
55mm User Guide



   55

2 

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Copyright
No part of this document may be reproduced or transmitted in any form or by 
any means, electronic or mechanical, including photocopying and recording, 
for any purpose without the express written consent of Digital Film Tools.

Copyright © Digital Film Tools, LLC. 2006. All Rights Reserved

January 27, 2007

About Us
Digital Film Tools is an off-shoot of a Los Angeles based motion picture visual 
effects facility. Our work includes hundreds of feature films, commercials and 
television shows. The understanding of photography, film and video editing, 
and in particular visual effects, allows us to design productive and highly 
specialized software. Software that is useful as well as easy to use. Our 
products stand up to the rigors of production and are the culmination of many 
years of experience.

Our philosophy is to bring our visual effects tools and techniques to the 
masses. What was once found only in expensive high-end packages or existed 
as proprietary in-house tools, is now available to photographers, artists, 
designers, and non-linear editors. Did I mention affordable? Our software 
doesn't cost an arm and a leg and won't break the bank.

If you have suggestions, comments or need support, E-mail us at:
dftsupport@digitalfilmtools.com. We will respond to you in a timely fashion. You 
can also visit our website at WWW.DIGITALFILMTOOLS.COM.
mm v7 User Guide
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 FILTER DESCRIPTIONS

55mm is the definitive set of digital optical filters meant to simulate popular 
glass camera filters, specialized lenses, optical lab processes, film grain, 
exacting color correction as well as natural light and photographic effects--all in 
a controlled digital environment with either 8 or 16 bits per channel processing. 
The set of plug-ins includes: Black & White, Black Mist, Bleach Bypass, Blur, 
Center Spot, Chromatic Aberration, Color Compensating, Color Conversion, 
Color Correct, Color Grad, Color Infrared, Color Spot, Cool Mist, Cross 
Processing, Day for Night, Defog, Defringe, Depth of Field, Diffusion, Double 
Fog, Dual Grad, Edge Glow, Enhancing, Faux Film, Flashing, Fluorescent, 
Fog, F-Stop, GamColor Gels, Gels, Glow, Gold Reflector, Grain, Halo, Infrared, 
Kelvin, Lens Distortion, Light, Light Balancing, Low Contrast, Mist, Mono Tint, 
ND Grad, Night Vision, Old Photo, Overexpose, Ozone, Pencil, Photographic 
Filters, Polarizer, Printer Points, Rack Focus, Radial Exposure, ReLight, Rosco 
Gels, Selective Color Correct, Selective Saturation, Silver Reflector, Skin 
Smoother, Soft Effects, Split Field, Split Tone, Star, Streaks, Strip Grad, 
Sunset/Twilight, Telecine, Temperature, Three Strip, Tint, Two Strip, Ultra 
Contrast, Vari-Star, Vignette, Warm Black Mist, Warm Mist, Warm Soft Effects 
and X-Ray.

Black Mist
The Black Mist filter creates atmosphere by reducing contrast, but with minimal 
glow around highlights. 

Black and White
Black and White converts color images to black and white simulating the look 
of Black and White photographic filters.

Blur
It’s fast, high quality and blurs outside the frame which removes the dark inward 
bleeding edges of most blurs. Horizontal, vertical or both, Blur uses either 
Gaussian or Box quality settings. 
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Bleach Bypass
Bleach Bypass is a film laboratory technique where, by skipping the bleach 
stage in the color processing sequence, silver is retained in the image along 
with the color dyes. The result is effectively a black and white image 
superimposed on a color image. Bleach Bypass images have increased 
contrast, reduced saturation, often giving a pastel effect.

Center Spot
Diffuses and blurs distracting backgrounds while keeping a center spot in 
focus. The center spot can be moved, sized and the amount of blur can be 
controlled.

Chromatic Aberration
Chromatic aberration is caused by a lens having a different refractive index for 
different wavelengths of light and is seen as fringes of color around the edges 
of the image. This fringing is removed by un-distorting the individual color 
channels.

Color Compensating
Color Compensating filters control color by attenuating specific parts of the 
spectrum. They can be used to make changes in color balance or compensate 
for deficiencies in the image’s spectral quality.

Color Conversion
Color Conversion filters correct for significant differences in color temperature 
between your light source and recording media.

Color Correct
Color Correct manipulates red, green and blue values of the overall image and 
separately in user definable shadow, midtone and highlight areas. Hue, 
saturation, brightness, contrast and gamma controls allow for further control.

Color Grad
Color Grad colors and or darkens only a portion of the image giving you the 
ability to simulate any Color Grad or ND (Neutral Density) Grad filter. Presets 
for your favorite color grad filters are provided as well as the ability to create 
mm v7 User Guide



• 

Filter Descriptions  5 
• 
• 
• 
•
•
•

custom colors. There is a graduated transition for a smooth color blend 
between the colored/darkened portion and the original image. Color Grad is 
especially good for changing and enhancing the color of the sky.

Color Infrared
Color Infrared simulates infrared filters used in conjunction with infrared 
sensitive film or sensors to produce very interesting false-color images with a 
dreamlike or sometimes lurid appearance.

Color Spot
Tints the image using presets for common photographic filters except for a 
center spot which retains normal color. The center spot can be moved, sized 
and the amount of blur can be controlled.

Cool Mist
The Cool Mist filter creates atmosphere by reducing contrast and glowing 
highlights in combination with a cooling filter.

Cross Processing
Cross-processing is a photographic technique where print film (C41) is 
processed in the set of chemicals usually used to process slide film (E6) or vice 
versa. The final result yields images with oddly skewed colors and increased 
contrast and saturation. Different film stocks produce different results, so we 
have created what we feel is a representative look.

Day for Night
Day for Night simulates a technique used for shooting exteriors in daylight 
made to look like they were photographed at night. Typically, it involves 
underexposing by two to two-and-a-half stops and using a filter to provide a tint, 
that is often a lavender-blue, as it mimics twilight and appears to emulate the 
mood of moonlight.

Defog
Using advanced deweathering algorithms, Defog restores clear day contrasts 
and colors of a scene taken in bad weather such as fog and mist. It is also 
successful in removing the effects of optical Fog and Diffusion filters.
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Defringe
Purple or blue fringing around overexposed areas is a result of sensor 
overloading in video as well as digital still cameras. Defringe isolates and 
removes the various types of color fringing.

Depth of Field
Depth of Field can be added to a scene by isolating and blurring only a portion 
of the image. The amount of blurring is directly proportionate to the luminance 
of the selection settings, a gradient or an input clip.

Diffusion
Diffusion creates atmosphere by reducing contrast while creating a glow 
around highlights or shadows. It simulates diffusion and fog filters as well as 
glows. In addition, a pre-built texture library allows you to add realistic diffusion 
to scenes as if you were adding diffusion directly to your camera lens.

Double Fog
The Double Fog filter creates a soft, misty atmosphere over the image by first 
applying fog using a vanishing point along the direction of increasing distance 
in the image. Then, a second pass blooms image highlights.

Dual Grad
Dual Grad applies two photographic filters to the image which are blended 
together with a gradient.

Edge Glow
Edge Glow isolates lines and edges in an image and then adds glow only to 
these areas resulting in a stylized look.

Enhancing
The saturation of either the red, green or blue areas of the image are isolated 
and enhanced with minimal effect on other colors. This filter is frequently used 
to enhance fall foliage, but is also ideal for blue sky and green grass.

Faux Film
The Faux Film filter gives video and digital images the look of photographic film. 
It reduces contrast, creates a soft mist around highlights and adds film grain.
mm v7 User Guide
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Flashing
Flashing allows you to use photographic filters to lower the contrast of your 
shadows or highlights. The motion picture lab can expose a small amount of 
light to the film at various stages of the developing and printing process. For 
example, Negative plus Dupe Negative flashing lifts blacks, while Print plus 
Master Positive flashing softens whites.

Fluorescent
The Fluorescent filter removes the greenish tone caused by photographing 
under fluorescent lights.

Fog
The Fog filter creates a soft, misty atmosphere over the image and glows 
highlights.

F-Stop
F-Stop manipulates red, green and blue values of the overall image and 
separately in user definable shadow, midtone and highlight areas using F-Stops 
as the unit of measure. In camera terminology, F-Stops measure the size of the 
lens opening, otherwise known as aperture. Each F-Stop is twice as bright as 
the next and is calculated using a logarithmic scale.

GamColor, CineFilters, Naked Cosmetics
Photographers, cinematographers and lighting designers use colored filters or 
gels in front of lights. Whether they want to create a romantic moonlit setting or 
a vicious, angry fight, they have the colors they need to achieve the effect. We 
have created digital equivalents of the lighting gels created by 
GAMPRODUCTS, INC. and these same exact colors can be applied to the 
entire image or inside a gradient. These three GAM filters contain digital gels 
from the GamColor, CineFilters and Naked Cosmetics collections. For detailed 
information about GAM Gels, you can visit their website at 
www.gamonline.com
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Gels
Photographers, cinematographers and lighting designers use colored filters or 
gels in front of lights. Whether they want to create a romantic moonlit setting or 
a vicious, angry fight, they have the colors they need to achieve the effect. We 
have created digital equivalents of these lighting gels and these same exact 
colors can be applied to the entire image or inside a gradient.

Glow
The Glow filter creates glows around selected areas of the image.

Gold Reflector
One of the oldest and still most popular means of lighting an exterior set is by 
taking a reflective surface and redirecting sunlight or artificial light exactly 
where it is needed. Unfortunately, it is nearly impossible for actors to keep their 
eyes open when looking into a reflector resulting in a lot of squinting eyes. Our 
digital reflector allows you to add gold light into shadow areas without the 
squinting.

Grain
Grain simulates film grain with individual control of red, green, and blue grain 
size and intensity. In addition, a Film Response parameter controls where you 
will see grain in the image. Popular film stock presets are provided as a starting 
point to adding grain.

Halo
Halo causes dark areas to glow into bright areas and bright areas to glow into 
dark areas along with a bit of diffusion.

Infrared
Infrared simulates infrared filters used in conjunction with infrared sensitive film 
or sensors to produce very interesting black and white images with halation in 
highlight areas.
mm v7 User Guide
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Kelvin
Degrees Kelvin is the standard unit of measure for color temperature and color 
temperature is a way to characterize the spectral properties of a light source. 
Low color temperature implies warmer (more yellow/red) light, while high color 
temperature implies a colder (more blue) light. Presets for a number of different 
light sources and conditions are provided in degrees Kelvin.

Lens Distortion
Lens Distortion corrects for pin-cushioning and barrel distortion of camera 
lenses. It is also useful for creating the look of a wide angle lens or placing the 
image into a television set.

Light!
Light can be added to a scene where none existed before just as if you were 
adding light at the time of shooting. Realistic lighting and shadow is introduced 
using the entire pattern/gobo library created by GAMPRODUCTS, INC. 
Normally used in front of lights during photography, these same exact patterns 
can now be applied digitally to the entire image or inside a selection. There are 
567 patterns to choose from including blendables, breakups, Christmas, 
cityscapes and towns, clouds, fences and openings, fire and water, flags, 
flowers, foliage, holidays and symbols, moons, natural elements, religion, 
signage, sky and stars, spirals, spotlights and pinspots, stones and brick, 
structures and sets, themes, trees, vignettes and windows. In addition, digital 
equivalents of the lighting gels created by GAMPRODUCTS, INC. can now be 
applied to your light source. For detailed information about GAM Patterns and 
Gels, you can visit their website at www.gamonline.com.

Light Balancing
Light Balancing filters correct for minor differences in color temperature 
between your light source and recording media.

Low Contrast
Low Contrast spreads highlights into darker areas, lowers contrast and keeps 
bright areas bright.
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Mist
The Mist filter creates atmosphere by reducing contrast while creating a glow 
around highlights.

Mono Tint
Mono Tint converts color images to black and white while applying a color tint.

ND Grad
The ND or Neutral Density Grad darkens only a portion of the image using a 
graduated transition between the darkened portion and the original image. It 
selectively adjusts brightness without affecting color balance. The most likely 
use for the ND Grad would be to balance the difference between the sky and 
the ground.

Night Vision
The Night Vision filter creates the effect of a Night Vision lens--that green, 
glowy, grainy look.

Old Photo
Images are treated to look like a variety of historical photographic processes 
including Cyanotype, Kallitype, Light Cyan, Palladium, Platinum, Sepia, Silver, 
Silver Gelatin and Van Dyck.

Overexpose
Overexpose simulates the overexposure that occurs when a film camera is 
stopped.

Ozone
The Ozone filter allows you to manipulate the color of an image with incredible 
flexibility and accuracy. Inspired by Ansel Adams’ Zone System for still 
photography, we have created "The Digital Zone System". Just what is the 
Digital Zone System? The world around us contains an infinite palette of colors, 
tones and brightness. To reproduce this vast range of brightness, the Digital 
Zone System takes the spectrum of image values and divides them into 11 
discrete zones, using proprietary image slicing algorithms. Each zone is twice 
as bright as the previous zone, proceeding from black towards white. With 
Ozone, the color, brightness, contrast and gamma of each zone can be 
mm v7 User Guide
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independently adjusted until you’ve painted a new picture. Your adjustments 
occur on a zone by zone basis, but you view the result of all color corrections 
simultaneously.

Pencil
Pencil converts your image to a pencil sketch.

Photographic Filters
The most complete line of Kodak® filters for photographic uses is available in 
the form of gelatin films and are known as Wratten® Gelatin Filters. 
Photographic Filters are digital equivalents of the Wratten set and were created 
using the spectral transmission curves for each optical filter.

Polarizer
The greatest use of polarizing filters is to achieve a darkened, deep blue sky. 
Our digital version of the Polarizer is designed to do just that. Through the use 
of a selection and an adjustable gradient, the color of the sky can be adjusted.

Printer Points
Printer Points manipulate the red, green and blue values of the overall image 
and separately in user definable shadow, midtone and highlight areas using 
motion picture laboratory printer points as the unit of measure. When creating 
color prints for motion pictures, a contact printer performs scene-to-scene color 
corrections. The most popular printing method is additive printing that uses 
three separate colored sources - red, green, and blue which are combined to 
form the light source that exposes the film. The red, green, and blue light valves 
in the printer are adjusted in values of 1, 2, 3. . . up to 50 for each primary color 
and are called printer points or printer lights.

Rack Focus
Rack Focus replicates a true camera defocus by introducing lens bokeh effects. 
Bokeh is the Japanese term that describes the quality of out-of-focus points of 
light. In defocused areas, each point of light becomes a shape--either a circle 
or a polygon. The shape grows in size as the amount of defocusing is 
increased.
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Radial Exposure
Lightens and/or darkens the center or edges of an image to correct lens 
vignetting.

ReLight
Light can be added to a scene where none existed before. A complete set of 
light source controls allow you to adjust the light just as you would at the time 
of shooting. In addition, digital equivalents of the lighting gels created by 
GAMPRODUCTS, INC. can be applied to your light source. For detailed 
information about GAM Gels, you can visit their website at 
www.gamonline.com.

Rosco Calcolor, Cinegel, Cinelux and Storaro Selection
Photographers, cinematographers and lighting designers use colored filters or 
gels in front of lights. Whether they want to create a romantic moonlit setting or 
a vicious, angry fight, they have the colors they need to achieve the effect. We 
have created digital equivalents of the lighting gels created by Rosco and these 
same exact colors can be applied to the entire image or inside a gradient. 
These four Rosco filters contains gels from the Calcolor, Cinegels, Cinelux and 
Storaro Selection. For detailed information about Rosco Gels, you can visit 
their website at www.rosco.com

Selective Color Correct
Colors can be selectively isolated through the use of a selection and adjusted 
using hue, saturation, brightness, gamma, contrast, red, green, and blue 
controls.

Selective Saturation
The saturation of the image can be adjusted independently in the shadows, 
midtones and highlights.
mm v7 User Guide
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Silver Reflector
One of the oldest and still most popular means of lighting an exterior set is by 
taking a reflective surface and redirecting sunlight or artificial light exactly 
where it is needed. Unfortunately, it is nearly impossible for actors to keep their 
eyes open when looking into a reflector resulting in a lot of squinting eyes. Our 
digital reflector allows you to add light into shadow areas without the squinting.

Skin Smoother
Skin Smoother softens wrinkles and blemishes producing smooth skin textures 
while retaining detail in larger features such as the eyes, nose and mouth.

Soft Effects
Soft Effects diffuses the image in such a way that minimizes facial 
imperfections while retaining overall clarity.

Split Field
Split Field splits the image with a line that can be positioned, rotated and 
blurred. On one side of the line, the image is blurred and on the other, it is in 
focus.

Split Tone
Shadows, midtones and highlights can be individually tinted with the Split Tone 
filter.

Star
Six point star patterns are generated on highlights in the image.

Streaks
The Streaks filter creates horizontal or vertical streaks around highlights in the 
image.

Strip Grad
Strip Grad colors and or darkens only a portion of the image in the form of a 
narrow strip using photographic filters. Presets for your favorite color grad filters 
are provided as well as the ability to create custom colors. There is a graduated 
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transition for a smooth color blend between the colored/darkened portion and 
the original image. Strip Grad is especially good for changing and enhancing a 
narrow portion of the sky.

Sunset/Twilight
Sunset/Twilight applies three photographic filters to the image which are 
blended together with a gradient.

Telecine
Telecine emulates the method of color correction done in a telecine film to tape 
transfer suite. Hue, saturation, brightness, contrast, gamma and pedestal 
values of the overall image can be adjusted as well as separately in user 
definable shadow, midtone and highlight areas.

Temperature
Temperature manipulates the temperature, cyan/magenta and brightness 
values of the overall image and separately in user definable shadow, midtone 
and highlight areas.

Three Strip
Known and celebrated for it ultra-realistic, saturated levels of color, the 
Technicolor® Three Strip process was commonly used for musicals, costume 
pictures and animated films. It was created by photographing three black and 
white strips of film each passing through red, green and blue filters on the 
camera lens and then recombining them in the printing process. Our Three 
Strip filter was created under the direction of Academy Award Winning Visual 
Effects Supervisor Rob Legato.

Tint
Colored tints are applied to the entire image or inside a gradient.

Two Strip
The Technicolor® Two Strip process was the first stab at producing color 
motion pictures and consisted of simultaneously photographing two black and 
white images using red and green filters. This look creates an odd but pleasing 
hand-painted look where faces appear normal and green takes on a blue-green 
mm v7 User Guide
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quality, while the sky and all things blue appear cyan. Our Two Strip filter was 
created under the direction of Academy Award Winning Visual Effects 
Supervisor Rob Legato.

Ultra Contrast
Ultra Contrast lowers contrast evenly throughout the image by brightening 
shadow areas and darkening highlights. It is useful for correcting dark 
foreground subjects due to strong backlighting as well as highlights that are 
slightly washed out.

Vari-Star
Variable multi-point star patterns are generated on highlights in the image.

Vignette
A vignette, or soft fade, is a popular photographic effect where the photo 
gradually fades into the background, usually in an oval or square shape. The 
vignette can be any color as well as thrown out of focus.

Warm Black Mist
The Warm Black Mist filter creates atmosphere by reducing contrast, but with 
minimal glow around highlights in combination with a warming filter.

Warm Mist
The Warm Mist filter creates atmosphere by reducing contrast and glowing 
highlights in combination with a warming filter.

Warm Soft Effects
Warm Soft Effects diffuses the image in such a way that minimizes facial 
imperfections while retaining overall clarity in combination with a warming filter.

X-Ray
Simulates the look of X-Ray images.
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 INSTALLATION

Adobe Photoshop
Installation
1 Download 55mm at WWW.DIGITALFILMTOOLS.COM
2 Run the installer and place the 55mm filters into your Adobe/Photoshop/Plug-Ins 

folder.
Note: If you are running a program other than Adobe Photoshop, you will need to select 
the Plug-In folder for your application.

3 Start Photoshop and load an image.
4 From the Filter pull-down menu, select one of the 55mm filters from a Digital Film 

Tools 55mm v7 filter group.
5 A registration dialog box pops up the first time that you run 55mm.
6 Click the Demo or Cancel buttons in the registration dialog and 55mm will 

operate in Demo mode. 
7 The 55mm Preview window opens and you’re ready to go.

In Demo mode, a watermark is superimposed over the image when the filter is 
applied.

Licensing
1 To convert the 55mm filters from Demo mode to full operation, you must install 

a Serial number.
2 You can obtain a Serial number by purchasing the filters at 

WWW.DIGITALFILMTOOLS.COM
3 Once you purchase the filters, a Serial number will be sent to you via email.
mm v7 User Guide

http://www.digitalfilmtools.com/
http://www.digitalfilmtools.com/


• 

Installation  17 
• 
• 
• 
•
•
•

Apple Final Cut Pro
Installation
1 Download 55mm at WWW.DIGITALFILMTOOLS.COM
2 Run the installer and place the 55mm plug-ins into your Final Cut Pro plug-ins 

folder usually located at /Library/Application Support/Final Cut Pro System 
Support/Plugins.

3 Start Final Cut Pro and select a clip in the Timeline by double-clicking on it.
4 Apply one of the 55mm filters by selecting one from the Effects>Video 

Filters>DFT 55mm v7 pull-down menus.
When you apply one of the 55mm filters to a clip, you will see a watermark 
superimposed over the image. This means that you are in Demo mode. 

Licensing
1 To convert the 55mm filters from Demo mode to full operation, you must install 

a Serial number.
2 You can obtain a Serial number by purchasing the filters at 

WWW.DIGITALFILMTOOLS.COM
3 Once you purchase the filters, a Serial number will be sent to you via email.
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After Effects & After Effects Compatible Programs
Installation
1 Download 55mm at WWW.DIGITALFILMTOOLS.COM
2 Run the installer and place the 55mm filters in your application's plug-in folder. 

For After Effects, this is usually the Adobe\After Effects\Plug-ins folder.
3 Start After Effects or your After Effects plug-in compatible application and find 

the 55mm filters in the Effects pull-down menu. They will be located in the DFT 
55mm v7 effect groups.
When you apply one of the 55mm filters to a clip, you will see a watermark 
superimposed over the image. This means that you are in Demo mode. 

Licensing
1 To convert the 55mm filters from Demo mode to full operation, you must install 

a Serial number.
2 You can obtain a Serial number by purchasing the filters at 

WWW.DIGITALFILMTOOLS.COM
3 Once you purchase the filters, a Serial number will be sent to you via email.
mm v7 User Guide
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Avid Editing Systems
Installation
1 Download 55mm at WWW.DIGITALFILMTOOLS.COM
2 Run the installer and place the 55mm filters into your AVX_Plug-ins folder. For 

Windows users, this is normally the C:\Program Files\Avid\AVX_Plug-ins folder. 
For Mac Users, this is usually the Media Composer\SupportingFiles\AVX_Plug-
ins folder.
Note: For Mac users that have Avid editing systems other than Media Composers, the 
AVX_Plug-ins folder is usually located at "Your Avid 
System"\SupportingFiles\AVX_Plug-ins.

3 Start your Avid editing software and find the 55mm filters in the Effects Palette. 
They will be located in the DFT 55mm v7 effect groups.
When you apply one of the 55mm filters to a clip, you will see a watermark 
superimposed over the image. This means that you are in Demo mode.

Licensing
1 To convert the 55mm filters from Demo mode to full operation, you must install 

a Serial number.
2 You can obtain a Serial number by purchasing the filters at 

WWW.DIGITALFILMTOOLS.COM
3 Once you purchase the filters, a Serial number will be sent to you via email.
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Avid | DS
Installation
1 Download 55mm at WWW.DIGITALFILMTOOLS.COM
2 Run the installer and place the 55mm filters in your AVX_Plug-ins folder. This is 

normally the C:\Program Files\Avid\AVX_Plug-ins folder.
3 Start Avid | DS and apply a Clip, Track or Timeline effect.
4 Under Image Effects, select AVX Host.
5 Choose one of the DFT 55mm v7 effect groups in the Group/Category and one of 

the 55mm filters in the Effect Category.
You will see a watermark superimposed over the image. This means that you 
are in Demo mode.

Licensing
1 To convert the 55mm filters from Demo mode to full operation, you must install 

a Serial number.
2 You can obtain a Serial number by purchasing the filters at 

WWW.DIGITALFILMTOOLS.COM
3 Once you purchase the filters, a Serial number will be sent to you via email.
mm v7 User Guide
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 GENERAL CONTROLS

There are some general controls that are common to all of the filters. For 
simplicity they will be listed here.

View 
Chooses what to view. The choices in this menu will change depending on the 
filter. 

Photoshop Macintosh Eyedropper
The Eyedropper that we use in the Photoshop Macintosh version of 55mm is a 
checkbox icon that appears to the right of color boxes. When it is activated, the 
cursor turns into a hand icon when moved over the image in the 55mm Preview 
window. Click the desired color on the image and it will become the current 
color.

Blur
Horizontal Blur

The image is blurred by a fast, quality blur along the X-axis.

Vertical Blur
The image is blurred by a fast, quality blur along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.
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DVE
The DVE allows you to transform your image using Position, Scale, Rotation, 
Corner Pin, Shear and Crop controls.

Crop
Top
Crops the image from the top down.

Bottom
Crops the image from the bottom up.

Left 
Crops the image from left to right.

Right
Crops the image from right to left.

Corner Pin
The image can be corner pinned by adjusting the Corner Pin sliders as well as 
dragging the four points on the corners of the screen.

Note: You may need to zoom the image out a bit to see the corner points. In addition, 
to see and adjust the corner points in After Effects, make sure that the effect title in the 
Effect Controls window is highlighted.
mm v7 User Guide
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For Final Cut Pro and Combustion, you must activate the cross hair icon next 
to the corner position parameters to see and adjust the corner points on the 
screen.

Upper-Left
Controls the X and Y position of the Upper Left Point.

Upper-Right
Controls the X and Y position of the Upper Right Point.

Lower-Right
Controls the X and Y position of the Lower Right Point.

Lower-Left
Controls the X and Y position of the Lower Left Point.

There are four points around the four corners of the image. By clicking and 
dragging any of the four points, the foreground can be adjusted.

Position
Position X
The horizontal position of the image.

Position Y
The vertical position of the image.

Note: In Photoshop, Position can be adjusted by clicking and dragging an on-screen 
control in the center of the image. For Final Cut Pro and Combustion, you must 
activate the cross hair icon next to the Position parameter.

Final Cut Pro

Combustion
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Scale
Scale X
The horizontal scale of the image.

Scale Y
The vertical scale of the image.

Gang Scale
The Scale X and Scale Y slider values can be ganged together.

Note: When Gang is turned on, the Scale Y slider doesn’t physically move. However, 
the Scale Y value will follow the value of the Scale X slider when Gang is turned on.

Rotate
In addition to the standard position and scale controls, the image can be 
rotated. Positive values rotate clockwise and negative values rotate counter-
clockwise.

Shear
Shear X
Skews the image left and right.

Shear Y
Skews the image up and down.

Anchor
Anchor X
Defines the point on the X axis where the image will be positioned, rotated, 
scaled or sheared.

Anchor Y
Defines the point on the Y axis where the image will be positioned, rotated, 
scaled or sheared.
mm v7 User Guide
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Selection
In some of the 55mm filters, a selection is generated to create the desired effect. 
The Selection controls consist of Position, Range and Blur parameters, and 
they work the same in all of the filters. The white areas of the selection are the 
areas that will be affected by the filter, while the black areas remain unaffected. 
The selection is extracted based on luminance, in most cases, and is created 
using the Position and Range parameters.

Position
Selects the values to be included in the selection. A higher Position value 
shows more white values from the original image as white values in the 
selection. A lower Position value shows more black values from the original 
image as white values in the selection.
Position 0, Range 25 Position 100, Range 25Original

Photos © THINKSTOCK LLC--WWW.THINKSTOCK.COM
55mm v7 User Guide    
• 
• 
•
•
•



   55

26 General Controls

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Range
Controls the range of values to be used for the selection. Once you’ve selected 
the "Position", you can then add or subtract the "Range" of values to be 
included in the selection. A higher Range value includes more white values in 
the selection while a lower Range value includes less values in the selection. 

Blur
The selection is blurred by a fast, quality blur.

Position 100, Range 25 Position 100, Range 75Original
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RGB Rendering (On)
Turns RGB Rendering on or off.

In Apple Final Cut Pro, when your sequence is set to "Always Render in RGB", 
the foreground image is compressed a third of the size at the top of the screen. 
This is a Final Cut Pro bug. To avoid this problem, activate this parameter.

Force 16-bit Processing
Turns 16 bit processing on or off.

A Force 16-bit processing function allows you to process in 16 bit even if your 
source images are 8 bit. 16 bit processing take longer to render, but will remove 
banding artifacts associated with 8 bit processing.
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 GENERAL CONTROLS - ADOBE PHOTOSHOP

In addition to the General Controls previously listed, the 55mm version for 
Adobe Photoshop has some of it’s own General Controls.

Zoom Buttons
At the bottom of the 55mm Preview window, there are buttons to zoom the 
image.

Fit
Fits the entire image into the Preview window. The Fit mode yields the quickest 
interaction when editing parameters.
mm v7 User Guide
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-
Makes the image in the Preview window smaller.

Tip: When using the + and 1:1 buttons, you are able to pan the image by clicking with 
the left mouse button and dragging in the image area.

+
Makes the image in the Preview window larger.

1:1
Makes the image in the Preview window a 1:1 zoom ratio and shows the actual 
pixels of the image. The 1:1 setting accurately represents what the filter will 
look like when applied to the full size image.

Warning: When using the + and 1:1 buttons in conjunction with large blur settings and 
large image sizes, the 55mm filters will run slower and will require more RAM.

Parameter Groups
Some of the filters have multiple parameter groups. When a parameter group 
is selected, the controls for that group appear and can be adjusted. The 
parameter groups are located at the top right of the 55mm Preview window just 
below the View menu.
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Miscellaneous Buttons
Across the bottom of the 55mm Preview window, there are a few miscellaneous 
buttons.

OK
Applies all 55mm adjustments to your full resolution image.

Cancel
Cancels the 55mm filter and closes the Preview window.

Reset
Resets all parameter values for the 55mm filter.

Save
Saves the settings for the 55mm filter which can be reloaded at a later time 
using the Load button.

Load
Loads the settings of a previously saved 55mm filter.
mm v7 User Guide
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16 Bits/Channel Processing
All of the 55mm filters can process in either 8 or 16 bit depending on whether 
8 Bits/Channel or 16Bits/Channel are selected in the Photoshop Image>Mode 
menu.
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 BLACK AND WHITE

Category
Color Correct.

Description
Black and White converts color images to black and white simulating the look 
of Black and White photographic filters.

Go to the Black and White - Tutorial on page 33 to see how the filter works.

Filter
The Filter pop-up selects the type of black and white filter to be applied to your 
color image.

Normal
Converts the color image to a monochrome image.

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Before After
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Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates an orange filter in black and white photography.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.

Black and White - Tutorial
Black and White converts color images to black and white simulating the look 
of Black and White photographic filters.

1 Apply the Black and White filter to an image.
2 From the filter pop-up, select the type of black and white filter to be applied to 

your color image.
Your choice of filter can dramatically change the black and white result.

3 Use the Brightness, Contrast and Gamma controls to further adjust the image.
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 BLEACH BYPASS

Category
Film Lab.

Description
Bleach Bypass is a film laboratory technique where, by skipping the bleach 
stage in the color processing sequence, silver is retained in the image along 
with the color dyes. The result is effectively a black and white image 
superimposed on a color image. Bleach Bypass images have increased 
contrast, reduced saturation, often giving a pastel effect.

Go to the Bleach Bypass - Tutorial on page 35 to see how the filter works.

Amount
Sets the intensity of the bleach effect.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.

Before After
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Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Temperature
Sets the color temperature of the image. Dragging the slider to the right makes 
the image cooler (bluer) and dragging the slider to the left makes the image 
warmer (redder).

Bleach Bypass - Tutorial
Bleach Bypass is a film laboratory technique where, by skipping the bleach 
stage in the color processing sequence, silver is retained in the image along 
with the color dyes. The result is effectively a black and white image 
superimposed on a color image. Bleach Bypass images have increased 
contrast, reduced saturation, often giving a pastel effect.

1 Apply the Bleach Bypass filter to an image.
2 Use the Amount slider to control the strength of the Bleach Bypass filter.
3 Saturation, Contrast and Temperature sliders are provided for additional 

enhancement.
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 BLUR

Category
Blurs.

Description
It’s fast, high quality and blurs outside the frame which removes the dark inward 
bleeding edges of most blurs. Horizontal, vertical or both, Blur uses either 
Gaussian or Box quality settings.

Go to the Blur - Tutorial on page 37 to see how the filter works.

Quality
Selects the quality of the blur.

Box
A fast, lower quality box blur.

Gaussian
A slower, higher quality gaussian blur.

Before After
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Blur
Horizontal Blur

The image is blurred along the X-axis.

Vertical Blur
The image is blurred along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.

Blur - Tutorial
It’s fast, high quality and blurs outside the frame which removes the dark inward 
bleeding edges of most blurs. Horizontal, vertical or both, Blur uses either 
Gaussian or Box quality settings.

1 Apply the Blur filter to an image.
2 Adjust the Horizontal Blur slider. 

Since the Gang button is activated, the Vertical Blur slider moves along with the 
Horizontal.

3 Un-click the Gang slider and now the Horizontal and Vertical slider can be moved 
independently.

4 Change the Quality setting from Box to Gaussian.
Gaussian is a higher quality blur, but comes with a price--it’s slower.
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 CENTER SPOT

Category
Blurs.

Description
Diffuses and blurs distracting backgrounds while keeping a center spot in 
focus. The center spot can be moved, sized and the amount of blur can be 
controlled.

Go to the Center Spot - Tutorial on page 40 to see how the filter works.

Blur
Horizontal

The image is blurred by a quality blur along the X-axis except in the area of the 
center spot.

Vertical
The image is blurred by a quality blur along the Y-axis except in the area of the 
center spot.

Before After
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Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.

Spot
A spot in the form of a radial gradient is used to control where blur is added to 
the image.

Position
Position X
The horizontal position of the center spot.

Position Y
The vertical position of the center spot.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the position of the spot can be adjusted. To see the on-screen 
control in After Effects, you may need to highlight Center Spot in the Effect Controls 
window, and in Final Cut Pro and Combustion, you will have to click on the crosshair 
icon to the right of the Position parameter. On Avid Editing Systems, the Position 
parameters are named only X and Y.

Aspect
The aspect ratio of the spot.

Radius
The un-blurred radius of the spot.

Falloff Radius
The blurred edge radius.

Falloff
Moves the falloff towards the spot centerpoint.
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Center Spot - Tutorial
Center Spot diffuses and blurs distracting backgrounds while keeping a center 
spot in focus. The center spot can be moved, sized and the amount of blur can 
be controlled

1 Apply the Center Spot filter to an image.
2 Adjust the Spot>Position, Radius, Falloff Radius and Falloff.

The area covered by the spot will be in focus with all other areas blurred.

3 If you are curious, you can see what the Spot looks like by changing your View 
to Spot. Change your View to Output when done.

4 Adjust the Horizontal and Vertical Blur to your liking.
mm v7 User Guide
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 CHROMATIC ABERRATION

Category
Lens.

Description
Chromatic aberration is caused by a lens having a different refractive index for 
different wavelengths of light and is seen as fringes of color around the edges 
of the image. This fringing is removed by un-distorting the individual color 
channels.

Go to the Chromatic Aberration - Tutorial on page 135 to see how the filter 
works.

Note: The Photoshop zoom controls only work at the Fit and 1:1 settings when using 
Chromatic Aberration.

There are some new types of color fringes that are not chromatic aberration. 
These effects might be visible as purple or blue fringes and are visible around 
overexposed areas in most cases. If the following conditions apply, your image 
most likely has true chromatic aberration as opposed to color fringing caused 
by sensor overloading:

• Corners should show most color fringes whereas the center should show none.
• Color fringes should be not only at the edges of overexposed areas but at lower 

contrast edges, too.

Before After
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• Color fringes should be of complementary color (red-cyan, green/magenta, and 
blue-yellow) on opposite sides of a dark or bright area.

• Color fringes should be in all corners the same direction and pointing out from the 
center.

Red/Cyan, Green/Magenta, Blue/Yellow
Use the appropriate color group to remove the chromatic aberration. For 
instance, if you see red/cyan fringing, use the Red/Cyan group. Start by 
adjusting the Distortion parameter.

Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 
image inward while positive values pull the corners of the image outward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 
picture lenses.

Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 
anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been moved.

Center X and Y
Determines the center point for the distortion.
mm v7 User Guide
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Chromatic Aberration - Tutorial
Chromatic aberration is caused by a lens having a different refractive index for 
different wavelengths of light and is seen as fringes of color around the edges 
of the image. This fringing is removed by un-distorting the individual color 
channels.

1 Apply the Chromatic Aberration filter to an image.
2 Look at the edges of the image and determine if the chromatic aberration is 

red/cyan, green/magenta, or blue/yellow.
3 Start by adjusting the Distortion parameter for the particular color fringing that 

you are trying to remove. For instance, if you see red/cyan fringing, adjust the 
Distortion slider in the Red/Cyan group.
If you are using anamorphic motion picture lenses or are experiencing non-
radial, asymmetric fringing, you may need to adjust the Anamorphic Squeeze 
and Curvature X/Y parameters.
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 COLOR CORRECT

Category
Color Correct.

Description
Color Correct manipulates red, green and blue values of the overall image and 
separately in user definable shadow, midtone and highlight areas. Hue, 
saturation, brightness, contrast and gamma controls allow for further control.

Go to the Color Correct - Tutorial on page 47 to see how the filter works.

Note: The following color correction parameters are included in other applicable filters.

Master
The master settings affect the entire image.

Hue
Rotates the hue of the image.

Before After
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Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Flashing
The Flash parameters mix a color into the image through the use of a standard 
color picker. The default color is white. What in the world is this for? It is a great 
way to add atmosphere to an element. Flash comes from the film term 
"flashing", which describes the optical process of lowering the contrast of an 
image by flashing it with light.

• Flash Amount 
Sets the opacity of the Flash Color. 

• Flash Color
The Flash Color can be set through the use of a standard color picker.
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Shadows, Midtones, Highlights
Adjusting parameters within the shadows, midtones and highlights will only 
affect those specific areas. If you are unsure about what values are included in 
the shadows, midtones and highlights, you can use the View pop-up menu. It 
will allow you to view the shadows, midtones and highlights as a black and 
white selection. The white areas are the areas that will be adjusted by that 
particular group. For instance, if you see white areas while viewing the 
midtones, then midtone color adjustments will affect only those white areas. If 
you want to change the default areas defined by the shadows, midtones and 
highlights, you would use the Position and Range sliders.

Go to the Selection section of General Controls on page 25 to see how the 
Position and Range controls work.

Position
The Position slider pinpoints the values to be considered as shadows, 
midtones, or highlights. A low Position value uses the darkest image values, 
while a high Position value uses the brightest.

Range
Increases or decreases the range of values considered as shadows, midtones 
or highlights. A low Range value indicates a narrow range of values, while a 
high Range value indicates a large range of values.

Red 
Adds or subtracts red from the shadows, midtones or highlights.

Original Shadows Midtones Highlights
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Green 
Adds or subtracts green from the shadows, midtones or highlights.

Blue 
Adds or subtracts blue from the shadows, midtones or highlights.

Brightness
Adjusts the luminance of the shadows, midtones or highlights.

Contrast
Adjusts the contrast of the shadows, midtones or highlights.

Gamma 
Adjusts the gamma of the shadows, midtones or highlights.

Color Correct - Tutorial
Color Correct manipulates red, green and blue values of the overall image and 
separately in user definable shadow, midtone and highlight areas. Hue, 
saturation, brightness, contrast and gamma controls allow for further control.

The F-Stop, Printer Points, Telecine, and Temperature filters all work in a similar 
fashion to Color Correct.

1 Apply the Color Correct filter to an image.
2 Adjust any of the controls in the Master group.

The master settings affect the entire image. However, Color Correct also uses 
selections in the shadow, midtone and highlight regions for you to adjust the 
color selectively in those areas.

Note: Lift, Gamma and Gain in the Telecine filter are the same as Shadows, Midtones 
and Highlights in the Color Correct filter.

3 Change your View to Shadows, Midtones or Highlights to see the selection 
values. 
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The areas that are white in the selection are the areas that will be adjusted by 
the color controls. The areas defined as shadows, midtones or highlights can 
be adjusted by modifying the Position and Range parameters.

4 Use the Shadows, Midtones or Highlights Position parameters if you want to 
select different values to be used for the selection.

5 Increase the Shadows, Midtones or Highlights Range controls to add more 
values to the selection. Decrease for less values.

6 Change your View to Output to see the image.
7 Adjust the color controls in the Shadows, Midtone or Highlight controls to see 

how it affects your image.

Original Shadows Midtones Highlights
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 COLOR GRAD

Category
Grads / Tints.

Description
Color Grad colors and or darkens only a portion of the image giving you the 
ability to simulate any Color Grad or ND (Neutral Density) Grad filter. Presets 
for your favorite color grad filters are provided as well as the ability to create 
custom colors. There is a graduated transition for a smooth color blend 
between the colored/darkened portion and the original image. Color Grad is 
especially good for changing and enhancing the color of the sky.

Go to the Color Grad - Tutorial on page 53 to see how the filter works.

Filters
Presets

Select one of the filters from the pop-up list. Go to Appendix D on page 283 to 
see the complete list of filters.

Before After
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Color
The Color parameter sets the color of the grad through the use of a standard 
color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Grad
Grad is the transition area that goes from the tinted image to the original image. 
Its direction, corners and size can be adjusted.

Enable
Turns the Grad on and off.

ND Brightness
Sets the brightness of the darkened portion of the Grad.

Direction
Controls the direction of the Grad.

Top-to-bottom
The direction of the Grad is from top to bottom.

Bottom-to-top
The direction of the Grad is from bottom to top.

Left-to-right
The direction of the Grad is from left to right.
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Right-to-left
The direction of the Grad is from right to left.

Corner Pin
There are four points around the four corners of the image. By clicking and 
dragging any of the four points, the Grad can be adjusted.

Note: You may need to zoom the image out a bit to see the corner points. In addition, 
to see the corner points in After Effects, make sure that Color Grad in the Effect 
Controls window is highlighted.
55mm v7 User Guide    
• 
• 
•
•
•



   55

52 Color Grad

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

For Final Cut Pro and Combustion, you must activate the cross hair icon next 
to the corner position parameters to see and adjust the corner points on the 
screen.

Upper Left
Controls the X and Y position of the Upper Left Point.

Upper Right
Controls the X and Y position of the Upper Right Point.

Lower Right
Controls the X and Y position of the Lower Right Point.

Lower Left
Controls the X and Y position of the Lower Left Point.

Size
The size of the Grad.

Final Cut Pro

Combustion
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Color Grad - Tutorial
Color Grad colors and or darkens only a portion of the image giving you the 
ability to simulate any Color Grad or ND (Neutral Density) Grad filter.

1 Apply the Color Grad filter to an image.
By default, the Custom filter preset is applied to the image.

2 To apply a custom color to the image, click on the Filters>Color box and select a 
color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

3 To choose one of the preset filters, select a filter from the Filters>Presets list.
You can also adjust the gradient’s position and size.

4 Adjust the Grad>Direction, Corner Points and Size.
Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

5 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

6 If you want less coloring of the image, turn down the Filters>Opacity.
7 Image highlights can be retained by adjusting the Filters>Preserve Highlights 

control to a value of 100.
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 COLOR INFRARED

Category
Effects.

Description
Color Infrared simulates infrared filters used in conjunction with infrared 
sensitive film or sensors to produce very interesting false-color images with a 
dreamlike or sometimes lurid appearance.

Go to the Color Infrared - Tutorial on page 55 to see how the filter works.

Magenta
Adjusts the amount of magenta.

Blue
Adjusts the amount of blue.

Hue
Adjusts the hue in any non-blue areas.
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Contrast
Adjusts the contrast of the image.

Color Infrared - Tutorial
Color Infrared simulates infrared filters used in conjunction with infrared 
sensitive film or sensors to produce very interesting false-color images with a 
dreamlike or sometimes lurid appearance.

1 Apply the Color Infrared filter to an image.
2 Adjust the Magenta and Blue sliders to your liking.
3 Changing the Hue will only adjust hue in non-blue areas.
4 Color Infrared images usually have high contrast. Lower the contrast setting if it 

is too high for your image.
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 COLOR SPOT

Category
Grads / Tints.

Description
Tints the image using presets for common photographic filters except for a 
center spot which retains normal color. The center spot can be moved, sized 
and the amount of blur can be controlled.

Go to the Color Spot - Tutorial on page 58 to see how the filter works.

Color
Presets

Select one of the filters from the pop-up list. Go to Appendix D on page 283 to 
see the complete list of filters.

Color
The Color parameter sets the color through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.
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Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Spot
A spot in the form of a radial gradient is used to control where color is added to 
the image.

Position
Position X
The horizontal position of the center spot.

Position Y
The vertical position of the center spot.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the position of the Spot can be adjusted. To see the on-screen 
control in After Effects, you may need to highlight Color Spot in the Effect Controls 
window, and in Final Cut Pro and Combustion, you will have to click on the crosshair 
icon to the right of the Position parameter. On Avid Editing Systems, the Position 
parameters are named only X and Y.

Aspect
The aspect ratio of the spot.

Radius
The un-blurred radius of the spot.

Falloff Radius
The blurred edge radius.
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Falloff
Moves the falloff towards the spot centerpoint.

Color Spot - Tutorial
Tints the image using presets for common photographic filters except for a 
center spot which retains normal color. The center spot can be moved, sized 
and the amount of blur can be controlled. 

1 Apply the Color Spot filter to an image.
2 Adjust the Spot>Position, Radius, Falloff Radius and Falloff.

The white area of the spot will be tinted.

3 If you are curious, you can see what the Spot looks like by changing your View 
to Spot. Change your View to Output when done.

4 To apply a custom color to the image, click on the Color>Color box and select a 
color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

5 To choose one of the preset filters, select a filter from the Color>Presets list.
6 If you want less coloring of the image, turn down the Color>Opacity.
7 Image highlights can be retained by adjusting the Color>Preserve Highlights 

control to a value of 100.
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 COOL MIST

Category
Diffusion.

Description
Cool Mist

The Cool Mist filter creates atmosphere by reducing contrast and glowing 
highlights in combination with a cooling filter.

Go to the Cool Mist - Tutorial on page 61 to see how the filter works.

Mist
Mist

Determines the method used to create the mist effect.

Spread
The mist spreads beyond the areas defined by the selection.

Subtle
The mist is constrained by the areas defined by the selection.
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Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the mist through the use of a standard 
color picker. The default color is white.

Cooling
Color

The Color parameter sets the color of the cooling through the use of a standard 
color picker.

Opacity
Sets the opacity of the cooling.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 
cooling.
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Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection Controls work.

Cool Mist - Tutorial
The Cool Mist filter creates atmosphere by reducing contrast and glowing 
highlights in combination with a cooling filter.

1 Apply either the Cool Mist filter to an image.
2 Adjust the Mist>Brightness, Blur and Color settings to your liking.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, mist.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where mist will be 
introduced. The location of the mist within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

4 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

5 Increase the Selection>Range value to add more mist into the scene. Decrease 
for less mist.

6 Increase the Selection>Blur parameter to soften the transition areas of the mist. 
7 Change your View to Output to see the filtered image.
8 The softness of the mist can also be adjusted using the Mist>Blur setting.
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 CROSS PROCESSING

Category
Film Lab.

Description
Cross-processing is a photographic technique where print film (C41) is 
processed in the set of chemicals usually used to process slide film (E6) or vice 
versa. The final result yields images with oddly skewed colors and increased 
contrast and saturation. Different film stocks produce different results, so we 
have created what we feel is a representative look.

Go to the Cross Processing - Tutorial on page 63 to see how the filter works.

Amount
Sets the intensity of the cross process effect.
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Mode
Print to Slide

Simulates the effect of print film (C41) being processed in slide (E6) chemicals.

Slide to Print
Simulates the effect of slide film (E6) being processed in print (C41) chemicals.

Cross Processing - Tutorial
Cross-processing is a photographic technique where print film (C41) is 
processed in the set of chemicals usually used to process slide film (E6) or vice 
versa. The final result yields images with oddly skewed colors and increased 
contrast and saturation. Different film stocks produce different results, so we 
have created what we feel is a representative look.

1 Apply the Cross Processing filter to an image.
2 Use the Amount slider to control the strength of the Cross Processing filter.
3 Switch the Mode to Slide to Print.

Both Print to Slide and Slide to Print modes are available.
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 DAY FOR NIGHT

Category
Effects.

Description
Day for Night simulates a technique used for shooting exteriors in daylight 
made to look like they were photographed at night. Typically, it involves 
underexposing by two to two-and-a-half stops and using a filter to provide a tint, 
that is often a lavender-blue, as it mimics twilight and appears to emulate the 
mood of moonlight.

Go to the Day for Night - Tutorial on page 66 to see how the filter works.

Diffusion
Horizontal Blur

The image is diffused by a fast, quality blur along the X-axis.

Vertical Blur
The image is diffused by a fast, quality blur along the Y-axis.
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Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.

Opacity
Sets the amount of diffusion mixed into the original image. The higher the 
setting, the more the image is blurred.

Moonlight
Color

The Color parameter sets the color of the moonlight through the use of a 
standard color picker. The default color is blue.

Opacity
Sets the opacity of the moonlight color.

Preserve Highlights
Preserves the white areas of the image.

Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.
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Day for Night - Tutorial
Day for Night simulates a technique used for shooting exteriors in daylight 
made to look like they were photographed at night. 

1 Apply the Day for Night filter to an image.
Day for Night uses a type of diffusion that grows darks areas into bright areas. 

2 Adjust the Diffusion>Blur and Opacity parameters to your liking.
The Day for Night effect relies on a blue tint to simulate moonlight. You can 
modify the color of the tint as well as its intensity using the Moonlight controls.

3 Use the Moonlight controls to adjust the tint applied to the image.
Photographically the image is underexposed by two stops or so. We duplicate 
the underexposure by using a combination of color correction controls. Modify 
the color correct presets brighter or darker depending on your image.

4 Change the Color Correct settings if necessary.
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 DEFOG

Category
Diffusion

Description
Using advanced deweathering algorithms, Defog restores clear day contrasts 
and colors of a scene taken in bad weather such as fog and mist. It is also 
successful in removing the effects of optical Fog and Diffusion filters.

Go to the Defog - Tutorial on page 69 to see how the filter works.

Defog
Color

The Color parameter sets the color of the fog to be removed through the use of 
a standard color picker. The default color is white.
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Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 
to remove fog. By default, the vanishing point is set to the center of the screen. 
Essentially, the fog is removed in a radial pattern emanating from the vanishing 
point. So at the default center position, fog is removed in a circular pattern with 
a greater amount of fog being removed from the center while falling off at the 
edges. For instance, if your fog moves in the direction of top right to bottom left, 
set your vanishing point towards the top right corner and the fog removal will 
be more intense at the upper right and fall off at the bottom left. However, in 
most cases, the vanishing point can be left in the center of the screen and you 
will obtain acceptable results.

X
The horizontal position of the vanishing point.

Y
The vertical position of the vanishing point.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the position of the vanishing point can be adjusted. To see the 
on-screen control in After Effects, you may need to highlight Defog in the Effect 
Controls window, and in Final Cut Pro and Combustion, you will have to click on the 
crosshair icon to the right of the vanishing point parameter. On Avid Editing Systems, 
the Vanishing Point parameter is named only X and Y.

Defog
Sets the amount of fog to be removed from the scene.

Min Depth
Controls how much fog is removed from the darker areas of the image.

Max Depth
Controls how much fog is removed from the brighter areas of the image.

Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.
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Defog - Tutorial
Using advanced deweathering algorithms, Defog restores clear day contrasts 
and colors of a scene taken in bad weather such as fog and mist. It is also 
successful in removing the effects of optical Fog and Diffusion filters.

1 Apply the Defog filter to an image.
2 Click on the Defog>Color picker and click on an area of fog.

This sets the color of the fog to be removed.

3 Adjust the Defog>Defog parameter to remove more fog or mist.
The fog is removed in a radial pattern emanating from the vanishing point. For 
instance, if your fog moves in the direction of top right to bottom left, set your 
vanishing point towards the top right corner and the fog removal will be more 
intense at the upper right and fall off at the bottom left. However, in most cases, 
the vanishing point can be left in the center of the screen and you will obtain 
acceptable results.

4 If needed, move the Vanishing Point to a new location by clicking and dragging 
the on-screen control in the center of the of the screen.
If the defogging operation causes the shadow areas to become too contrasty, 
adjust the Min Depth slider to a lower value. This will bring back some shadow 
detail.

5 Lower the Min Depth value if you have lost to much detail in the shadow portions 
of the image.
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 DEFRINGE

Category
Lens.

Description
Purple or blue fringing around overexposed areas is a result of sensor 
overloading in video as well as digital still cameras. Defringe isolates and 
removes the various types of color fringing.

Go to the Defringe - Tutorial on page 71 to see how the filter works.

Red
Red

Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.

Position
A selection is generated to isolate red fringing. The areas that are white in the 
red selection are the areas that will be defringed. Moving the Position slider will 
change the hue that is used for the red selection.
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Range
Increases or decreases the range of values considered as red fringing. A low 
Range value indicates a narrow range of values, while a high Range value 
indicates a large range of values.

Go to the Selection section of General Controls on page 25 to see how the 
Position and Range controls work.

Green, Blue, Cyan, Magenta, and Yellow
The Green, Blue, Cyan, Magenta and Yellow groups work in a similar fashion 
to the Red group.

Defringe - Tutorial
Purple or blue fringing around overexposed areas is a result of sensor 
overloading in video as well as digital still cameras. Defringe isolates and 
removes the various types of color fringing.

1 Apply the Defringe filter to an image.
Determine the color of the fringing that you would like to remove. Let’s say that 
you have purple fringing in the highlight areas of your image.

2 Go to the Magenta parameter group.
3 Move the Magenta slider to the right until the purple fringing is gone.
4 If the purple fringing is not being removed when the Magenta slider is adjusted, 

you may need to adjust the Position slider.
5 Change your View to Magenta to see the selection values. 

The areas that are white in the selection are the areas that will be defringed.

6 Change your View back to Output.
7 Move the Position slider to the right or left until you see the fringing go away.

This may be necessary if your purple fringing is not the same hue of what we 
consider to be magenta.

8 If there is still some magenta left, you may want to increase the value of the 
Range slider to include more values considered as magenta.

9 Repeat the above steps for each type of color fringe you see in the image.
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 DEPTH OF FIELD

Category
Blurs.

Description
Depth of Field can be added to a scene by isolating and blurring only a portion 
of the image. The amount of blurring is directly proportionate to the luminance 
of the selection settings, a gradient or an input clip.
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Go to the Depth of Field - Tutorial on page 75 to see how the filter works.

Note to Avid Users: Depth of Field is a two-layer track effect. The lower track/layer is 
the background and the track/layer above is the foreground, which is also used as the 
depth source. If you want to use only one image (as in the example above), just place 
the same image on two adjacent tracks/layers.

Depth
Selects the source for the depth of field effect.

Selection
Use the selection for the depth source.

Grad
Use the grad for the depth source.

Input
Load a file for use as the depth source. This is useful for 3D programs which 
render out depth mattes. 

Note: To load a file as the depth source in Photoshop, make sure that it is a grayscale 
image and save it as either a JPG or PNG. It will then show up in the browser when you 
click on the Depth>Input>Browse button.

Blur
Horizontal Blur

The image is blurred by a quality blur along the X-axis.

Vertical Blur
The image is blurred by a quality blur along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.
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Grad 
Depth of Field can optionally use a gradient that limits where the filter is 
adjusted. Grad is the transition area that goes from the blurred portion to the 
original image. Its direction, corners and size can be adjusted. Go to the Grad 
section of Color Grad on page 50 to see how the Grad controls work.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Depth of Field - Tutorial
Depth of Field can be added to a scene by isolating and blurring only a portion 
of the image. The amount of blurring is directly proportionate to the luminance 
of the depth source.

1 Apply the Depth of Field filter to an image.
Note to Avid Users: Depth of Field is a two-layer track effect. The lower track/layer is 
the background and the track/layer above is the foreground, which is also used as the 
depth source. If you want to use only one image, just place the same image on two 
adjacent tracks/layers.

2 Adjust the Horizontal and Vertical Blur to your liking.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, depth of field.

3 Change your View to Depth to see the selection values. 
The areas that are white in the selection are the areas where blur will be 
introduced. The location of the blur within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

4 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

5 Increase the Selection>Range value to add more blur into the scene. Decrease 
for less blur.

6 Increase the Selection>Blur parameter to soften the transition areas of the added 
blur.

7 Change your View to Output to see the filtered image.
The Depth of Field filter can also use a grad or an image as the depth source 
instead of the selection.

8 Set the Depth to Grad.
9 Adjust the Grad>Direction, Corner Points and Size to change where the blur is 

added.
To use an image as the depth source, do one of the following:

10 In Adobe Photosop:
• Change Depth to Input. 
• Click the Browse button.
• Select a either a grayscale JPG or PNG file.
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or

11 In Adobe After Effects:
• Change Depth to Input. 
• Select the layer you want to use from the Depth>Input selector.
or

12 In Apple Final Cut Pro:
• Change Depth to Input. 
• Drag and drop a clip onto the clip icon to the right of the Depth>Input parameter.
or

13 In Avid Editing Systems:
• Change Depth to Input.  
The foreground track (the one you applied the filter to) is now used as the depth 
source.
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 DIFFUSION

Category
Diffusion.

Description
Diffusion creates atmosphere by reducing contrast while creating a glow 
around highlights or shadows. It simulates diffusion and fog filters as well as 
glows. In addition, a pre-built texture library allows you to add realistic diffusion 
to scenes as if you were adding diffusion directly to your camera lens.

Go to the Diffusion - Tutorial on page 80 to see how the filter works.

Diffusion
Diffusion

Determines the method used to create the diffusion effect.

Spread
The diffusion spreads beyond the areas defined by the selection.

Subtle
The diffusion is constrained by the areas defined by the selection.
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Blend
Determines the blend mode to be used to create the diffusion effect.

Add
The diffusion is added to your image.

Screen
The diffusion is combined with the image using a Screen blend mode. This 
looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the diffusion.

Blur
Sets the softness of the diffusion. Go to the Blur section of General Controls 
on page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the diffusion through the use of a 
standard color picker. The default color is white.

Texture
Texture

A pre-built texture library can be used to add diffusion to an image. Go to 
Appendix A on page 271 to view the textures.

Note: The Photoshop version uses a Browser to load the textures instead of a pop-up 
menu.

Blend
Textures can be used as the source of the diffusion as well as combined with 
the selection created with the Selection parameters using a variety of Blend 
modes. Go to Appendix C on page 280 to see visual examples of the various 
Blend modes.

I like the Multiply blend mode for combining textures with the selection because 
it only puts the texture within the areas of the generated selection.
mm v7 User Guide



• 

Diffusion  79 
• 
• 
• 
•
•
•

DVE
The DVE allows you to transform your texture using Position, Scale, Rotation, 
Corner Pin, Shear and Crop controls.

Go to the DVE section of General Controls on page 22 to see how the DVE 
Controls work.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Diffusion - Tutorial
1 Apply the Diffusion filter to an image.
2 Adjust the Diffusion>Brightness parameter to control the amount of diffusion 

added to the image.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, diffusion.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where diffusion will be 
introduced. The location of the diffusion within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

4 Change the Selection>Position parameter if you want to add diffusion to different 
areas of the image.

5 Adjust the Selection>Range slider to increase or decrease the image areas 
affected by the diffusion.

6 For Avid, After Effects, or Final Cut Pro, if you want to use a texture as the source 
of the diffusion, select one from the Texture pull-down menu.

7 For Photoshop users, if you want to select a texture as the source of the 
diffusion, choose one by clicking on the Browse button in the Texture menu. If 
you want to use your own texture, create a grayscale image and save it as either 
a JPG or PNG file in the Adobe\Photoshop\Plug-Ins\DFT 55mm v7\textures 
folder. It will then show up in the browser when you click on the Texture>Browse 
button.
You can either use the texture by itself or combine it with the selection using 
one of the Texture>Blend Modes.

8 Change your View to Output to see the filtered image.
9 Using the Texture>DVE controls, you can move the texture around.
10 Adjust the Diffusion>Brightness, Blur and Color of the diffusion to your liking.
mm v7 User Guide



• 

Double Fog  81 
• 
• 
• 
•
•
•

 DOUBLE FOG

Category
Diffusion.

Description
The Double Fog filter creates a soft, misty atmosphere over the image by first 
applying fog using a vanishing point along the direction of increasing distance 
in the image. Then, a second pass blooms image highlights. 

Go to the Double Fog - Tutorial on page 84 to see how the filter works.

Fog
Color

The Color parameter sets the color of the fog to be added through the use of a 
standard color picker. The default color is white.
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Vanishing Point
A vanishing point along the direction of increasing distance in the image is used 
to add fog. By default, the vanishing point is set to the center of the screen. 
Essentially, the fog is added in a radial pattern emanating from the vanishing 
point. So at the default center position, fog is added in a circular pattern with a 
greater amount of fog being added in the center while falling off at the edges. 
For instance, if you would like your fog to move in the direction of top right to 
bottom left, set your vanishing point towards the top right corner and the fog will 
be more intense at the upper right and fall off at the bottom left. However, in 
most cases, the vanishing point can be left in the center of the screen and you 
will obtain acceptable results. 

X
The horizontal position of the vanishing point.

Y
The vertical position of the vanishing point.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the position of the vanishing point can be adjusted. To see the 
on-screen control in After Effects, you may need to highlight Double Fog in the Effect 
Controls window, and in Final Cut Pro and Combustion, you will have to click on the 
crosshair icon to the right of the vanishing point parameter. On Avid Editing Systems, 
the Vanishing Point parameters are named only X and Y.

Fog
Sets the amount of fog to be added to the scene.

Min Depth
Controls how much fog is added in the darker areas of the image.

Max Depth
Controls how much fog is added in the brighter areas of the image.
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Glow
The Glow controls are used to add additional atmosphere and are useful in 
adding glow to highlights. By default, a wide selection of highlights are glowed 
in the image and blended with the Screen blend mode. This works well for 
adding additional fog. To add glow around highlights such as light sources, it is 
best to set the Blend mode to Add and lower the Selection>Range parameter 
to limit the areas of glow to only include the light sources.

Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the glow through the use of a standard 
color picker. The default color is white.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Double Fog - Tutorial
The Double Fog filter creates a soft, misty atmosphere over the image by first 
applying fog using a vanishing point along the direction of increasing distance 
in the image. Then, a second pass blooms image highlights.

1 Apply the Double Fog filter to an image.
2 Click on the Fog>Color parameter to set the color of the fog.

This sets the color of the fog to be added.

3 Adjust the Fog>Fog parameter to control how much overall fog is added to the 
image.
The fog is added in a radial pattern emanating from the vanishing point. For 
instance, if want your fog to move in the direction of top right to bottom left, set 
your vanishing point towards the top right corner and the fog will be more 
intense at the upper right and fall off at the bottom left. However, in most cases, 
the vanishing point can be left in the center of the screen and you will obtain 
acceptable results.

4 If needed, move the Vanishing Point to a new location by clicking and dragging 
the on-screen control in the center of the of the screen.
You can limit where the fog is added to your image by using the Min/Max Depth 
sliders. Min Depth controls how much fog is added in the darker areas of the 
image, while Max Depth controls how much fog is added in the brighter areas 
of the image.

5 Change the Min/Max Depth values if you want to control how fog is added in the 
shadow and highlight areas of the image.
Secondary fogging effects can be achieved using the Glow parameters. A 
portion of the screen is isolated with a selection, and based on this selection, 
additional fog and glow can be added.

6 Adjust the Glow>Brightness, Blur and Color settings to your liking.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, highlight glow.

7 Change your View to Selection to see the selection values.
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The areas that are white in the selection are the areas where glow will be 
introduced. For instance, If you want to put glow around bright lights, make sure 
that the light sources appear as white in the selection. The location and amount 
of the additional glow within the scene can be adjusted by modifying the 
Selection>Position and Selection>Range parameters.

8 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

9 Increase the Selection>Range value to add more glow into the scene. Decrease 
for less glow.

10 Increase the Selection>Blur parameter to soften the transition areas of the glow. 
The softness of the glow can also be adjusted using the Glow>Blur setting.

11 Change your View to Output to see the filtered image.
12 To create Glow effects around highlights such as bright lights, change your 

Glow>Blend parameter to Add and make sure that your selection includes only 
the light sources.
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 DUAL GRAD

Category
Grads / Tints.

Description
Dual Grad applies two photographic filters to the image which are blended 
together with a gradient.

Go to the Dual Grad - Tutorial on page 88 to see how the filter works.

Color 1
Sets the color for the top half of the image. Select the desired color using the 
color picker or choose a filter preset. The default color is blue.

Presets
Select one of the filters from the pop-up list. Go to Appendix D on page 283 to 
see the complete list of filters.

Before After
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Color
The Color parameter sets the color of the grad through the use of a standard 
color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Opacity
Sets the opacity of the color filter.

Color 2
The Color 2 controls are the same as the controls for Color 1 except that the 
default color is a sepia tone and is applied to the bottom half of the image.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Grad 
Grad is the transition area between the two tints. Its direction, corners and size 
can be adjusted. Go to the Grad section of Color Grad on page 50 to see how 
the Grad controls work.
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Dual Grad - Tutorial
Dual Grad applies two photographic filters to the image which are blended 
together with a gradient.

1 Apply the Dual Grad filter to an image.
2 To apply custom colors to the image, click on the Color 1 or Color 2>Color box’s 

and select a color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

3 To choose one of the preset filters, select a filter from the Color 1 or Color 
2>Presets list.

4 If you want less coloring of the image, turn down the Color 1 or Color 2>Opacity.
5 Image highlights can be retained by adjusting the Preserve Highlights control to 

a value of 100.
The color gradient can be adjusted to your specific image.

6 Adjust the Grad>Direction, Corner Points and Size to position and adjust the 
grad.
Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

7 Change your View to Grad to see the color gradient being applied to the image.
8 Change your View back to Output to see the filtered image.
mm v7 User Guide



• 

Edge Glow  89 
• 
• 
• 
•
•
•

 EDGE GLOW

Category
Light.

Description
Edge Glow isolates lines and edges in an image and then adds glow only to 
these areas resulting in a stylized look.

Go to the Edge Glow - Tutorial on page 91 to see how the filter works.

Glow
Glow

Determines the method used to create the edge glow effect.

Spread
The glow spreads beyond the areas defined by the selection.

Subtle
The glow is constrained by the areas defined by the selection.

Blend
Determines the blend mode to be used to create the edge glow effect.

Before After

Photos © THINKSTOCK LLC--WWW.THINKSTOCK.COM
55mm v7 User Guide    
• 
• 
•
•
•



   55

90 Edge Glow

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Add
The edge glow is added to your image.

Screen
The edge glow is combined with the image using a Screen blend mode. This 
looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the edge glow.

Blur
Sets the softness of the edge glow. Go to the Blur section of General Controls 
on page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the edge glow through the use of a 
standard color picker. The default color is white.

Edge
An edge selection is created to produce the edge glow effect.

Brightness
Determines the brightness of the edge selection.

Blur
Blurs the edge selection.
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Edge Glow - Tutorial
Edge Glow isolates lines and edges in an image and then adds glow only to 
these areas resulting in a stylized look.

1 Apply the Edge Glow filter to an image.
2 Select either the Add or Screen Blend Mode. Add will burn out highlights while 

the Screen Mode will retain them.
3 Adjust the Glow>Brightness, Blur and Color settings to your liking.

In Edge Glow, an edge selection is generated to create the desired effect.

4 Change your View to Edge to see the selection values. 
The areas that are white in the edge selection are the areas where glow will be 
introduced.

5 Adjust the Edge>Brightness to make sure that you have sufficient white areas in 
the edge selection.

6 Set the Edge>Blur to smooth out the edge selection.
7 Change your View to Output to see the filtered image.
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 ENHANCING

Category
Color Correct.

Description
The saturation of either the red, green or blue areas of the image are isolated 
and enhanced with minimal effect on other colors. This filter is frequently used 
to enhance fall foliage, but is also ideal for blue sky and green grass.

Go to the Enhancing - Tutorial on page 94 to see how the filter works.

Enhancing
Adjusts the saturation of red, green or blue hues.

Selection
In the Enhancing filter, a selection is generated to enhance colors.

Presets
Custom
Presets the Selection to Red.

Before After
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Red
Presets the Selection to Red.

Green
Presets the Selection to Green.

Blue
Presets the Selection to Blue.

Hue
A selection is created based on the hue of the image. When adjusting the Hue 
parameter, you are selecting the hue of the image which will be enhanced. The 
Hue is preset to red values.

Note: The Hue Color picker allows you to select a custom selection color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Range
Increases or decreases the range of values in the selection. A low Range value 
indicates a narrow range of values. A high Range value indicates a large range 
of values included in the selection

Blur
Blurs the selection.
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.Enhancing - Tutorial
The saturation of either the red, green or blue areas of the image are isolated 
and enhanced with minimal effect on other colors.

1 Apply the Enhancing filter to an image.
2 Adjust the Enhancing slider to make the red, orange and brown values pop.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, the enhancement effect. By default, the Selection>Hue is 
preset to red values.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the red, orange and brown areas 
of the image that will be enhanced. The enhancement effect within the scene 
can be adjusted by modifying the Selection>Hue and Selection>Range 
parameters.

4 Choose another Selection>Preset or change the Selection>Hue parameter if you 
want to add enhancement to different areas of the image.

5 Adjust the Selection>Range slider to increase or decrease the areas affected by 
the enhancement.

6 Change your View to Output to see the image.
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 FAUX FILM

Category
Film Lab.

Description
The Faux Film filter attempts to give video and digital images the look of 
photographic film. It reduces contrast, creates a soft mist around highlights and 
adds film grain.

Go to the Faux Film - Tutorial on page 97 to see how the filter works.

Mist
Mist

Determines the method used to create the mist effect.

Spread
The mist spreads beyond the areas defined by the selection.

Subtle
The mist is constrained by the areas defined by the selection.

Before After

Photos © THINKSTOCK LLC--WWW.THINKSTOCK.COM
55mm v7 User Guide    
• 
• 
•
•
•



   55

96 Faux Film

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the mist through the use of a standard 
color picker. The default color is white.

Grain
Go to the Grain filter on page 120 to see how the Grain controls work.

Warning to Photoshop users: You may not see the grain size change in the Preview 
window unless you are set to a 1:1 zoom ratio. 

Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Faux Film - Tutorial
The Faux Film filter attempts to give video and digital images the look of 
photographic film. It reduces contrast, creates a soft mist around highlights and 
adds film grain.

1 Apply the Faux Film filter to an image.
2 Adjust the Mist>Brightness, Blur and Color settings to your liking.
3 If you want, you can use the Color Correct controls to modify the color of the 

image.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, mist.

4 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where mist will be 
introduced. The location of the mist within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

5 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

6 Increase the Selection>Range value to add more mist into the scene. Decrease 
for less mist.

7 Increase the Selection>Blur parameter to soften the transition areas of the mist. 
8 Change your View to Output to see the filtered image.
9 The softness of the mist can also be adjusted using the Mist>Blur setting.
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 FLASHING

Category
Film Lab.

Description
Flashing allows you to use photographic filters to lower the contrast of your 
shadows or highlights. The motion picture lab can expose a small amount of 
light to the film at various stages of the developing and printing process. For 
example, Negative plus Dupe Negative flashing lifts blacks, while Print plus 
Master Positive flashing softens whites.

Go to the Flashing - Tutorial on page 100 to see how the filter works.

Shadows
Brightness

Raises the brightness of the shadows using either the Shadow>Color or 
Shadow>Presets.

Presets
Select one of the filters from the pop-up list. Go to Appendix D on page 283 to 
see the complete list of filters.
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Color
The Color parameter sets the color of the flashing through the use of a standard 
color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Position
Selects the shadow values to be adjusted when using the Shadows slider.

Range
Controls the range of values to be used for the shadows. A higher Range value 
considers more values as shadows. 

Highlights
Brightness

Lowers the brightness of the highlights using either the Highlights>Color or 
Highlights>Presets.

Presets
Select one of the filters from the pop-up list.

Color
The Color parameter sets the color of the flashing through the use of a standard 
color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Position
Selects the highlight values to be adjusted when using the Highlights slider.

Range
Controls the range of values to be used for the highlights. A higher Range value 
considers more values as highlights. 
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Flashing - Tutorial
Flashing allows you to use photographic filters to lower the contrast of your 
shadows or highlights.

1 Apply the Flashing filter to an image.
2 Adjust the Shadows>Brightness slider to brighten shadow areas.
3 Adjust the Highlights>Brightness slider to darken highlight areas.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, flashing.

4 To flash the Shadows or Highlights with a custom color, click on the Shadows or 
Highlights>Color box and select a color.
Note: The Color picker allows you to use a custom color, but is only active when the 
Custom option has been selected in the Presets pop-up menu.

5 To choose one of the preset filters, select a filter from the Shadows or 
Highlights>Presets list.

6 Change your View to Shadows or Highlights to see the selection values. 
The areas that are white in the selection are the areas that will be adjusted by 
either the Shadows or Highlights sliders. The areas defined as Shadows or 
Highlights can be adjusted by modifying the Position and Range parameters.

7 Adjust the Shadows or Highlights Position and Range controls to change what 
is considered Shadows or Highlights.

8 Change your View to Output to see the image.
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 FLUORESCENT

Category
Color Correct.

Description
The fluorescent filter removes the greenish tone caused by photographing 
under fluorescent lights.

Temperature
Removes the greenish tone caused by photographing under fluorescent lights.
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 FOG

Category
Diffusion.

Description
Fog

The Fog filter creates a soft, misty atmosphere over the image and glows 
highlights.

Go to the Fog - Tutorial on page 104 to see how the filters work.

Fog
Fog

Determines the method used to create the fog effect.

Spread
The fog spreads beyond the areas defined by the selection.
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Subtle
The fog is constrained by the areas defined by the selection.

Blend
Determines the blend mode to be used to create the fog effect.

Add
The fog is added to your image.

Screen
The fog is combined with the image using a Screen blend mode. This looks kind 
of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the fog.

Blur
Sets the softness of the fog. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the fog through the use of a standard 
color picker. The default color is white.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Fog - Tutorial
The Fog filter creates a soft, misty atmosphere over the image and glows 
highlights.

1 Apply the Fog filter to an image.
2 Adjust the Fog>Brightness, Blur and Color settings to your liking.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, fog.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where fog will be 
introduced. The location of the fog within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

4 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

5 Increase the Selection>Range value to add more fog into the scene. Decrease for 
less fog.

6 Increase the Selection>Blur parameter to soften the transition areas of the fog. 
The softness of the fog can also be adjusted using the Fog>Blur setting.

7 Change your View to Output to see the filtered image.
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 F-STOP

Category
Color Correct.

Description
F-Stop manipulates red, green and blue values of the overall image and 
separately in user definable shadow, midtone and highlight areas using F-Stops 
as the unit of measure. In camera terminology, F-Stops measure the size of the 
lens opening, otherwise known as aperture. Each F-Stop is twice as bright as 
the next. 

F-Stop works in a similar fashion as Color Correct eventhough the color 
adjustments are slightly different. So, go to the Color Correct Tutorial on 
page 47 to see how the filter works.

Master
The master settings affect the entire image.
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Red Exposure
Adds or subtracts red from the image.

Green Exposure
Adds or subtracts green from the image.

Blue Exposure
Adds or subtracts blue from the image.

Gang
The Red, Blue and Green Exposure slider values can be ganged together. 
Slide the Red Exposure slider to affect all three values.

Shadows, Midtones, Highlights
Adjusting parameters within the shadows, midtones and highlights will only 
affect those specific areas. If you are unsure about what values are included in 
the shadows, midtones and highlights, you can use the View pop-up menu. It 
will allow you to view the shadows, midtones and highlights as a black and 
white selection. The white areas are the areas that will be adjusted by that 
particular group. For instance, if you see white areas while viewing the 
midtones, then midtone color adjustments will affect only those white areas. If 
you want to change the default areas defined by the shadows, midtones and 
highlights, you would use the Position and Range sliders.

Go to the Selection section of General Controls on page 25 to see how the 
Position and Range controls work.

Position
The Position slider pinpoints the values to be considered as shadows, 
midtones, or highlights. A low Position value uses the darkest image values, 
while a high Position value uses the brightest.

Range
Increases or decreases the range of values considered as shadows, midtones 
or highlights. A low Range value indicates a narrow range of values, while a 
high Range value indicates a large range of values.
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Red Exposure
Adds or subtracts red from the entire image.

Green Exposure
Adds or subtracts green from the entire image.

Blue Exposure
Adds or subtracts blue from the entire image.

Gang
The Red, Blue and Green Exposure slider values can be ganged together. 
Slide the Red Exposure slider to affect all three values.
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 GELS

Category
Gels.

Description
Photographers, cinematographers and lighting designers use colored filters or 
gels in front of lights. Whether they want to create a romantic moonlit setting or 
a vicious, angry fight, they have the colors they need to achieve the effect. We 
have created digital equivalents of these lighting gels and these same exact 
colors can be applied to the entire image or inside a gradient. In cooperation 
with GAMPRODUCTS, INC. and Rosco USA, we have created digital versions 
of their popular gels.

Go to the Gels - Tutorial on page 114 to see how the filters work.
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GamColor Gels
Digital equivalents of the lighting gels created by GAMPRODUCTS, INC. can  
be applied to the entire image or inside a gradient. These three GAM filters 
contain digital gels from the GamColor, CineFilters, Naked Cosmetics 
collections. For detailed information about GAM Gels, you can visit their 
website at www.gamonline.com
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GamColor
The GamColor system divides the visible spectrum into nine color sections 
convenient to the lighting designer. It is a circular classification of colors by hue, 
referencing the primaries, secondaries and important subdivisions. The 
GamColor gels are arranged according to this system, making it easy to locate 
any color in a logical manner.

Go to Appendix G - Gam Color on page 293 to see the complete list of gels.
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GamColor CineFilters
CineFilters change the color temperature to balance your lighting situation 
using a variety of filters including CTO(sunlight to incandescent), 
CTB(incandescent to daylight), ND(light reducing), Minus Green(eliminates the 
peak green output of fluorescent lights) and Plus Green(incandescent to 
fluorescent).

GamColor Naked Cosmetics
Naked Cosmetics™ are designed to modify skin tones. Use them to blend and 
enhance skin tones while masking undesirable undertones. The choice of 
which Naked Cosmetics™ to use depends on a few variables. Skin color of the 
subjects, costumes, make-up, the recording medium, the desired effect, and 
most important, your artistic taste.

Gels
A set of generic lighting gels are provided within the Gels filter. Go to Appendix 
G - Gels on page 298 to see the complete list of gels.

Rosco Gels
Digital equivalents of the lighting gels created by Rosco can be applied to the 
entire image or inside a gradient. These four Rosco filters contain gels from the 
Calcolor, Cinegels, Cinelux and Storaro Selection. For detailed information 
about Rosco Gels, you can visit their website at www.rosco.com.

Rosco Calcolor
Calibrated color, by Rosco, is a series of color effects lighting gels designed 
specifically to the spectral sensitivity of color film. The series includes the 
primary colors Blue, Green and Red, along with the secondary colors Yellow, 
Magenta and Cyan followed by Pink and Lavender. Each color is designed in 
four densities: 15, 30, 60 and 90, corresponding to the familiar ½, 1, 2 and 3 
stop calibrations.  Go to Appendix G - Rosco Calcolor on page 313 to see the 
complete list of gels.
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Rosco Cinegel
The Rosco Cinegel range includes over 75 tools for controlling light including 
Tungsten Conversion Filters, Daylight Conversion Filters, Sun 85 & Neutral 
Density Filters, Filters for Controlling Carbon ARC & HMI Lighting as well as 
Fluorescent Light Filters. In 1974, Cinegel won an Academy Award for 
technical achievement. Go to Appendix G - Rosco Cinegel on page 306 to 
see the complete list of gels. 

Rosco Cinelux
Cinelux is a selection from the Roscolux range of color gels. Go to Appendix 
G - Rosco Cinelux on page 308 to see the complete list of gels.

Rosco Storaro Selection
The Storaro Selection contains ten color effects lighting gels designed to the 
personal specifications of eminent cinematographer Vittorio Storaro. These ten 
colors represent key chromatic elements of the visible spectrum, and are 
intended for dramatic effect and strong emotional response. Go to Appendix 
G - Rosco Storaro Selection on page 313 to see the complete list of gels.

Gels
Presets

Select one of the many gels from the pop-up list.

Color
The Color parameter sets the color through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.
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Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the gel 
application.

Grad 
Gels can optionally use a gradient that limits where the image is adjusted. Grad 
is the transition area that goes from the colored portion to the original image. 
Its direction, corners and size can be adjusted. Go to the Grad section of Color 
Grad on page 50 to see how the Grad controls work.
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Gels - Tutorial
Photographers, cinematographers and lighting designers use colored filters or 
gels in front of lights. We have created digital equivalents of the lighting gels 
and these same exact colors can be applied to the entire image or inside a 
gradient.

1 Apply one of the Gel filters to an image.
2 Select the desired gel from the Gels>Presets pulldown menu.

The selected gel can be applied through a gradient creating a graduated 
transition between the colored portion and the original image.

3 Click on the Grad>Enable checkbox to activate the Grad.
4 Adjust the Grad>Direction, Corner Points and Size.

Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

5 Adjust the Gels>Opacity, Preserve Highlights and Exposure Compensation 
sliders to your liking.
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 GLOW

Category
Light.

Description
The Glow filter creates glows around selected areas of the image.

Go to the Glow - Tutorial on page 117 to see how the filter works.

Glow
Glow

Determines the method used to create the glow effect.

Spread
The glow spreads beyond the areas defined by the selection.

Subtle
The glow is constrained by the areas defined by the selection.
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Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the glow through the use of a standard 
color picker. The default color is white.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Glow - Tutorial
Glow creates glows around selected areas of the image based on a generated 
selection. 

1 Apply the Glow filter to an image.
2 Select either the Add or Screen Blend Mode. Add will burn out highlights while 

the Screen Mode will retain them.
3 Adjust the Glow>Brightness, Blur and Color settings to your liking.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, glow.

4 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where glow will be 
introduced. The location of the glow within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

5 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

6 Increase the Selection>Range value to add more glow into the scene. Decrease 
for less glow.

7 Increase the Selection>Blur parameter to soften the transition areas of the glow. 
The softness of the glow can also be adjusted using the Glow>Blur setting.

8 Change your View to Output to see the filtered image.
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 GOLD REFLECTOR, SILVER REFLECTOR

Category
Light.

Description
One of the oldest and still most popular means of lighting an exterior set is by 
taking a reflective surface and redirecting sunlight or artificial light exactly 
where it is needed. Unfortunately, it is nearly impossible for actors to keep their 
eyes open when looking into a reflector resulting in a lot of squinting eyes. Our 
digital reflector allows you to add white or gold light into shadow areas without 
the squinting.

Go to the Reflector - Tutorial on page 119 to see how the filter works.

Brightness
Sets the intensity of the reflector.
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Color
The Color parameter sets the color of the reflector through the use of a 
standard color picker. The default color is gold for Gold Reflector and white for 
Silver Reflector.

Position
Selects the shadow values that will be adjusted with the Brightness slider.

Range
Controls the range of shadow values that will be adjusted with the Brightness 
slider.

Reflector - Tutorial
Reflector allows you to add white or gold light into shadow areas.

1 Apply either the Gold or Silver Reflector filter to an image.
2 Adjust the Brightness and Color settings to your liking.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, light reflecting into the shadow areas.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where light will be 
introduced. The location of the light within the scene can be adjusted by 
modifying the Position and Range parameters.

4 Change the Position parameter if you want to select different luminance values 
to be used for the selection.

5 Increase the Range value to add more light into the scene. Decrease for less 
light.

6 Change your View to Output to see the filtered image.
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 GRAIN

Category
Film Lab.

Description
Grain simulates film grain with individual control of red, green, and blue grain 
size and intensity. In addition, a Film Response parameter controls where you 
will see grain in the image. Popular film stock presets are provided as a starting 
point to adding grain.

Go to the Grain - Tutorial on page 123 to see how the filter works.

Presets
Select one of the many film grain presets from the pop-up list.

Note: On Avid Editing Systems and Apple Final Cut Pro, the Grain parameters are 
deactivated when a preset has been selected.
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Monochrome
When checked, the grain is monochrome. In this mode, only the Red Size, Red 
Amount and Red Softness sliders are active. Since the grain is monochrome, 
only one slider is needed.

Size
The Size parameters control the size of the grain. Sometimes a film stock’s 
grain structure varies in size from one color channel to another, so individual 
control has been given. The larger the Size settings, the larger the grain will be.

Warning to Photoshop users: You may not see the grain size change in the Preview 
window unless you are set to a 1:1 zoom ratio. 

Red Size
Controls the size of the red grain.

Green Size
Controls the size of the green grain.

Blue Size
Controls the size of the blue grain.

Amount
The Amount parameters set the red, green and blue intensities of the grain. 
Film stocks generally have varying amounts of red, green and blue intensities 
with the blue intensity generally higher than the rest. If you turn the red, green 
and blue amount sliders to a value of 0, the grain will disappear.

Red Amount
Controls the intensity of the red grain.

Green Amount
Controls the intensity of the green grain.

Blue Amount
Controls the intensity of the blue grain.
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Softness
The Softness parameters control the softness of the grain. Some film stock’s 
grain structure varies in softness from one color channel to another, so 
individual control has been given. Normally, only minor softness adjustments 
are necessary, usually between a value of 0-1.

Red Softness
Controls the softness of the red grain.

Green Softness
Controls the softness of the green grain.

Blue Softness
Controls the softness of the blue grain.

Film Response
The Film Response parameter allows the adjustment of where you will see 
grain in the image. In most cases, film grain is apparent over the entire image 
except the brightest whites with the black areas being the most affected.

Position
The Position slider defines the portions of the image where grain will be added. 
A low Position value places grain in the darkest image values, while a high 
Position value places grain in the brightest areas.

Range
Increases or decreases the area where grain is added to the image based on 
the value of the Position slider. A low Range value indicates a narrow range of 
values, while a high Range value indicates a large range of values.

Minimum
Sets the minimum level of grain that is always added to the image.

Note: A Position value of 0 and a Range of 80 is typical of standard film, with grain 
applied to the entire range except the brightest whites with black being the most 
affected.
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Grain - Tutorial
Grain simulates film grain with individual control of red, green, and blue grain 
size and intensity.

1 Apply the Grain filter to an image.
2 If you’d like, select one of the grain presets from the pop-up list.

Note: On Avid Editing Systems and Apple Final Cut Pro, the Grain parameters are 
deactivated when a preset has been selected.

3 Adjust the Red, Green and Blue Size parameters.
The Size parameters control the size of the grain. Sometimes a film stock’s 
grain structure varies in size from one color channel to another, so individual 
control has been given. The larger the Size settings, the larger the grain will be.

4 Manipulate the Red, Green and Blue Amount parameters.
The Amount parameters set the red, green and blue intensities of the grain. 
Film stocks generally have varying amounts of red, green and blue intensities 
with the blue intensity generally higher than the rest. If you turn the red, green 
and blue amount sliders to a value of 0, the grain will disappear.

5 Change the Red, Green and Blue Softness parameters.
The Softness parameters set the red, green and blue softness of the grain. 
Some film stock’s grain structure varies in softness from one color channel to 
another, so individual control has been given. Normally, only minor softness 
adjustments are necessary, usually between a value of 0-1. 

6 Adjust the Response Position and Response Range to control where you will see 
grain in the image. 
In most cases, film grain is apparent over the entire image except the brightest 
whites with the black areas being the most affected. A low Response Position 
value places grain in the darkest image values, while a high Response Position 
value places grain in the brightest areas. Response Range will increase or 
decrease the area where grain is added to the image based on the value of the 
Response Position slider.

7 If you want, use Response Minimum to set the minimum level of grain that is 
always added to the image.
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 HALO

Category
Effects.

Description
Halo causes dark areas to glow into bright areas and bright areas to glow into 
dark areas along with a bit of diffusion.

Go to the Halo - Tutorial on page 125 to see how the filter works.

Diffusion
Horizontal Blur

The image is diffused by a fast, quality blur along the X-axis.

Vertical Blur
The image is diffused by a fast, quality blur along the Y-axis.
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Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.

Opacity
Sets the amount of diffusion mixed into the original image. The higher the 
setting, the more the image is blurred.

Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.

Halo - Tutorial
Halo causes dark areas to glow into bright areas and bright areas to glow into 
dark areas along with a bit of diffusion.

1 Apply the Halo filter to an image.
Halo uses a type of diffusion that grows darks areas into bright areas and bright 
areas into dark areas. 

2 Adjust the Diffusion>Blur and Opacity parameters to your liking.
The Halo effect is enhanced by using a combination of color correction controls 
in addition to the diffusion.

3 Change the Color Correct settings if necessary.
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 INFRARED

Category
Effects.

Description
Infrared simulates infrared filters used in conjunction with infrared sensitive film 
or sensors to produce very interesting black and white images with halation in 
highlight areas.

Go to the Infrared - Tutorial on page 129 to see how the filter works.

Black and White
Selects the type of black and white filter to be applied to your color image.

Normal
Converts the color image to a monochrome image.

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.
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Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates an orange filter in black and white photography.

Mist
Mist

Determines the method used to create the mist effect.

Spread
The mist spreads beyond the areas defined by the selection.

Subtle
The mist is constrained by the areas defined by the selection.

Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.
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Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Infrared - Tutorial
Infrared simulates infrared filters used in conjunction with infrared sensitive film 
or sensors to produce very interesting black and white images with halation in 
highlight areas. 

1 Apply the Infrared filter to an image.
2 Choose the type of black and white filter to be applied to your color image from 

the Black and White pop-up menu.
The type of Black and White filter that you choose can dramatically change the 
look of your image.

3 Set the Mist>Brightness and Blur to your liking.
4 If you want, you can use the Color Correct controls to modify the Brightness, 

Contrast and Gamma of the image.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, mist.

5 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where mist will be 
introduced. The location of the mist within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

6 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

7 Increase the Selection>Range value to add more mist into the scene. Decrease 
for less mist.

8 Increase the Selection>Blur parameter to soften the transition areas of the mist. 
The softness of the mist can also be adjusted using the Mist>Blur setting.

9 Change your View to Output to see the filtered image.
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 KELVIN

Category
Color Correct.

Description
Degrees Kelvin is the standard unit of measure for color temperature and color 
temperature is a way to characterize the spectral properties of a light source. 
Low color temperature implies warmer (redder) light, while high color 
temperature implies a colder (bluer) light. Presets for a number of different light 
sources and conditions are provided in degrees Kelvin.

Go to the Color Temperature - Tutorial on page 132 to see how the filter 
works.

Color Temperature
The Color Temperature of the image is determined by the difference of the 
Destination and Source Kelvin parameters. For instance, if your Source Kelvin 
is 3200 degrees Kelvin and you adjust the Destination Kelvin to 6500 degrees, 

Before After

Photos © THINKSTOCK LLC--WWW.THINKSTOCK.COM
mm v7 User Guide



• 

Kelvin  131 
• 
• 
• 
•
•
•

your image would turn blue. This is the same as using tungsten indoor film 
meant to be used with lighting balanced for 3200 degrees Kelvin outside in 
daylight which is 6500 degrees Kelvin.

Presets
Select one of the temperature presets from the pop-up list. Go to Appendix E 
on page 286 to see the complete list of filters.

Destination Kelvin
Sets the destination color temperature of the image in degrees Kelvin.

Note: On Avid Editing Systems and Apple Final Cut Pro, the Destination Kelvin slider 
deactivates when a Preset has been applied.

Source Kelvin
Sets the source color temperature of the image in degrees Kelvin.

Opacity
Sets the opacity of the color Kelvin adjustment.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the Color 
Temperature application.

Grad 
Color temperature can optionally use a gradient that limits where the filter is 
adjusted. Grad is the transition area that goes from the colored portion to the 
original image. Its direction, corners and size can be adjusted. Go to the Grad 
section of Color Grad on page 50 to see how the Grad controls work.
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Kelvin - Tutorial
Degrees Kelvin is the standard unit of measure for color temperature and color 
temperature is a way to characterize the spectral properties of a light source. 
Low color temperature implies warmer (redder) light, while high color 
temperature implies a colder (bluer) light.

1 Apply the Kelvin filter to an image.
The Color Temperature of the image is determined by the difference of the 
Destination and Source Kelvin parameters.

2 Adjust the Destination Kelvin slider.
Presets for a number of different light sources and conditions are provided in 
degrees Kelvin, the standard unit of measure for color temperature.

Note: On Avid Editing Systems and Apple Final Cut Pro, the Destination Kelvin slider 
deactivates when a Preset has been applied.

3 From the Presets menu, select from one of the temperature presets.
The temperature adjustment can be applied through a gradient creating a 
graduated transition between the colored portion and the original image.

4 Click on the Grad>Enable checkbox to activate the Grad.
5 Adjust the Grad>Direction, Corner Points and Size.

Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

6 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

7 If you want less coloring of the image, turn down the Color Temperature>Opacity.
8 Image highlights can be retained by adjusting the Color Temperature>Preserve 

Highlights control to a value of 100.
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 LENS DISTORTION

Category
Lens.

Description
Lens Distortion corrects for pin-cushioning and barrel distortion of camera 
lenses. It is also useful for creating the look of a wide angle lens or placing the 
image into a television set.

Go to the Lens Distortion - Tutorial on page 135 to see how the filter works.

Notes: The Photoshop zoom controls only work at the Fit and 1:1 settings when using 
Lens Distortion.

Barrel Distortion Pin Cushion Distortion

Original
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Distortion
Pulls the corners of the image in or out. Negative values pull the corners of the 
image outward while positive values pull the corners of the image inward.

Anamorphic Squeeze
Anamorphic Squeeze corrects for the squeeze found in anamorphic motion 
picture lenses.

Curvature X and Y
Curvature X and Y correct for non-radial, asymmetric distortions found in 
anamorphic motion picture lenses.

Note: Anamorphic Squeeze and Curvature X and Y only work once the Distortion 
parameter has been moved.

Center
Determines the center point for the distortion.
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Center X
The horizontal position of the distortion.

Center Y
The vertical position of the distortion.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the Center can be adjusted. To see the on-screen control in After 
Effects, you may need to highlight Lens Distortion in the Effect Controls window, and in 
Final Cut Pro and Combustion, you will have to click on the crosshair icon to the right 
of the Center parameter. On Avid Editing Systems, the Center parameters are named 
only X and Y.

Lens Distortion - Tutorial
Lens Distortion corrects for pin-cushioning and barrel distortion of camera 
lenses. It is also useful for creating the look of a wide angle lens or placing the 
image into a television set.

1 Apply the Lens Distortion filter to an image.
To undo either Pin-cushioning or Barrel distortion, it is best if you can 
photograph a grid. You would then go about adjusting the various parameters 
to straighten out any curved lines. If you haven’t photographed a grid, find a 
curved line that should otherwise be straight.

2 Start by adjusting the Distortion control to straighten out any curved lines that 
should be straight.
Note: Positive Distortion parameters correct Pin-cushioning while negative values 
correct Barrel distortion.

Depending on the lens that was used, you may need to also adjust the 
Anamorphic Squeeze and Curvature X and Y parameters.
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 LIGHT!

Category
Light.

Description
Light can be added to a scene where none existed before just as if you were 
adding light at the time of shooting. Realistic lighting and shadow is introduced 
using the entire pattern/gobo library created by GAMPRODUCTS, INC. 

Normally used in front of lights during photography, these same exact patterns 
can be applied digitally to the entire image or inside a selection. There are 567 
patterns to choose from including blendables, breakups, Christmas, cityscapes 
and towns, clouds, fences and openings, fire and water, flags, flowers, foliage, 
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holidays and symbols, moons, natural elements, religion, signage, sky and 
stars, spirals, spotlights and pinspots, stones and brick, structures and sets, 
themes, trees, vignettes and windows. 

Photographers, cinematographers and lighting designers use colored filters or 
gels in front of lights. Whether they want to create a romantic moonlit setting or 
a vicious, angry fight, they have the colors they need to achieve the effect. 
Digital equivalents of the lighting gels created by GAMPRODUCTS, INC. can  
be applied to your light source. The GamColor system divides the visible 
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spectrum into nine color sections convenient to the lighting designer. It is a 
circular classification of colors by hue, referencing the primaries, secondaries 
and important subdivisions. 

The GamColor gels are arranged according to this system, making it easy to 
locate any color in a logical manner. For detailed information about GAM 
Patterns and Gels, you can visit their website at www.gamonline.com.

Go to the Light - Tutorials on page 147 to see how the filter works.

Note to Avid Users: Light is a two-layer track effect. The lower track/layer is the 
background and the track/layer above is the foreground, which is also used as the 
lighting source. If you want to use one image to add light to itself, just place the same 
image on two adjacent tracks/layers.
mm v7 User Guide
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Light
Blend

Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Screen
The light is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the light.

Displacement
Displaces the pattern by the luminance values of the image. This "fakes" the 
effect of light wrapping over objects in the image.

Blur
Sets the softness of the light. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Displaced Pattern            
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GamColor Presets
Digital equivalents of the lighting gels created by GAMPRODUCTS, INC. can  
be applied to your light source. Select one of the GamColor presets from the 
pop-up list. Go to Appendix G - Gam Color on page 293 to see the complete 
list of gels.

Color
Sets the color of the light through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

Shadow
Brightness

Sets the intensity of the shadows. The Brightness parameter will darken only 
those areas that are not being brightened by the Light settings. 
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Selection
A selection is used to create areas of light or constrain areas of added light 
patterns. Wherever there is a white in the selection is where the light will be 
added. When using Light, it is usually helpful to blur the selection. Go to the 
Selection section of General Controls on page 25 to see how the Selection 
controls work.

To use a selection to create light:
1 Shape>Blend Mode must be set to something other than Shape Only for the 

Selection controls to be active.
2 To use only the selection to create light, set the Gam Patterns to None. 

To use a selection to create light in Adobe Photoshop:
1 Shape>Blend Mode must be set to something other than Shape Only for the 

Selection controls to be active.
2 To use only the selection to create light, set the Shape>Blend Mode to None. 

Selection
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Shapes
Gam Patterns

Realistic lighting and shadow is introduced using the entire pattern/gobo library 
created by GAMPRODUCTS, INC. Normally used in front of lights during 
photography, these same exact patterns can be applied digitally to the entire 
image or inside a selection. There are 567 patterns to choose including 
blendables, breakups, Christmas, cityscapes and towns, clouds, fences and 
openings, fire and water, flags, flowers, foliage, holidays and symbols, moons, 
natural elements, religion, signage, sky and stars, spirals, spotlights and 
pinspots, stones and brick, structures and sets, themes, trees, vignettes and 
windows. For detailed information about GAM Patterns, you can visit their 
website at www.gamonline.com. Go to Appendix B on page 274 to see 
examples of all the patterns.
mm v7 User Guide
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Series 200, 300, 500, 600, 700, 800
Select a pattern from one of the Gam Pattern series.

Loading a Pattern
When using Adobe After Effects, Apple Final Cut Pro, or Avid Editing Systems, 
first select Series 200, 300, 500, 600, 700 or 800 in the Gam Patterns pop-up 
menu and then choose the desired pattern within the selected series.
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Loading a Pattern in Photoshop
In Photoshop, the patterns are loaded by clicking Shape>Gam Pattern>Browse 
button and selecting a pattern from the list. If you want to use your own pattern, 
create a grayscale image and save it as either a JPG or PNG file in the 
Adobe\Photoshop\Plug-Ins\DFT 55mm v7\gam patterns folder. It will then show 
up in the browser when you click on the Shape>Gam Pattern>Browse button.

Input
Input allows you to use a second image as the light source. 

To use an image as a light source:

Apple Final Cut Pro
• Select Input from the Shape>Gam Patterns menu.
• Drag and drop a clip onto the clip icon to the right of the Shape>Input parameter. 

Adobe After Effects
• Select Input from the Shape>Gam Patterns menu. 
• Select a layer from the Shape>Input menu. 

Avid Editing Systems
• Select Input from the Shape>Pattern list. 
The track that you added Light to is now used as the light source and applied 
to the track below. 

Note: If the camera is moving and you want to add a pattern, the pattern won’t 
automatically follow the camera. You will either need to manually move the pattern to 
follow the camera or better, use Motion Tracking software to Match Move the pattern to 
the camera move. For all systems except Avid systems, the patterns can be found in 
the DFT 55mm v7/gam patterns folder within the plug-ins folder. On Avid systems, the 
patterns can be found in the DFT 55mm v7 Light/gam patterns folder. Track the motion 
of your source image and apply that motion to your pattern and render it. To use the 
newly tracked and rendered pattern as a light source, follow the previous instructions 
listed for loading a pattern.

Blend
Once selected, the pattern can be added to the selection using a variety of 
Blend modes. Go to Appendix C on page 280 to see visual examples of the 
various Blend modes.
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I like the Multiply blend mode for combining patterns with the selection because 
it only puts the pattern within the areas of the selection.

Opacity
Sets the opacity of the pattern.

Selection Shape

Photos © THINKSTOCK LLC--WWW.THINKSTOCK.COM
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Blur
Sets the softness of the pattern. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

DVE
The DVE allows you to transform your pattern using Position, Scale, Rotation, 
Corner Pin, Shear and Crop controls. Go to the DVE section of General 
Controls on page 22 to see how the DVE Controls work.

Selection with Shape Blur=20
mm v7 User Guide
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Light Tutorial
Light can be added to scene where none existed before just as if you were 
adding light at the time of shooting. Realistic lighting and shadow is introduced 
using the entire pattern/gobo and gel library created by GAMPRODUCTS, INC. 

Adobe Photoshop - Light Tutorial
1 Apply the Light filter to an image.
2 Hit the Reset button.

The venetian blind pattern is applied to your image.

3 To select a different pattern, choose one by clicking the Shape>Gam 
Pattern>Browse button and take your pick.

4 If you want to use your own pattern, create a grayscale image and save it as 
either a JPG or PNG file in the Adobe\Photoshop\Plug-Ins\DFT 55mm v7\gam 
patterns folder. It will then show up in the browser when you click on the 
Shape>Gam Pattern>Browse button.

5 Using the Shape>Position, Scale, Rotate and Corner Pin controls, you can move 
the shape around.

6 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 
Adding blur to the light makes the light glow.

7 To apply a custom light color to the image, click on the Light>Color box and 
select a color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

8 To choose one of the GamColor gels, select a gel from the 
Light>GamColor>Presets list.

9 Combine the pattern with a selection by changing the Shape>Blend Mode from 
Shape Only to Multiply.
I like the Multiply blend mode because it only adds the shape in the areas of 
the selection.

10 Change your View selector to Selection to see the selection values. 
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The default selection settings are preset to a highlight selection to create the 
light effect. If you are not seeing sufficient light, your selection should be 
adjusted. The areas that are white in the selection are the areas where light will 
be added into the image. The location of the light within the scene can be 
adjusted by changing the Selection>Position and Range parameters.

11 Change the Selection>Position parameter if you want to select different values 
to be used for the light.

12 Increase the Selection>Range value to add more light into the scene. Decrease 
for less light.

13 Increase the Selection>Blur parameter to soften the transition areas of the light.
14 Change the View selector from Selection to Output.
15 The softness of the light can also be adjusted using the Light>Blur setting.
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Adobe After Effects - Light Tutorial
1 Apply the Light filter to a layer.

The venetian blind pattern is applied to your image.

2 To select a different pattern, first select Series 200, 300, 500, 600, 700 or 800 in 
the Gam Patterns pop-up menu and then choose the desired pattern within the 
selected series.

3 Using the Shape>DVE controls, you can move the shape around.
4 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

5 To apply a custom light color to the image, click on the Light>Color box and 
select a color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

6 To choose one of the GamColor gels, select a gel from the 
Light>GamColor>Presets list.

7 Combine the pattern with a selection by changing the Shape>Blend Mode from 
Shape Only to Multiply.
I like the Multiply blend mode because it only adds the shape in the areas of 
the selection.

8 Change your View selector to Selection to see the selection values. 
The default selection settings are preset to a highlight selection to create the 
light effect. If you are not seeing sufficient light, your selection should be 
adjusted. The areas that are white in the selection are the areas where light will 
be added into the image. The location of the light within the scene can be 
adjusted by changing the Selection>Position and Range parameters.

9 Change the Selection>Position parameter if you want to select different values 
to be used for the light.

10 Increase the Selection>Range value to add more light into the scene. Decrease 
for less light.

11 Increase the Selection>Blur parameter to soften the transition areas of the light.
12 Change the View selector from Selection to Output.
13 The softness of the light can also be adjusted using the Light>Blur setting.
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14 If the camera is moving and you want to add a pattern, the pattern won’t 
automatically follow the camera. You will either need to manually move the 
pattern to follow the camera or better, use Motion Tracking software to Match 
Move the pattern to the camera move. The patterns can be found in the After 
Effects/Plug-ins/DFT 55mm v7/gam patterns folder. 
• Track the motion of your source image, apply that motion to your pattern and 

render it out. 
• Import the newly tracked and rendered pattern into your composition below the 

layer you want to add lighting to. 
• To use your rendered light source, select Input from the Shape>Gam Patterns 

menu and then select the layer you want to use from the Shape>Input Selector.
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Apple Final Cut Pro - Light Tutorial
1 Apply the Light filter to a clip in the Timeline.

The venetian blind pattern is applied to your image.

2 To select a different pattern, first select Series 200, 300, 500, 600, 700 or 800 in 
the Gam Patterns pop-up menu and then choose the desired pattern within the 
selected series.

3 Using the Shape>DVE controls, you can move the shape around.
4 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

5 To apply a custom light color to the image, click on the Light>Color box and 
select a color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

6 To choose one of the GamColor gels, select a gel from the 
Light>GamColor>Presets list.

7 Combine the pattern with a selection by changing the Shape>Blend Mode from 
Shape Only to Multiply.
I like the Multiply blend mode because it only adds the shape in the areas of 
the selection.

8 Change your View selector to Selection to see the selection values. 
The default selection settings are preset to a highlight selection to create the 
light effect. If you are not seeing sufficient light, your selection should be 
adjusted. The areas that are white in the selection are the areas where light will 
be added into the image. The location of the light within the scene can be 
adjusted by changing the Selection>Position and Range parameters.

9 Change the Selection>Position parameter if you want to select different values 
to be used for the light.

10 Increase the Selection>Range value to add more light into the scene. Decrease 
for less light.

11 Increase the Selection>Blur parameter to soften the transition areas of the light.
12 Change the View selector from Selection to Output.
13 The softness of the light can also be adjusted using the Light>Blur setting.
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14 If the camera is moving and you want to add a pattern, the pattern won’t 
automatically follow the camera. You will either need to manually move the 
pattern to follow the camera or better, use Motion Tracking software to Match 
Move the pattern to the camera move. The patterns can be found in the 
/Library/Application Support/Final Cut Pro System Support/Plugins/DFT 55mm 
v7/gam patterns folder. 
• Track the motion of your source image, apply that motion to your pattern and 

render it.
• Import the newly tracked and rendered pattern into your project.
• Select Input from the Shape>Gam Pattern menu.
• To use your rendered light source, drag and drop the rendered motion tracked 

pattern onto the the clip icon to the right of the Shape>Input parameter.
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Avid Editing Systems - Light Tutorial
1 Apply the Light filter to the track above the track that you want to add light to. If 

you want to use one image to add light to itself, just place the same image on two 
adjacent tracks. If you use a different image on the foreground, this image can 
later be used as the lighting source.
The venetian blind pattern is applied to your image.

2 To select a different pattern, first select Series 200, 300, 500, 600, 700 or 800 in 
the Gam Patterns pop-up menu and then choose the desired pattern within the 
selected series.

3 Using the Shape>DVE controls, you can move the shape around.
4 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

5 To apply a custom light color to the image, click on the Light>Color box and 
select a color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

6 To choose one of the GamColor gels, select a gel from the 
Light>GamColor>Presets list.

7 Combine the pattern with a selection by changing the Shape>Blend Mode from 
Shape Only to Multiply.
I like the Multiply blend mode because it only adds the shape in the areas of 
the selection.

8 Change your View selector to Selection to see the selection values. 
The default selection settings are preset to a highlight selection to create the 
light effect. If you are not seeing sufficient light, your selection should be 
adjusted. The areas that are white in the selection are the areas where light will 
be added into the image. The location of the light within the scene can be 
adjusted by changing the Selection>Position and Range parameters.

9 Change the Selection>Position parameter if you want to select different values 
to be used for the light.

10 Increase the Selection>Range value to add more light into the scene. Decrease 
for less light.

11 Increase the Selection>Blur parameter to soften the transition areas of the light.
12 Change the View selector from Selection to Output.
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13 The softness of the light can also be adjusted using the Light>Blur setting.
14 If the camera is moving and you want to add a pattern, the pattern won’t 

automatically follow the camera. You will either need to manually move the 
pattern to follow the camera or better, use Motion Tracking software to Match 
Move the pattern to the camera move. The patterns can be found in the 
AVX_Plugins/DFT 55mm v7 Light/gam patterns folder.
• Track the motion of your source image, apply that motion to your pattern and 

render it. 
• Edit the rendered motion tracked pattern onto the layer above the image that you 

want to add light to.
• Reapply the Light filter to the layer that contains the motion tracked pattern.
• To use your own light source, select Input from the Shape>Gam Patterns menu. 

The foreground track (the one you applied the filter to) is now used as the light 
source.
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 LOW CONTRAST

Category
Diffusion.

Description
Low Contrast spreads highlights into darker areas, lowers contrast and keeps 
bright areas bright.

Go to the Low Contrast - Tutorial on page 156 to see how the filter works.

Contrast
Light Brightness

Sets the intensity of the light that is spread into darker areas.

Light Spread
Sets how far light is spread from bright areas to darker areas.

Shadow Brightness
Adjusts the brightness of the shadow areas.

Before After
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Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.

Low Contrast - Tutorial
Low Contrast spreads highlights into darker areas, lowers contrast and keeps 
bright areas bright.

1 Apply the Low Contrast filter to an image.
2 Adjust the Contrast>Light Brightness and Contrast>Light Spread to control the 

brightness and distance of the light being spread into the shadow areas.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, low contrast.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection will be the image areas used to spread 
light into the shadow areas. The location of the low contrast within the scene 
can be adjusted by modifying the Selection>Position and Selection>Range 
parameters.

4 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

5 Increase the Selection>Range value to add more low contrast into the scene. 
Decrease for less low contrast.

6 Change your View to Spread to see the special selection used to create the low 
contrast effect.
The Spread selection will change as the Contrast>Light Spread slider is 
adjusted.

7 Move the Contrast>Light Spread slider to see how it affects the Spread selection. 
Leave it at a value of 200 when you are done.

8 Change your View to Output to see the filtered image.
9 Adjust the Contrast>Shadow Brightness if your shadows are still too dark.
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 MIST, BLACK MIST 

Category
Diffusion.

Description
Mist

The Mist filter creates atmosphere by reducing contrast while creating a glow 
around highlights.

Black Mist
A more subtle version of Mist, the Black Mist filter creates atmosphere by 
reducing contrast, but with minimal glow around highlights.

Before Mist After

Black Mist After
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Go to the Mist - Tutorial on page 159 to see how the filters work.

Mist
Mist

Determines the method used to create the mist effect.

Spread
The mist spreads beyond the areas defined by the selection.

Subtle
The mist is constrained by the areas defined by the selection.

Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the mist through the use of a standard 
color picker. The default color is white.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Mist - Tutorial
Mist creates atmosphere by reducing contrast while creating a glow around 
highlights. Black Mist is a more subtle version of Mist, but creates minimal glow 
around highlights.

1 Apply either the Mist or Black Mist filter to an image.
2 Adjust the Mist>Brightness, Blur and Color settings to your liking.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, mist.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where mist will be 
introduced. The location of the mist within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

4 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

5 Increase the Selection>Range value to add more mist into the scene. Decrease 
for less mist.

6 Increase the Selection>Blur parameter to soften the transition areas of the mist. 
7 Change your View to Output to see the filtered image.
8 The softness of the mist can also be adjusted using the Mist>Blur setting.
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 MONO TINT

Category
Grads / Tints.

Description
Mono Tint converts color images to black and white while applying a color tint.

Go to the Mono Tint - Tutorial on page 162 to see how the filter works.

Black and White
Filter

The Filter pop-up selects the type of black and white filter to be applied to your 
color image.

Normal
Converts the color image to a monochrome image.

Before After

Photos © THINKSTOCK LLC--WWW.THINKSTOCK.COM
mm v7 User Guide



• 

Mono Tint  161 
• 
• 
• 
•
•
•

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates an orange filter in black and white photography.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.

Tint
Color

The Color parameter sets the color of the tint through the use of a standard 
color picker.

Opacity
Sets the opacity of the tint.
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Preserve Highlights
Preserves the white areas of the image.

Mono Tint - Tutorial
Mono Tint converts color images to black and white while applying a color tint.

1 Apply the Mono Tint filter to an image.
2 In the Black and White>Filter pop-up menu, select a filter to convert your image 

to Black and White.
3 Adjust the Tint>Color, Opacity and Preserve Highlights sliders to your liking.
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 ND GRAD

Category
Grads / Tints.

Description
The ND or Neutral Density Grad darkens only a portion of the image using a 
graduated transition between the darkened portion and the original image. It 
selectively adjusts brightness without affecting color balance. The most likely 
use for the ND Grad would be to balance the difference between the sky and 
the ground. F-Stops are used as the unit of measure to darken the image. In 
camera terminology, F-Stops measure the size of the lens opening, otherwise 
known as aperture. Each F-Stop is twice as bright as the next. 

Go to the ND Grad - Tutorial on page 164 to see how the filter works.

F-Stop
Presets

Select one of the ND Grad presets from the pop-up list.

Before After
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Exposure
Darkens the image using F-Stops as the unit of measure.

Note: On Avid Editing Systems and Apple Final Cut Pro, the Exposure slider 
deactivates when a Preset has been applied.

Preserve Highlights
Preserves the whites areas of the image.

Grad 
Grad is the transition area that goes from the darkened portion to the original 
image. Its direction, corners and size can be adjusted. Go to the Grad section 
of Color Grad on page 50 to see how the Grad controls work.

ND Grad - Tutorial
The ND or Neutral Density Grad darkens only a portion of the image using a 
graduated transition.

1 Apply the ND Grad filter to an image.
2 Adjust the Exposure slider to vary the amount of neutral density being applied 

to the image.
Note: On Avid Editing Systems and Apple Final Cut Pro, the Exposure slider 
deactivates when a Preset has been applied.

3 If you’d like, select one of the presets from the pop-up list.
4 Adjust the Grad>Direction, Corner Points and Size.

Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

5 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

6 If you want less darkening of the image in the area of the Grad, adjust F-
Stop>Exposure.
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 NIGHT VISION

Category
Effects.

Description
The Night Vision filter creates the effect of a Night Vision lens--that green, 
glowy, grainy look.

Go to the Night Vision - Tutorial on page 169 to see how the filter works.

Black and White
Selects the type of black and white filter to be applied to your color image.

Normal
Converts the color image to a monochrome image.

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Before After
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Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates an orange filter in black and white photography.

Tint
Color

Sets the color that the image will be tinted with. The color is preset to a night 
vision green, but feel free change it by using the color picker.

Tint Mode
Sets the color model that will be used to calculate the tinting. 

HSV
The HSV (Hue, Saturation, Value) tint mode creates a tint over the entire 
image. 

HLS
The HLS (Hue, Luminance, Saturation) tint mode creates a tint over the image, 
but preserves the black and white values.

Preserve Highlights
Preserves the white areas of the image when using the HLS tint mode.

Glow
Glow

Determines the method used to create the glow effect.

Spread
The glow spreads beyond the areas defined by the selection.
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Subtle
The glow is constrained by the areas defined by the selection.

Blend
Determines the blend mode to be used to create the glow effect.

Add
The glow is added to your image.

Screen
The glow is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the glow.

Blur
Sets the softness of the glow. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Grain
Grain Size

Controls the size of the grain.

Warning to Photoshop Users: You may not see the grain size change in the Preview 
window unless you are set to a 1:1 zoom ratio. 

Grain Amount
Controls the intensity of the grain.

Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.
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Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Night Vision - Tutorial
Night Vision creates the effect of a Night Vision lens by tinting the image green, 
blooming highlights and adding grain.

1 Apply the Night Vision filter to an image.
2 Choose the type of black and white filter to be applied to your color image from 

the Black and White pop-up menu.
The type of Black and White filter that you choose can dramatically change the 
look of your image.

3 Adjust the Glow>Brightness and Blur as well as the Grain>Size and Amount 
settings to your liking.

4 If you want, you can use the Color Correct controls to modify the color of the 
image.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, glow.

5 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where glow will be 
introduced. The location of the glow within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

6 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

7 Increase the Selection>Range value to add more glow into the scene. Decrease 
for less glow.

8 Increase the Selection>Blur parameter to soften the transition areas of the glow. 
The softness of the glow can also be adjusted using the Glow>Blur setting.

9 Change your View to Output to see the filtered image.
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 OLD PHOTO

Category
Grads / Tints.

Description
Images are treated to look like a variety of historical photographic processes 
including Cyanotype, Kallitype, Light Cyan, Palladium, Platinum, Sepia, Silver, 
Silver Gelatin and Van Dyck.

Go to the Old Photo - Tutorial on page 174 to see how the filter works.

Presets
The Presets set the Tint>Tint Color as well as various Color Correct settings. 
Select one of the filters from the pop-up list.

Note: In Apple Final Cut Pro and Avid Editing Systems, the Tint Color and the Color 
Correct settings can’t be adjusted unless the Custom option has been selected in the 
Presets pop-up menu.
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Cyanotype
Blue photographic prints employing light sensitive iron salts, most commonly on 
paper.

Kallitype
A silver-iron method for making permanent prints in gold, palladium and 
platinum metals.

Light Cyan
A lighter, less saturated version of Cyanotype.

Palladium
Palladium was introduced as a cheaper alternative to Platinum prints, and 
possesses a remarkable range of tones and surface texture.

Platinum
Platinum prints are an iron (non-silver) process for making photographic prints 
in which platinum is reduced from a salt to form the image. 

Sepia
Sepia toning replaces silver in the black and white photographic print with silver 
sulphide, which is brown.

Silver
Prints made on paper coated with a solution of albumen (egg whites) and 
ammonia salt, which is then sensitized with silver nitrate and printed (usually 
using a collodion negative).

Silver Gelatin
The silver gelatin process uses gelatin as the binder and developed silver as 
the image material.

Van Dyck
The Vandyke print gets its name from its similarity in color to the deep brown 
pigment, Vandyke brown, used by the Flemish painter Van Dyck.
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Black and White
Filter

The Filter pop-up selects the type of black and white filter to be applied to your 
color image.

Normal
Converts the color image to a monochrome image.

Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates an orange filter in black and white photography.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.
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Tint
Opacity

Sets the opacity of the tint.

Tint
Sets the color that the image will be tinted with. Select the desired color using 
the color picker. The default color is a cyan tone.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Tint Mode
Sets the color model that will be used to calculate the tinting. 

HLS
The HLS (Hue, Luminance, Saturation) tint mode creates a tint over the image, 
but preserves the black and white values.

HSV
The HSV (Hue, Saturation, Value) tint mode creates a tint over the entire 
image. 

Preserve Highlights
Preserves white areas of the image when using the HLS tint mode.

Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.
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Old Photo - Tutorial
Images are treated to look like a variety of historical photographic processes 
including Cyanotype, Kallitype, Light Cyan, Palladium, Platinum, Sepia, Silver, 
Silver Gelatin and Van Dyck.

1 Apply the Old Photo filter to an image.
2 Try out the different presets by selecting them from the Filters>Presets list.

Note: In Apple Final Cut Pro and Avid Editing Systems, the Tint Color and the Color 
Correct settings can’t be adjusted unless the Custom option has been selected in the 
Presets pop-up menu.

3 In the Black and White>Filter pop-up menu, select a filter to convert your image 
to Black and White.
The look of the image will significantly change based on the type of black and 
white filter used.

4 Change to the Custom preset to select a custom color and adjust other settings.
5 Adjust the Tint>Color, Opacity and Preserve Highlights sliders to your liking.
mm v7 User Guide



• 

Overexpose  175 
• 
• 
• 
•
•
•

 OVEREXPOSE

Category
Film Lab.

Description
Overexpose simulates the overexposure that occurs when a film camera is 
stopped.

Go to the Overexpose - Tutorial on page 176 to see how the filter works.

Amount
Controls the amount of overexposure.

Intensity
Sets the intensity of the overexposure.

Blur
Adjusts the softness of the overexposure. Go to the Blur section of General 
Controls on page 21 to see how the Blur controls work.
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Overexpose - Tutorial
Overexpose simulates the overexposure that occurs when a film camera is 
stopped.

1 Apply the Overexpose filter to an image.
2 Vary your result by adjusting both the Amount and Blur controls.
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 OZONE

Category
Color Correct.

Description
The Ozone filter allows you to manipulate the color of an image with incredible 
flexibility and accuracy. Inspired by Ansel Adams’ Zone System for still 
photography, we have created "The Digital Zone System". Just what is the 
Digital Zone System? The world around us contains an infinite palette of colors, 
tones and brightness. To reproduce this vast range of brightness, the Digital 
Zone System takes the spectrum of image values and divides them into 11 
discrete zones, using proprietary image slicing algorithms. Each zone is twice 
as bright as the previous zone, proceeding from black towards white. Look at 
how the image below is divided into zones: 

 Zone 0  Zone 1  Zone 2  Zone 3  Zone 4  Zone 5  Zone 6  Zone 7  Zone 8  Zone 9  Zone 10
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With Ozone, the color, brightness, contrast and gamma of each zone can be 
independently adjusted until you’ve painted a new picture. Your adjustments 
occur on a zone by zone basis, but you view the result of all color corrections 
simultaneously.

Go to the Ozone - Tutorial on page 181 to see how the filter works.

Extract On
The Extract On pop-up menu allows you to specify the image values to be used 
for dividing the image into the 11 individual zones.

Luminance
Zones are created using the image’s luminance values.

Hue
Zones are created using the image’s hue. When adjusting the Position 
parameter, you are selecting different hues.

Saturation
Zones are created using the image’s saturation values.

Average
Zones are created based on the average of the image’s RGB values.

Red
Zones are created using the image’s red values.
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Green
Zones are created using the image’s green values.

Blue
Zones are created using the image’s blue values.

Alpha
Zones are created using the image’s alpha values.

Cyan
Zones are created using the image’s cyan values.

Magenta
Zones are created using the image’s magenta values.

Yellow
Zones are created using the image’s yellow values.

Zone 0-10
When using Luminance as the method for slicing up the image, the Position 
and Range sliders are preset so that each zone is twice as bright as the 
previous zone, proceeding from black towards white. Pure black is defined as 
Zone 0, Zone 5 as middle gray and pure white as Zone 10.

By using the View pop-up menu, you can look at the individual zones which is 
helpful in determining the portions of the image you are going to adjust. The 
values shown as white in the selected zone are the areas of the image that will 
be modified by the color adjustments. Go back to View>Output when you are 
ready to adjust color.

Go to the Selection section of General Controls on page 25 to see how the 
Position and Range controls work.
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Position
The Position value pinpoints the color values to be used in the selected zone. 
This value has been preset according to the Digital Zone System, but can be 
changed if you choose. If the zones are created using Luminance, a high 
Position value shows the brightest image values as white values in the zone. A 
low Position value shows the darkest image values as white values in the zone.

Range
The Range value increases or decreases the range of values in the selected 
zone. This value has been preset according to the Digital Zone System, but can 
be changed if you want.

Brightness
Adjusts the brightness of the zone. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the zone. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the zone. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the zone.

Green
Adds or subtracts green from the zone.

Blue
Adds or subtracts blue from the zone.
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Ozone - Tutorial
1 Apply the Ozone filter to an image.
2 Use the View pop-up menu to look at Zones 0-10.

The selected zone is represented as a black and white image. The values 
shown as white in the selected zone are the portions of the image that will be 
modified when using the Brightness, Contrast, Gamma, Red, Green and Blue 
sliders. As the values drop-off to black, so does the strength of whatever 
adjustments you’ll make. Although the zone’s Position and Range parameters 
are preset according to the Digital Zone system, they can be changed if you 
want.

The Position value pinpoints the color values to be used in the selected zone. 
For instance, if the zones are created using Luminance, a high Position value 
shows the brightest image values as white values in the zone. A low Position 
value shows the darkest image values as white values in the zone. The Range 
value increases or decreases the range of values in the selected zone.

3 Make sure that the View pop-up menu is set to Output.
The preview window now shows the full color image. When viewing the full 
color image, you are always looking at the result of all zone color corrections.

4 To modify your image, adjust any combination of the Brightness, Contrast, 
Gamma, Red, Green and Blue sliders for each zone.
Your adjustments occur on a zone by zone basis, but you view the result of all 
color corrections simultaneously.
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 PENCIL

Category
Effects.

Description
Pencil converts your image to a pencil sketch.

Amount
Sets the intensity of the pencil effect.

Color
The Color parameter sets the color of the filter through the use of a standard 
color picker.
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  PHOTOGRAPHIC FILTERS, COLOR 
CONVERSION, LIGHT BALANCING AND COLOR 
COMPENSATING 

Category
Grads / Tints.

Description
The most complete line of Kodak® filters for photographic uses is available in 
the form of gelatin films and are known as Wratten® Gelatin Filters. 
Photographic Filters are digital equivalents of the Wratten set and were created 
using the spectral transmission curves for each optical filter. The Color 
Conversion, Light Balancing and Color Compensating filters are subsets of  
Photographic Filters. 

Go to the Photographic Filters - Tutorial on page 186 to see how the filter 
works.

Photographic Filters
Digital versions of the complete line of Kodak® Wratten® Gelatin Filters.
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Color Conversion
Color Conversion filters correct for significant differences in color temperature 
between your light source and recording media.

Light Balancing
Light Balancing filters correct for minor differences in color temperature 
between your light source and recording media.

Color Compensating
Color Compensating filters control color by attenuating specific parts of the 
spectrum. They can be used to make changes in color balance or compensate 
for deficiencies in the image’s spectral quality.

Filters
Presets

Select one of the filters from the pop-up list. Go to Appendix F - Photographic 
Filters on page 289 to see the complete list of filters.

Color
The Color parameter sets the color of the filter through the use of a standard 
color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.
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Grad 
These filters can optionally use a gradient that limits where the image is 
adjusted. Grad is the transition area that goes from the colored portion to the 
original image. Its direction, corners and size can be adjusted. Go to the Grad 
section of Color Grad on page 50 to see how the Grad controls work.
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Photographic Filters - Tutorial
The most complete line of Kodak® filters for photographic uses is available in 
the form of gelatin films and are known as Wratten® Gelatin Filters. 
Photographic Filters are digital equivalents of the Wratten set and were created 
using the spectral transmission curves for each optical filter. The Color 
Conversion, Light Balancing and Color Compensating filters are subsets of  
Photographic Filters.

1 Apply the Photographic Filters to an image.
By default, the 1A Pale Pink filter preset is applied to the image.

2 From the Presets pop-up menu, select another filter preset.
The selected filter can be applied through a gradient creating a graduated 
transition between the colored portion and the original image.

3 Click on the Grad>Enable checkbox to activate the Grad.
4 Adjust the Grad>Direction, Corner Points and Size.

Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

5 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

6 To apply a custom color to the image, you can do so by selecting Custom from 
the Presets pop-up menu and adjusting the Filters>Color parameter.

7 If you want less coloring of the image, turn down the Filters>Opacity.
8 Image highlights can be retained by adjusting the Filters>Preserve Highlights 

control to a value of 100.
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 POLARIZER

Category
Lens.

Description
The greatest use of polarizing filters is to achieve a darkened, deep blue sky. 
Our digital version of the Polarizer is designed to do just that. Through the use 
of a selection and an adjustable gradient, the color of the sky can be adjusted.

Go to the Polarizer - Tutorial on page 190 to see how the filter works.

Sky
Color Correct controls are provided to adjust the sky.

Hue
Rotates the hue of the sky.

Saturation
Adjusts the saturation of the sky. Positive values saturate, negative values 
desaturate.
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Brightness
Adjusts the brightness of the sky. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the sky. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the sky. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the entire sky.

Green
Adds or subtracts green from the entire sky.

Blue
Adds or subtracts blue from the entire sky.

Temperature
Sets the color temperature of the sky. Dragging the slider to the right makes the 
image cooler (bluer) and dragging the slider to the left makes the image warmer 
(redder).

Grad
The Polarizer can optionally use a gradient that limits where the image is 
adjusted. For instance, if the polarization is affecting areas other than they sky, 
enable the Grad and adjust it to limit the areas of polarization. Go to the Grad 
section of Color Grad on page 50 to see how the Grad controls work.
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Selection
The Polarizer isolates the sky using a selection based on blue values. Skies 
vary in their color of blue, so you can adjust the selection to accommodate your 
sky.

Hue
A selection is created based on the hue of the image. When adjusting the Hue 
parameter, you are selecting different hues. The Hue is preset to blue values.

Range
Increases or decreases the range of values in the selection. A low Range value 
indicates a narrow range of values. A high Range value indicates a large range 
of values included in the selection

Blur
Blurs the selection.
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Polarizer - Tutorial
The Polarizer creates a darkened, deep blue sky. Through the use of a 
selection and a gradient, the color of the sky can be adjusted.

1 Apply the Polarizer filter to an image.
2 Change your View to Selection to see the selection values. 

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, the polarization.

3 Change the Selection>Hue parameter if you want to select different blue values 
to be used for the sky selection.
A selection is generated based on the blue values in the sky. Skies vary in their 
color of blue, so you can adjust the selection to accommodate your sky. The 
blue that is used to create the selection can be modified by using 
Selection>Hue to select the exact blue value and Selection>Range to select 
the amount of blue values to be used for the selection.

4 Increase the Selection>Range value to add more polarization into the scene. 
Decrease for less polarization.

5 Increase the Selection>Blur parameter to soften the transition areas of the 
polarization.
Remember, the areas that are white in the selection are the areas that will be 
polarized.

6 Change your View to Output to see the filtered image.
7 Adjust the Sky color settings to make the sky look polarized.
8 If the polarization is affecting areas other than they sky, enable the Grad and 

adjust it to limit the areas of polarization.
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 PRINTER POINTS

Category
Color Correct.

Description
Printer Points manipulate the red, green and blue values of the overall image 
and separately in user definable shadow, midtone and highlight areas using 
motion picture laboratory printer points as the unit of measure. When creating 
color prints for motion pictures, a contact printer performs scene-to-scene color 
corrections. The most popular printing method is additive printing that uses 
three separate colored sources - red, green, and blue which are combined to 
form the light source that exposes the film. The red, green, and blue light valves 
in the printer are adjusted in values of 1, 2, 3. . . up to 60 for each primary color 
and are called printer points or printer lights. 

Printer Points works in a similar fashion as Color Correct eventhough the color 
adjustments are slightly different. So, go to the Color Correct Tutorial on 
page 47 to see how the filter works.
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Master
The master settings affect the entire image. The Red, Green and Blue 
Exposure are set to a value of 25 which represent no adjustment. Printer 
"lights" or points set to 25, 25, 25 are considered to be the normal or standard 
printer setup at most motion picture labs.

Red Exposure
Adds or subtracts red from the image. As in motion picture printing, higher 
values subtract and lower values add.

Green Exposure
Adds or subtracts green from the image. As in motion picture printing, higher 
values subtract and lower values add.

Blue Exposure
Adds or subtracts blue from the image. As in motion picture printing, higher 
values subtract and lower values add.

Gang
The Red, Blue and Green Exposure slider values can be ganged together. 
Slide the Red Exposure slider to affect all three values.

Shadows, Midtones, Highlights
Adjusting parameters within the shadows, midtones and highlights will only 
affect those specific areas. If you are unsure about what values are included in 
the shadows, midtones and highlights, you can use the View pop-up menu. It 
will allow you to view the shadows, midtones and highlights as a black and 
white selection. The white areas are the areas that will be adjusted by that 
particular group. For instance, if you see white areas while viewing the 
midtones, then midtone color adjustments will affect only those white areas. If 
you want to change the default areas defined by the shadows, midtones and 
highlights, you would use the Position and Range sliders.

Go to the Selection section of General Controls on page 25 to see how the 
Position and Range controls work.
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Position
The Position slider pinpoints the values to be considered as shadows, 
midtones, or highlights. A low Position value uses the darkest image values, 
while a high Position value uses the brightest.

Range
Increases or decreases the range of values considered as shadows, midtones 
or highlights. A low Range value indicates a narrow range of values, while a 
high Range value indicates a large range of values.

Red Exposure
Adds or subtracts red from the image. As in motion picture printing, higher 
values subtract and lower values add.

Green Exposure
Adds or subtracts green from the image. As in motion picture printing, higher 
values subtract and lower values add.

Blue Exposure
Adds or subtracts blue from the image. As in motion picture printing, higher 
values subtract and lower values add.

Gang
The Red, Blue and Green Exposure slider values can be ganged together. 
Slide the Red Exposure slider to affect all three values.
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 RACK FOCUS

Category
Blurs.

Description
Rack Focus replicates a true camera defocus by introducing lens Bokeh 
effects. Bokeh is the Japanese term that describes the quality of out-of-focus 
points of light. In defocused areas, each point of light becomes a shape--either 
a circle or a polygon. The shape grows in size as the amount of defocusing is 
increased.

Go to the Rack Focus - Tutorial on page 196 to see how the filter works.

Warning: Large Position>Range and Aperture>Size settings can cause the Rack 
Focus plug-in to render slowly.

Blur
The image is blurred by a quality blur.

Aperture
The Aperture settings control the various qualities of the out-of-focus points of 
light.
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Boost
Brightens the out-of-focus points of light.

Facets
Set the number of facets of out-of-focus points of light when the Curvature 
parameter is set to 0.

Curvature
Controls the curvature of out-of-focus points of light. When set to 100, the out-
of-focus points of light are completely round. Set to a value of 0 to see a 
polygonal shape.

Angle
Rotates the out-of-focus points of light.

Size
Sets the size of the out-of-focus points of light.

Blur
Blurs the out-of-focus points of light.

Noise
Noise is introduced into the out-of-focus points of light resulting in a more 
organic bokeh effect.

Density
Controls the brightness of the noise.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.

Time Average
In most cases, it is necessary to use an Average function on moving images. 
Otherwise, the Bokeh effects tend to flicker. Averaging allows for a very smooth 
selection, because pixel values from future frames are averaged together.
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Rack Focus - Tutorial
Rack Focus replicates a true camera defocus by introducing lens Bokeh 
effects. Bokeh is the Japanese term that describes the quality of out-of-focus 
points of light. In defocused areas, each point of light becomes a shape--either 
a circle or a polygon. The shape grows in size as the amount of defocusing is 
increased.

1 Apply the Rack Focus filter to an image.
2 Adjust the Blur to your liking.
3 Set the Aperture>Curvature to 0 if you prefer the out-of-focus points of light be 

polygonal in shape.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, Bokeh effects.

4 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where Bokeh effects will 
be introduced. The location of the Bokeh effects within the scene can be 
adjusted by modifying the Selection>Position and Selection>Range 
parameters.

5 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

6 Change you View to Aperture to see the generated Bokeh effects.
7 Increase the Selection>Range value to add more Bokeh effects into the scene. 

Decrease for less Bokeh effects.
The Selection>Range parameter has been purposely set to a low value. A high 
range setting will slow down the filter significantly.

8 Increase the Selection>Blur parameter to smooth out the selection.
9 Change your View to Output to see the filtered image.
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 RADIAL EXPOSURE

Category
Lens.

Description
Lightens and/or darkens the center or edges of an image to correct lens 
vignetting.

Go to the Radial Exposure - Tutorial on page 199 to see how the filter works.

Exposure
Edges

Lightens or darkens the edges of the image.

Center
Lightens or darkens the center of the image.

Spot
A radial gradient is used to lighten or darken the edges or center of the image.
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Position
Position X
The horizontal position of the spot.

Position Y
The vertical position of the spot.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the position of the Spot can be adjusted. To see the on-screen 
control in After Effects, you may need to highlight Radial Exposure in the Effect 
Controls window, and in Final Cut Pro and Combustion, you will have to click on the 
crosshair icon to the right of the Position parameter. On Avid Editing Systems, the 
Position parameters are named only X and Y.

Aspect
The aspect ratio of the spot.

Radius
The un-blurred radius of the spot.

Falloff Radius
The blurred edge radius.

Falloff
Moves the falloff towards the spot centerpoint.
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Radial Exposure - Tutorial
Lightens and/or darkens the center or edges of an image to correct lens 
vignetting.

1 Apply the Radial Exposure filter to an image.
2 Adjust the Exposure>Edges or Center parameters.

The radial gradient used to lighten or darken the edges or center of the image 
can be adjusted to suit your image.

3 Adjust the Spot>Position, Radius, Falloff Radius and Falloff.
4 If you are curious, you can see what the Spot looks like by changing your View 

to Spot. Change your View to Output when done.
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 RELIGHT

Category
Light.

Description
Light can be added to a scene where none existed before. A complete set of 
light source controls allow you to adjust the light just as you would at the time 
of shooting.

Photographers, cinematographers and lighting designers use colored filters or 
gels in front of lights. Whether they want to create a romantic moonlit setting or 
a vicious, angry fight, they have the colors they need to achieve the effect. 
Digital equivalents of the lighting gels created by GAMPRODUCTS, INC. can  
be applied to your light source.The GamColor system divides the visible 

Before After
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spectrum into nine color sections convenient to the lighting designer. It is a 
circular classification of colors by hue, referencing the primaries, secondaries 
and important subdivisions. 

The GamColor gels are arranged according to this system, making it easy to 
locate any color in a logical manner. For detailed information about GAM 
Patterns and Gels, you can visit their website at www.gamonline.com.

Go to the ReLight - Tutorial on page 204 to see how the filter works.
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Light
Blend

Determines the blend mode to be used to add the light.

Add
The light is added to your image.

Screen
The light is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the light.

Displacement
Displaces the light source by the luminance values of the image. This "fakes" 
the effect of light wrapping over objects in the image.

Blur
Sets the softness of the light. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

GamColor Presets
Digital equivalents of the lighting gels created by GAMPRODUCTS, INC. can  
be applied to your light source. Select one of the GamColor presets from the 
pop-up list. Go to Appendix G - Gam Color on page 293 to see the complete 
list of gels.

Color
Sets the color of the light through the use of a standard color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.
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Selection
A selection is used to constrain the area of added light. Wherever there is a 
white in the selection is where the light will be added. When using ReLight, it is 
usually helpful to blur the selection. Go to the Selection section of General 
Controls on page 25 to see how the Selection controls work.

Note: Light Source>Blend Mode must be set to something other than Shape Only for 
the selection controls to be active.

Light Source
Blend

The light source can be added to the selection using a variety of Blend modes. 
Go to Appendix C on page 280 to see visual examples of the various Blend 
modes.

I like the Multiply blend mode for combining the light source with the selection 
because it only puts the pattern within the areas of the selection.

Opacity
Sets the opacity of the light source.

Radius
The un-blurred radius of the light.

Falloff Radius
The blurred edge radius.

Falloff
Moves the falloff towards the light centerpoint.

DVE
The DVE allows you to transform your light source using Position, Scale, 
Rotation, Corner Pin, Shear and Crop controls. Go to the DVE section of 
General Controls on page 22 to see how the DVE Controls work.
55mm v7 User Guide    
• 
• 
•
•
•



   55

204 ReLight

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

ReLight - Tutorial
Light can be added to a scene where none existed before. A complete set of 
light source controls allow you to adjust the light just as you would at the time 
of shooting.

Adobe Photoshop
1 Apply the ReLight filter to an image.
2 Using the Light Source>Position, Scale, Rotate and Corner Pin controls, you can 

move the shape around.
3 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

4 To apply a custom light color to the image, click on the Light>Color box and 
select a color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

5 To choose one of the GamColor gels, select a gel from the 
Light>GamColor>Presets list.

6 Combine the light source with a selection by changing the Shape>Blend Mode 
from Shape Only to Multiply.
I like the Multiply blend mode because it only adds the light source in the areas 
of the selection.

7 Change your View selector to Selection to see the selection values. 
The default Selection settings are preset to a highlight selection to create the 
light effect. If you are not seeing sufficient light, your selection should be 
adjusted. The areas that are white in the selection are the areas where light will 
be added into the image. The location of the light within the scene can be 
adjusted by changing the Selection>Position and Selection>Range 
parameters.

8 Change the Selection>Position parameter if you want to select different values 
to be used for the light.

9 Increase the Selection>Range value to add more light into the scene. Decrease 
for less light.

10 Change the View selector from Selection to Output.
11 Increase the Selection>Blur parameter to soften the transition areas of the light.
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Platforms other than Photoshop
1 Apply the ReLight filter to an image.
2 Using the Shape>DVE controls, you can move the shape around.
3 In the Light menu, adjust the Brightness, Displacement, and Blur of the light. 

Adding blur to the light makes the light glow.

4 To apply a custom light color to the image, click on the Light>Color box and 
select a color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the GamColor Presets pop-up 
menu.

5 To choose one of the GamColor gels, select a gel from the 
Light>GamColor>Presets list.

6 Combine the light source with a selection by changing the Light Source>Blend 
Mode from Shape Only to Multiply.
I like the Multiply blend mode because it only adds the light source in the areas 
of the selection.

7 Change your View selector to Selection to see the selection values. 
The default Selection settings are preset to a highlight selection to create the 
light effect. If you are not seeing sufficient light, your selection should be 
adjusted. The areas that are white in the selection are the areas where light will 
be added into the image. The location of the light within the scene can be 
adjusted by changing the Selection>Position and Range parameters.

8 Change the Selection>Position parameter if you want to select different values 
to be used for the light.

9 Increase the Selection>Range value to add more light into the scene. Decrease 
for less light.

10 Change the View selector from Selection to Output.
11 Increase the Selection>Blur parameter to soften the transition areas of the light. 
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 SELECTIVE COLOR CORRECT

Category
Color Correct.

Description
Colors can be selectively isolated through the use of a selection and adjusted 
using hue, saturation, brightness, gamma, contrast, red, green, and blue 
controls.

Go to the Selective Color Correct - Tutorial on page 214 to see how the filter 
works.

Color Controls
Certain parts of the image are isolated by the creation of a selection. Whatever 
is shown as white in the selection can be adjusted by the color controls below. 

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.
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Brightness
Adjusts the luminance of the entire image. Positive values brighten, negative 
values darken.

Contrast
Adjusts the contrast of the entire image. Positive values increase contrast, 
negative values decrease contrast.

Gamma 
Adjusts the gamma of the entire image. The gamma adjustment leaves the 
white and black points the same and only modifies the values in-between. 
Positive values darken the midtones, negative values lighten the midtones.

Red
Adds or subtracts red from the image.

Green
Adds or subtracts green from the image.

Blue
Adds or subtracts blue from the image.

Temperature
Sets the color temperature of the image. Dragging the slider to the right makes 
the image cooler (bluer) and dragging the slider to the left makes the image 
warmer (redder).
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Selection
A selection is created to isolate areas to be color corrected. Using advanced 
image slicing algorithms, selections are created using luminance, hue, 
saturation, average, red, green, blue, cyan, magenta, and yellow values.

Extract On
Extract On selects the type of selection. Select whichever type isolates the 
desired values.

A selection is created based on one of the following:

Luminance
A selection is created based on the luminance of the image.

Hue
A selection is created based on the hue of the image. When adjusting the 
Position parameter, you are selecting different hues.

Saturation
A selection is created based on the saturation of the image.

 Original                                                       Selection

Hue Selection
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Average
A selection is created based on the average of the image’s RGB values.

Red
A selection is created based on the image’s red values.

Green
A selection is created based on the image’s green values.

Blue
A selection is created based on the image’s blue values.

Alpha
A selection is created based on the image’s alpha values.

Cyan
A selection is created based on the image’s cyan values.

Magenta
A selection is created based on the image’s magenta values.

Yellow
A selection is created based on the image’s yellow values.

Position
The Position value pinpoints the color values to be used in the selection. For a 
luminance selection, a Position value of 100 would make a white selection of 
the highlights and a value of 0 would make a white selection of the shadows. In 
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our flower image, look at how the selection varies for different Position values 
in a red extraction. When the Position is at a value of 100, the red flowers are 
shown as white in the selection.

When the Position is moved to 50, the red flowers turn black.

Position=100, Range=25

Position=50, Range=25
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Range
Increases or decreases the range of values in the selection. A low Range value 
indicates a narrow range of values. A high Range value indicates a large range 
of values included in the selection.

Clip
Clip Black
Blacks in the selection are made blacker by increasing the value of the slider. 
As the slider value increases, more values are clipped to black. This is helpful 
for getting rid of unwanted grey areas in what should be the black part of the 
selection. 

Position=100, Range=50

Selection with No Black Clip                                 Black Clip=50
55mm v7 User Guide    
• 
• 
•
•
•



   55

212 Selective Color Correct

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Clip White
Whites in the selection are made whiter by increasing the value of the slider. As 
the slider value increases, more values are clipped to white. This is helpful for 
getting rid of unwanted grey areas in what should be the white part of the 
selection. 

Shrink/Grow
Shrinks or grows the selection. Negative values shrink and positive values 
grow the selection.

Selection with No White Clip                               White Clip=50

Original

                    Shrink=-2                                              Grow=1.5
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Blur
Go to the Blur section of General Controls on page 21 to see how the Blur 
controls work.

Invert
• Off
Does nothing to the selection.

• On
Inverts the luminance values of the selection.                         

No Blur                                                   Blur=10 

Invert Off                                                 Invert On
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Selective Color Correct - Tutorial
Colors can be selectively isolated through the use of a selection and adjusted 
using hue, saturation, brightness, gamma, contrast, red, green, and blue 
controls.

1 Apply the Selective Color Correct filter to an image.
2 Change your View to Selection to see the selection values. 

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, selective color correction.

3 Adjust the selection controls so that the areas that you want to color correct are 
white in the selection.
Go to the Selection parameters on page 208 to see how they work.

4 Change your View to Output to see the image.
5 Adjust the color correct parameters to your liking.
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 SELECTIVE SATURATION

Category
Color Correct.

Description
The saturation of the image can be adjusted independently in the shadows, 
midtones and highlights.

Go to the Selective Saturation - Tutorial on page 217 to see how the filter 
works.

Shadows
Saturation

Adjusts the saturation of the image in the shadows. Positive values saturate, 
negative values desaturate.

Position
Selects the shadow values to be adjusted when using the Saturation slider.

Range
Controls the range of values to be used for the shadows. A higher Range value 
considers more values as shadows.

Before After
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Midtones
Saturation

Adjusts the saturation of the image in the midtones. Positive values saturate, 
negative values desaturate.

Position
Selects the midtones values to be adjusted when using the Saturation slider.

Range
Controls the range of values to be used for the midtones. A higher Range value 
considers more values as midtones.

Highlights
Saturation

Adjusts the saturation of the image in the highlights. Positive values saturate, 
negative values desaturate.

Position
Selects the highlight values to be adjusted when using the Saturation slider.

Range
Controls the range of values to be used for the highlights. A higher Range value 
considers more values as highlights.
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Selective Saturation - Tutorial
The saturation of the image can be adjusted independently in the shadows, 
midtones and highlights.

1 Apply the Selective Saturation filter to an image.
2 Adjust the Saturation in the Shadows, Midtones or Highlights.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, selective saturation. Shadow, midtone and highlight 
selections have been preset for you to adjust the saturation selectively in those 
areas.

3 Change your View to Shadows, Midtones or Highlights to see the selection 
values. 
The areas that are white in the selection are the areas that will be adjusted by 
the Saturation slider. The areas defined as shadows, midtones or highlights can 
be adjusted by modifying the Position and Range parameters.

4 Adjust the Shadow, Midtone or Highlight Position and Range controls to change 
what is considered shadows, midtones or highlights.
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.

5 Change your View to Output to see the image.
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 SKIN SMOOTHER

Category
Diffusion.

Description
Skin Smoother softens wrinkles and blemishes producing smooth skin textures 
while retaining detail in larger features such as the eyes, nose and mouth.

Go to the Skin Smoother - Tutorial on page 220 to see how the filter works.

Blur
The image is blurred only in areas of the selection.

Horizontal Blur
The image is blurred by a fast, quality blur along the X-axis.

Vertical Blur
The image is blurred by a fast, quality blur along the Y-axis.

Before After

Photos © THINKSTOCK LLC--WWW.THINKSTOCK.COM
mm v7 User Guide



• 

Skin Smoother  219 
• 
• 
• 
•
•
•

Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.

Edge
Edge detail lost as a result of the blurring is restored through the use of an edge 
detect.

Brightness
Determines the brightness of the edge selection.

Blur
Blurs the edge selection.

Opacity
Determines the opacity of the edge detail added back to the image.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Skin Smoother - Tutorial
Skin Smoother softens wrinkles and blemishes producing smooth skin textures 
while retaining detail in larger features such as the eyes, nose and mouth. This 
is achieved by softening the image based on a selection with areas of detail 
being retained by using an edge detect. The first step is to adjust the selection.

1 Apply the Skin Smoother filter to an image.
2 Change your View to Selection to see the selection values. 

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, skin smoothing.

The idea here is to generate a selection that isolates the face of the person 
whose skin needs to be smoothed. The white areas of the selection are the 
areas that will be smoothed. The selection has been preset to a midtone 
selection. This can be modified by using Selection>Position to select the 
luminance value and Selection>Range to select the amount of values to be 
used for the selection.

3 If needed, change the Selection>Position parameter so that the face you are 
trying to smooth is as white as possible in the selection.

4 Adjust the Selection>Range value so that the white values of the selection are 
limited as much as possible to the person’s face.

5 Increase the Selection>Blur parameter if you want to soften the transition areas 
of the soft focus.

6 Change your View to Edge to see the edge values. 
The areas that are white in the edge is where detail in the image is retained.

7 Adjust the Edge>Brightness of the edge selection to make sure that you have 
sufficient levels of white in areas such as the person’s eyes, nose and mouth.

8 Set the Edge>Blur to smooth out the edge selection.
9 Change your View to Output to see the filtered image.
10 Adjust the Horizontal and Vertical Blur to smooth out any blemishes or wrinkles.
11 If the person is looking too soft, increase the Edge>Brightness, decrease the 

amount of Blur added to the scene or modify the Selection>Position and Range 
parameters.
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 SOFT EFFECTS, WARM SOFT EFFECTS

Category
Diffusion.

Description
Soft Effects

Soft Effects diffuses the image in such a way that minimizes facial 
imperfections while retaining overall clarity.

Warm Soft Effects
Warm Soft Effects diffuses the image in such a way that minimizes facial 
imperfections while retaining overall clarity in combination with a warming filter.

Go to the Soft Effects / Warm Soft Effects - Tutorial on page 223 to see how 
the filters work.

Before Soft Effects After
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Blur
Horizontal Blur

The image is blurred by a fast, quality blur along the X-axis.

Vertical Blur
The image is blurred by a fast, quality blur along the Y-axis.

Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.

Opacity
Sets the amount of diffusion mixed into the original image. The higher the 
setting, the more the image is blurred.

Warming
Color

The Color parameter sets the color of the warming through the use of a 
standard color picker.

Opacity
Sets the opacity of the warming.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 
warming.

Note: The Warming controls are only available in Warm Soft Effects.
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Soft Effects - Tutorial
Soft Effects diffuses the image in such a way that minimizes facial 
imperfections while retaining overall clarity. Warm Soft Effects adds a warming 
filter.

1 Apply either the Soft Effects or Warm Soft Effects filter to an image.
2 Adjust the Blur and Opacity parameters to your liking.
3 If using Warm Soft Effects, adjust the Warming>Color, Opacity, Preserve 

Highlights and Exposure Compensation sliders to your liking.
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 SPLIT FIELD

Category
Blurs.

Description
Split Field splits the image with a line that can be positioned, rotated and 
blurred. On one side of the line, the image is blurred and on the other, it is in 
focus.

Go to the Split Field - Tutorial on page 225 to see how the filter works.

Blur
Horizontal Blur

The split portion of the image is blurred by a quality blur along the X-axis.

Vertical Blur
The split portion of the image is blurred by a quality blur along the Y-axis.

Before After
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Gang
The horizontal and vertical slider values can be ganged together. Slide the 
horizontal slider to affect both values.

Note: When Gang is turned on, the vertical slider doesn’t physically move. However, 
the vertical value will follow the value of the horizontal slider when Gang is turned on.

Split
The Split controls manipulate the position, rotation and blur of the split line.

Position
Position X
The horizontal position of the split line.

Position Y
The vertical position of the split line.

Note: There is an on-screen control in the center of the image. By clicking and dragging 
the on-screen control, the position of the split line can be adjusted. To see the on-
screen control in After Effects, you may need to highlight Split Field in the Effect 
Controls window, and in Final Cut Pro and Combustion, you will have to click on the 
crosshair icon to the right of the Position parameter. On Avid Editing Systems, the 
Position parameters are named only X and Y.

Rotate
Rotates the split line.

Blur
Blurs the split line with a fast quality blur.

Split Field - Tutorial
Split Field splits the image with a line that can be positioned, rotated and 
blurred. On one side of the line, the image is blurred and on the other, it is in 
focus.

1 Apply the Split Field filter to an image.
2 Adjust the Blur controls.
3 Position, Rotate and Blur the split line using the Split controls.
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 SPLIT TONE

Category
Grads / Tints.

Description
Shadows, midtones and highlights can be individually tinted with the Split Tone 
filter.

Go to the Split Tone - Tutorial on page 229 to see how the filter works.

Shadows
Opacity

Set the opacity of the tint color.

Tint
The Tint parameter sets the color of the shadow tint through the use of a 
standard color picker.
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Position
Selects the shadow values to be adjusted when using the Opacity slider.

Range
Controls the range of values to be used for the shadows. A higher Range value 
considers more values as shadows. 

Midtones
Opacity

Set the opacity of the tint color.

Tint
The Tint parameter sets the color of the midtone tint through the use of a 
standard color picker.

Position
Selects the shadow values to be adjusted when using the Opacity slider.

Range
Controls the range of values to be used for the midtones. A higher Range value 
considers more values as shadows. 

Highlights
Opacity

Set the opacity of the tint color.

Tint
The Tint parameter sets the color of the highlight tint through the use of a 
standard color picker.

Position
Selects the highlight values to be adjusted when using the Opacity slider.

Range
Controls the range of values to be used for the highlights. A higher Range value 
considers more values as highlights.
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Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 
tinting.
mm v7 User Guide
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Split Tone - Tutorial
Shadows, midtones and highlights can be individually tinted with the Split Tone 
filter.

1 Apply the Split Tone filter to an image.
2 Turn up the Opacity slider in the Shadows, Midtones or Highlights.
3 Change the Tint colors by clicking on the Tint color boxes.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, split toning.

4 Change your View to Shadows, Midtones or Highlights to see the selection 
values. 
The areas that are white in the selection are the areas that will be tinted by the 
selected tint color. The areas defined as Shadows, Midtones or Highlights can 
be adjusted by modifying the Position and Range parameters.

5 Adjust the Shadows, Midtones or Highlights Position and Range controls to 
change what is considered to be Shadows, Midtones or Highlights.

6 Change your View to Output to see the image.
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 STAR

Category
Light.

Description
Six point star patterns are generated on highlights in the image.

Go to the Star - Tutorial on page 231 to see how the filter works.

Star
Brightness

Sets the intensity of the stars.

Size
Controls the size of the stars.
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Color
The Color parameter sets the color of the stars through the use of a standard 
color picker. The default color is white.

Note: When adding stars to images with a lot of dark values, you may need to increase 
the Star>Brightness value.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.

Star - Tutorial
Six point star patterns are generated on highlights in the image. 

1 Apply the Star filter to an image.
2 Adjust the Star>Brightness, Size and Color settings to your liking.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, a star filter.

3 Change your View to Selection to see the selection values.
The selection has been preset to a highlight selection to generate the stars. 
Different luminance values can be selected with the Selection>Position 
parameter and the range of selection values can be adjusted using 
Selection>Range.

4 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.
Stars will be generated wherever there are white values in the selection.

5 Change your View to Stars to see the generated stars.
6 Increase the Selection>Range value to add more stars into the scene. Decrease 

for less stars.
7 Change your View to Output to see the filtered image.
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 STREAKS

Category
Effects.

Description
The Streaks filter creates horizontal or vertical streaks around highlights in the 
image.

Go to the Streaks - Tutorial on page 234 to see how the filter works.

Streaks
Blend

Determines the blend mode to be used to create the streak effect.

Add
The streaks are added to your image.
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Screen
The streaks are combined with the image using a Screen blend mode. This 
looks kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the streaks.

Streaks
Horizontal Streaks
Creates horizontal streaks along the X-axis.

Vertical Streaks
Creates vertical streaks along the Y-axis.

Color
The Color parameter sets the color of the streaks through the use of a standard 
color picker. The default color is white.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Streaks - Tutorial
The Streaks filter creates horizontal or vertical streaks around highlights in the 
image.

1 Apply the Streaks filter to an image.
2 Adjust either the Vertical or Horizontal Streaks controls.

Note: If you adjust both the Vertical and Horizontal Streak controls at the same time, 
the Streak effect will be lost.

3 Select either the Add or Screen Blend Mode. Add will burn out highlights while 
the Screen Mode will retain them.

4 Adjust the Streak>Brightness and Color settings to your liking.
In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, streaks.

5 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where streaks will be 
introduced. The location of the streaks within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

6 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

7 Increase the Selection>Range value to add more streaks into the scene. 
Decrease for less streaks.

8 Change your View to Output to see the filtered image.
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 STRIP GRAD

Category
Grads / Tints.

Description
Strip Grad colors and or darkens only a portion of the image in the form of a 
narrow strip using photographic filters. Presets for your favorite color grad filters 
are provided as well as the ability to create custom colors. There is a graduated 
transition for a smooth color blend between the colored/darkened portion and 
the original image. Strip Grad is especially good for changing and enhancing a 
narrow portion of the sky.

Go to the Strip Grad - Tutorial on page 237 to see how the filter works.

Filters
Presets

Select one of the filters from the pop-up list. Go to Appendix D on page 283 to 
see the complete list of filters.
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Color
The Color parameter sets the color of the grad through the use of a standard 
color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Opacity
Sets the opacity of the color filter.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Grad
Grad is the transition area that goes from the tinted image to the original image. 
Its direction, corners and size can be adjusted. Go to the Grad section of Color 
Grad on page 50 to see how the Grad controls work.
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Strip Grad - Tutorial
Strip Grad colors and or darkens only a portion of the image in the form of a 
narrow strip using photographic filters.

1 Apply the Strip Grad filter to an image.
By default, the Custom filter preset is applied to the image.

2 To apply a custom color to the image, click on the Filters>Color box and select a 
color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

3 To choose one of the preset filters, select a filter from the Filters>Presets list.
You can also adjust the gradient’s position and size.

4 Adjust the Grad>Direction, Corner Points and Size.
Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

5 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.

6 If you want less coloring of the image, turn down the Filters>Opacity.
7 Image highlights can be retained by adjusting the Filters>Preserve Highlights 

control to a value of 100.
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 SUNSET/TWILIGHT

Category
Grads / Tints.

Description
Sunset/Twilight applies three photographic filters to the image which are 
blended together with a gradient.

Go to the Sunset/Twilight - Tutorial on page 240 to see how the filter works.

Color 1
Sets the color for the top third of the image. Select the desired color using the 
color picker or choose a filter preset. The default color is magenta.

Presets
Select one of the filters from the pop-up list. Go to Appendix D on page 283 to 
see the complete list of filters.
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Color
The Color parameter sets the color of the grad through the use of a standard 
color picker.

Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

Opacity
Sets the opacity of the color filter.

Color 2
The Color 2 controls are the same as the controls for Color 1 except that the 
default color is a orange and is applied to the middle third of the image.

Color 3
The Color 3 controls are the same as the controls for Color 1 except that the 
default color is yellow and is applied to the bottom third of the image.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the filter 
application.

Grad 
Grad is the combination of the three blended tints. Its direction, corners and 
size can be adjusted. Go to the Grad section of Color Grad on page 50 to see 
how the Grad controls work.
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Sunset/Twilight - Tutorial
Sunset/Twilight applies three photographic filters to the image which are 
blended together with a gradient.

1 Apply the Sunset/Twilight filter to an image.
2 To apply custom colors to the image, click on the Color 1, Color 2 and Color 

3>Color box’s and select a color.
Note: The Color picker allows you to treat the image with a custom color, but is only 
active when the Custom option has been selected in the Presets pop-up menu.

3 To choose one of the preset filters, select a filter from the Color 1, Color 2 and 
Color 3>Presets list.

4 If you want less coloring of the image, turn down Color 1, Color 2 or Color 
3>Opacity.

5 Image highlights can be retained by adjusting the Preserve Highlights control to 
a value of 100.
The color gradient can be adjusted to your specific image.

6 Adjust the Grad>Direction, Corner Points and Size to position and adjust the 
grad.
Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

7 Change your View to Grad to see the color gradient being applied to the image.
8 Change your View back to Output to see the filtered image.
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 TELECINE

Category
Color Correct.

Description
Telecine emulates the method of color correction done in a telecine film to tape 
transfer suite. Hue, saturation, brightness, contrast, gamma and pedestal 
values of the overall image can be adjusted as well as separately in user 
definable shadow, midtone and highlight areas.

Telecine works in a similar fashion as Color Correct eventhough the color 
adjustments are slightly different. So, go to the Color Correct Tutorial on 
page 47 to see how the filter works.

Master
The master settings affect the entire image.

Hue
Rotates the hue of the image.
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Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.

Pedestal
Adjusts the black level of the image.

Lift, Gamma, Gain
Adjusting parameters within the Lift (shadows), Gamma (midtones) and Gain 
(highlights) will only affect those specific areas. If you are unsure about what 
values are included in Lift, Gamma and Gain, you can use the View pop-up 
menu. It will allow you to view the Lift, Gamma and Gain as a black and white 
selection. The white areas are the areas that will be adjusted by that particular 
group. For instance, if you see white areas while viewing the Gamma, then 
Gamma color adjustments will affect only those white areas. If you want to 
change the default areas defined by the Lift, Gamma and Gain, you would use 
the Position and Range sliders.

Go to the Selection section of General Controls on page 25 to see how the 
Position and Range controls work.
mm v7 User Guide
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Position
The Position slider pinpoints the values to be considered as Lift, Gamma, or 
Gain. A low Position value uses the darkest image values, while a high Position 
value uses the brightest.

Range
Increases or decreases the range of values considered as Lift, Gamma or Gain. 
A low Range value indicates a narrow range of values, while a high Range 
value indicates a large range of values.

Hue
Rotates the hue of the image.

Saturation
Adjusts the saturation of the image. Positive values saturate, negative values 
desaturate.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.

Pedestal
Adjusts the black level of the image.
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 TEMPERATURE

Category
Color Correct.

Description
Temperature manipulates the temperature, cyan/magenta and brightness 
values of the overall image and separately in user definable shadow, midtone 
and highlight areas.

Temperature works in a similar fashion as Color Correct eventhough the color 
adjustments are slightly different. So, go to the Color Correct Tutorial on 
page 47 to see how the filter works.

Master
The master settings affect the entire image.
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Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 
the right makes the image cooler (bluer) and dragging the slider to the left 
makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 
makes the image more magenta and dragging the slider to the left makes the 
image more cyan.

Brightness
Adjusts the luminance of the image.

Shadows, Midtones, Highlights
Adjusting parameters within the shadows, midtones and highlights will only 
affect those specific areas. If you are unsure about what values are included in 
the shadows, midtones and highlights, you can use the View pop-up menu. It 
will allow you to view the shadows, midtones and highlights as a black and 
white selection. The white areas are the areas that will be adjusted by that 
particular group. For instance, if you see white areas while viewing the 
midtones, then midtone color adjustments will affect only those white areas. If 
you want to change the default areas defined by the shadows, midtones and 
highlights, you would use the Position and Range sliders.

Go to the Selection section of General Controls on page 25 to see how the 
Position and Range controls work.

Position
The Position slider pinpoints the values to be considered as shadows, 
midtones, or highlights. A low Position value uses the darkest image values, 
while a high Position value uses the brightest.

Range
Increases or decreases the range of values considered as shadows, midtones 
or highlights. A low Range value indicates a narrow range of values, while a 
high Range value indicates a large range of values.
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Temperature
Sets the color of the image to be either warmer or cooler. Dragging the slider to 
the right makes the image cooler (bluer) and dragging the slider to the left 
makes the image warmer (redder).

Cyan/Magenta
Adds either Cyan or Magenta to the image. Dragging the slider to the right 
makes the image more magenta and dragging the slider to the left makes the 
image more cyan.

Brightness
Adjusts the luminance of the image.
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 THREE STRIP

Category
Film Lab.

Description
Known and celebrated for it ultra-realistic, saturated levels of color, the 
Technicolor® Three Strip process was commonly used for musicals, costume 
pictures and animated films. It was created by photographing three black and 
white strips of film each passing through red, green and blue filters on the 
camera lens and then recombining them in the printing process. Our Three 
Strip filter was created under the direction of Academy Award Winning Visual 
Effects Supervisor Rob Legato.

Go to the Three Strip - Tutorial on page 249 to see how the filter works.

Opacity
Sets the intensity of the of the Three Strip effect.

Strips
Red Intensity

Intensifies red values in the image.
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Red Smooth
Blurs the red selection that is used to isolate the red values. Use this control to 
smooth out any noise that may appear if the Red Intensity is turned up to a high 
value.

Green Intensity
Intensifies green values in the image.

Green Smooth
Blurs the green selection that is used to isolate the green values. Use this 
control to smooth out any noise that may appear if the Green Intensity is turned 
up to a high value.

Blue Intensity
Intensifies blue values in the image.

Blue Smooth
Blurs the blue selection that is used to isolate the blue values. Use this control 
to smooth out any noise that may appear if the Blue Intensity is turned up to a 
high value.

Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.
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Three Strip - Tutorial
Known and celebrated for it ultra-realistic, saturated levels of color, the 
Technicolor® Three Strip process was commonly used for musicals, costume 
pictures and animated films. It was created by photographing three black and 
white strips of film each passing through red, green and blue filters on the 
camera lens and then recombining them in the printing process. Our Three 
Strip filter was created under the direction of Academy Award Winning Visual 
Effects Supervisor Rob Legato.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, increasing the intensity of the red, green and blue values. 

1 Apply the Three Strip filter to an image.
2 Change your View to Red, Green or Blue to see the selection values. 

Normally, the areas that are white in the selection are the areas that will be 
adjusted by a particular filter or control. The Red, Green and Blue Intensities, 
on the other hand, make adjustments where you see black in the selection.

3 Adjust the Intensity of whatever color channel you are viewing and you will see 
that certain values become darker. These are the values that will be intensified in 
the color image.

4 Change your View to Output to see the color image.
5 Adjust the Red, Green and Blue Intensities until you have the desired levels of 

red, green and blue in the image.
6 You may need to use the Red, Green and Blue Smooth controls to smooth out 

any noise that may have appeared if the Intensities were turned up to high 
values. 
The Smooth controls are set to a low value by default.

7 Set the Opacity to a lower level if the strength of the Three Strip effect looks too 
strong.
Color Correct controls are also provided for additional control.
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 TINT

Category
Grads / Tints.

Description
Tints the entire image with a selected color.

Go to the Tint - Tutorial on page 252 to see how the filter works.

Tint
Opacity

Sets the opacity of the tint color.

Tint
Sets the color that the image will be tinted with. Select the desired color using 
the color picker. The default color is a sepia tone.

Tint Mode
Sets the color model that will be used to calculate the tinting. 
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HLS
The HLS (Hue, Luminance, Saturation) tint mode creates a tint over the image, 
but preserves the black and white values.

HSV
The HSV (Hue, Saturation, Value) tint mode creates a tint over the entire 
image. 

Replace
The Replace tint mode replaces any areas of saturation with the chosen tint 
color, but preserves the white levels from the original image. 

Note: The Replace mode won’t work on an image that is black and white.

Preserve Highlights
Preserves white areas of the image when using the HLS tint mode.

Grad
Grad is the transition area that goes from the tinted image to the original image. 
Its direction, corners and size can be adjusted. Go to the Grad section of Color 
Grad on page 50 to see how the Grad controls work.
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Tint - Tutorial
Tints the entire image with a selected color

1 Apply the Tint filter to an image.
By default, a sepia color is applied to the image.

2 To apply a different color to the image, click on the Tint>Tint color box and select 
a new color.

3 Select either a HLS, HSV or Replace Tint Mode.
4 When using the HLS Tint mode, image highlights can be retained by adjusting 

the Tint>Preserve Highlights control to a value of 100.
5 If you want less tinting of the image, turn down the Tint>Opacity.

You can also use a gradient in combination with the Tint.

6 To use a gradient with the Tint, click on Grad>Enable.
7 Adjust the Grad>Direction, Corner Points and Size.

Go to the Grad section of Color Grad on page 50 to see how the Grad controls 
work.

8 If you are curious, you can see what the Grad looks like by changing your View 
to Grad. Change your View to Output when done.
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 TWO STRIP

Category
Film Lab.

Description
The Technicolor® Two Strip process was the first stab at producing color 
motion pictures and consisted of simultaneously photographing two black and 
white images using red and green filters. This look creates an odd but pleasing 
hand-painted look where faces appear normal and green takes on a blue-green 
quality, while the sky and all things blue appear cyan. Our Two Strip filter was 
created under the direction of Academy Award Winning Visual Effects 
Supervisor Rob Legato.

Go to the Two Strip - Tutorial on page 255 to see how the filter works.

Opacity
Sets the intensity of the of the Two Strip effect.
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Strips
Red Intensity

Intensifies red values in the image.

Red Smooth
Blurs the red selection that is used to isolate the red values. Use this control to 
smooth out any noise that may appear if the Red Intensity is turned up to a high 
value.

Green Intensity
Intensifies green values in the image.

Green Smooth
Blurs the green selection that is used to isolate the green values. Use this 
control to smooth out any noise that may appear if the Green Intensity is turned 
up to a high value.

Blue Intensity
Darkens image areas that were blue in the source image.

Blue Smooth
Blurs the blue selection that is used to isolate the blue values. Use this control 
to smooth out any noise that may appear if the Blue Intensity is turned up to a 
high value.

Color Correct
Go to the Color Correct filter on page 44 to see how the Color Correct controls 
work.
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Two Strip - Tutorial
The Technicolor® Two Strip process was the first stab at producing color 
motion pictures and consisted of simultaneously photographing two black and 
white images using red and green filters. This look creates an odd but pleasing 
hand-painted look where faces appear normal and green takes on a blue-green 
quality, while the sky and all things blue appear cyan. Our Two Strip filter was 
created under the direction of Academy Award Winning Visual Effects 
Supervisor Rob Legato.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, increasing the intensity of the red, green and blue values. 

1 Apply the Two Strip filter to an image.
2 Change your View to Red, Green or Blue to see the selection values. 

Normally, the areas that are white in the selection are the areas that will be 
adjusted by a particular filter or control. The Red, Green and Blue Intensities, 
on the other hand, make adjustments where you see black in the selection.

3 Adjust the Intensity of whatever color channel you are viewing and you will see 
that certain values become darker. These are the values that will be intensified in 
the color image.

4 Change your View to Output to see the color image.
5 Adjust the Red and Green Intensities until you have the desired levels of red and 

green in the image.
6 Adjust the Blue Intensity to darken image areas that were blue in the source 

image.
7 You may need to use the Red, Green and Blue Smooth controls to smooth out 

any noise that may have appeared if the Intensities were turned up to high 
values. 
The Smooth controls are set to a low value by default.

8 Set the Opacity to a lower level if the strength of the Two Strip effect looks too 
strong.
Color Correct controls are also provided for additional control.
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 ULTRA CONTRAST

Category
Color Correct.

Description
Ultra Contrast lowers contrast evenly throughout the image by brightening 
shadow areas and darkening highlights. It is useful for correcting dark 
foreground subjects due to strong backlighting as well as highlights that are 
slightly washed out.

Go to the Ultra Contrast - Tutorial on page 257 to see how the filter works.

Shadows
Shadows

Raises the brightness of the shadows.

Position
Selects the shadow values to be adjusted when using the Shadows slider.

Range
Controls the range of values to be used for the shadows. A higher Range value 
considers more values as shadows. 
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Highlights
Highlights

Lowers the brightness of the highlights.

Position
Selects the highlight values to be adjusted when using the Highlights slider.

Range
Controls the range of values to be used for the highlights. A higher Range value 
considers more values as highlights. 

Ultra Contrast - Tutorial
Ultra Contrast lowers contrast evenly throughout the image by brightening 
shadow areas and darkening highlights. It is useful for correcting dark 
foreground subjects due to strong backlighting as well as highlights that are 
slightly washed out.

1 Apply the Ultra Contrast filter to an image.
2 Adjust the Shadows>Shadows slider to brighten shadow areas.
3 Adjust the Highlights>Highlights slider to darken highlight areas.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, lowering contrast. 

4 Change your View to Shadows or Highlights to see the selection values. 
The areas that are white in the selection are the areas that will be adjusted by 
either the Shadows or Highlights sliders. The areas defined as Shadows or 
Highlights can be adjusted by modifying the Position and Range parameters.

5 Adjust the Shadows or Highlights Position and Range controls to change what 
is considered Shadows or Highlights.
Go to the Selection section of General Controls on page 25 to see how the 
Position and Range controls work.

6 Change your View to Output to see the image.
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 VARI-STAR

Category
Light.

Description
Variable multi-point star patterns are generated on highlights in the image.

Go to the Vari-Star - Tutorial on page 260 to see how the filter works.

Warning: Large Position>Range and Star>Size settings can cause the Vari-Star plug-
in to render slowly.

Star
The Star settings control the various qualities of the generated star patterns.

Blend
Determines the blend mode to be used when adding the stars.
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Add
The stars are added to your image.

Screen
The stars are combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Determines the brightness of the stars.

Spokes
Controls the number of star spokes.

Size
Sets the star size.

Angle
Rotates the stars.

Blur
Blurs the stars.

Noise
Noise is introduced into the star patterns resulting in a more organic star effect.

Density
Controls the brightness of the noise.

Color
Sets the star color.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Time Average
In most cases, it is necessary to use an Average function on moving images. 
Otherwise, the Star patterns tend to flicker. Averaging allows for a very smooth 
selection, because pixel values from future frames are averaged together.

Vari-Star - Tutorial
Variable multi-point patterns are generated on highlights in the image.

1 Apply the Vari-Star filter to an image.
2 Adjust the Star>Brightness, Spokes, Size and Color settings to your liking.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, star effects.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where stars will be 
introduced. The location of the stars within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

4 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

5 Change your View to Stars to see the generated stars.
6 Increase the Selection>Range value to add more stars into the scene. Decrease 

for less stars.
The Selection>Range parameter has been purposely set to a low value. A high 
range setting will slow down the plug-in significantly.

7 Increase the Selection>Blur parameter to smooth out the star selection.
8 Change your View to Output to see the filtered image.
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 VIGNETTE

Category
Lens.

Description
A vignette, or soft fade, is a popular photographic effect where the photo 
gradually fades into the background, usually in an oval or square shape. The 
vignette can be any color as well as thrown out of focus.

Go to the Vignette - Tutorial on page 263 to see how the filter works.

Vignette
Type

Sets the type of vignette to be used.

Circular
Uses a circular vignette shape.

Square
Uses a square vignette shape.

Before After
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Horizontal and Vertical Blur
When creating defocused vignettes, use these blur parameters. Go to the Blur 
section of General Controls on page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the vignette through the use of a standard 
color picker. The default color is black.

Opacity
Sets the opacity of the colored vignette. For defocused vignettes, turn down the 
Opacity so you can see the defocused effect.

Shape
Softness X / Y

The Softness parameters control the vignette’s edge softness and operate 
similar to our standard blur controls. Go to the Blur section of General Controls 
on page 21 to see how the softness controls work.

Size X / Y
The size parameters change the size of the vignette.

Size X
The horizontal size of the vignette.

Size Y
The vertical size of the vignette.

Gang Size
The Size X and Size Y slider values can be ganged together. Drag the Size X 
slider to affect both values.

Note: When Gang is turned on, the Size Y slider doesn’t physically move. However, 
the Size Y value will follow the value of the Size X slider when Gang is turned on.
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Vignette - Tutorial
A vignette, or soft fade, is a popular photographic effect where the photo 
gradually fades into the background, usually in an oval or square shape. The 
vignette can be any color as well as thrown out of focus.

1 Apply the Vignette filter to an image.
2 Select either a circular or square vignette shape.
3 Adjust the Shape>Softness and Size.

The area outside of the shape will be where the vignetting will occur.

4 If you are curious, you can see what the vignette looks like by changing your 
View to Shape. Change your View to Output when done.

5 Set the Vignette>Color and Opacity.
The vignette can be either colored or defocused or a combination of the two.

6 Turn down the Vignette>Opacity if you would like to see only defocusing in the 
vignette.

7 Adjust the Vignette>Horizontal and Vertical Blur to your liking.
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 WARM MIST, WARM BLACK MIST

Category
Diffusion.

Description
Warm Mist

The Warm Mist filter creates atmosphere by reducing contrast and glowing 
highlights in combination with a warming filter.

Warm Black Mist
The Warm Black Mist filter creates atmosphere by reducing contrast, but with 
minimal glow around highlights in combination with a warming filter.

Before Warm Mist After

Warm Black Mist After
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Go to the Warm Mist / Warm Black Mist - Tutorial on page 267 to see how 
the filters work.

Mist
Mist

Determines the method used to create the mist effect.

Spread
The mist spreads beyond the areas defined by the selection.

Subtle
The mist is constrained by the areas defined by the selection.

Blend
Determines the blend mode to be used to create the mist effect.

Add
The mist is added to your image.

Screen
The mist is combined with the image using a Screen blend mode. This looks 
kind of like the Add blend mode, but highlights are retained.

Brightness
Sets the intensity of the mist.

Blur
Sets the softness of the mist. Go to the Blur section of General Controls on 
page 21 to see how the Blur controls work.

Color
The Color parameter sets the color of the mist through the use of a standard 
color picker. The default color is white.
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Warming
Color

The Color parameter sets the color of the warming through the use of a 
standard color picker.

Opacity
Sets the opacity of the warming.

Preserve Highlights
Preserves the white areas of the image.

Exposure Compensation
Exposure Compensation adds back the brightness loss as a result of the 
warming.

Selection
Go to the Selection section of General Controls on page 25 to see how the 
Selection controls work.
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Warm Mist / Warm Black Mist - Tutorial
The Warm Mist filter creates atmosphere by reducing contrast and glowing 
highlights in combination with a warming filter. The Warm Black Mist filter 
creates atmosphere by reducing contrast, but with minimal glow around 
highlights in combination with a warming filter.

1 Apply either the Warm Mist or Warm Black Mist filter to an image.
2 Adjust the Mist>Brightness, Blur and Color settings to your liking.

In some of the 55mm filters, a selection is generated to create the desired 
effect--in this case, mist.

3 Change your View to Selection to see the selection values. 
The areas that are white in the selection are the areas where mist will be 
introduced. The location of the mist within the scene can be adjusted by 
modifying the Selection>Position and Selection>Range parameters.

4 Change the Selection>Position parameter if you want to select different 
luminance values to be used for the selection.

5 Increase the Selection>Range value to add more mist into the scene. Decrease 
for less mist.

6 Increase the Selection>Blur parameter to soften the transition areas of the mist. 
7 Change your View to Output to see the filtered image.
8 The softness of the mist can also be adjusted using the Mist>Blur setting.
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 X-RAY

Category
Effects.

Description
Simulates the look of X-Ray images.

Go to the X-Ray - Tutorial on page 270 to see how the filters work.

Black and White
Filter

The Filter pop-up selects the type of black and white filter to be applied to your 
color image.

Normal
Converts the color image to a monochrome image.

Before After
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Red
Simulates a red filter in black and white photography.

Green
Simulates a green filter in black and white photography.

Blue
Simulates a blue filter in black and white photography.

Yellow
Simulates a yellow filter in black and white photography.

Orange
Simulates an orange filter in black and white photography.

Brightness
Adjusts the brightness of the image. Positive values brighten, negative values 
darken.

Contrast
Adjusts the contrast of the image. Positive values increase contrast, negative 
values decrease contrast.

Gamma 
Adjusts the gamma of the image. The gamma adjustment leaves the white and 
black points the same and only modifies the values in-between. Positive values 
darken the midtones, negative values lighten the midtones.

Color
Opacity

Sets the opacity of the color.

Color
The Color parameter sets the color of the x-ray through the use of a standard 
color picker and defaults to blue.
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X-Ray - Tutorial
Simulates the look of X-Ray images.

1 Apply the X-Ray filter to an image.
2 From the Filter pop-up, select the type of black and white filter to be applied to 

your color image.
Your choice of filter can dramatically change the black and white result.

3 Use the Brightness, Contrast and Gamma controls to further adjust the image.
4 Adjust the Color if you would like to tint the image to something other than blue.
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 APPENDIX A - TEXTURE LIBRARY
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 APPENDIX B - GAM PATTERN LIBRARY
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 APPENDIX C - BLEND MODES

Blend modes are used to combine images in a variety of different ways.

Add
The pixels of one image are added to another image.

        Background                   Foreground                       Result

Subtract
The pixels of one image are subtracted from another image.

        Background                   Foreground                       Result

Multiply
Produces a result where there is a union of pixels from two images.

        Background                   Foreground                       Result
mm v7 User Guide
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Screen
Looks at each images color information and multiplies the inverse of the two 
images. This looks kind of like the Add blend mode, but highlights are retained.

        Background                   Foreground                       Result

Difference
Produces a result where a value exists in each image, but not in both.

        Background                   Foreground                       Result

Darken
Compares two images and takes the pixels with the lower value.

        Background                   Foreground                       Result
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Lighten
Compares two images and takes the pixels with the higher value.

        Background                   Foreground                       Result
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 APPENDIX D - COLOR GRAD FILTER PRESETS

Cranberry 1

Cranberry 2

Cranberry 3

Tangerine 1

Tangerine 2

Tangerine 3

Straw 1

Straw 2

Straw 3

Tobacco 1

Tobacco 2

Tobacco 3

Chocolate 1

Chocolate 2

Chocolate 3

Plum 1

Plum 2

Plum 3

Grape 1

Grape 2

Grape 3

Tropic Blue 1

Tropic Blue 2

Tropic Blue 3
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Coral 1/8

Coral 1/4

Coral 1/2

Coral 1

Coral 2

Coral 3

Coral 4

Coral 5

Magenta 1

Magenta 2

Magenta 3

Magenta 4

Magenta 5

Pink 1

Pink 2

Pink 3

Pink 4

Pink 5

Red 1

Red 2

Red 3

Red 4

Red 5

Yellow 1

Yellow 2
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Yellow 3

Yellow 4

Yellow 5

Green 1

Green 2

Green 3

Green 4

Green 5

Cyan 1

Cyan 2

Cyan 3

Cyan 4

Cyan 5

Cool Blue 1

Cool Blue 2

Cool Blue 3

Cool Blue 4

Cool Blue 5

Blue 1

Blue 2

Blue 3

Blue 4

Blue 5
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 APPENDIX E - COLOR TEMPERATURE PRESETS

Match Flame (1700K)

Candle Flame (1850K)

Hefner Lamp (1880K)

Harcourt Pentane Lamp (1920K)

Standard British Candle (1930K)

Sunlight-Sunrise or Sunset (2000K)

Incandescent Carbon-4 watts\candle (2080K)

High Pressure Sodium-Lucalox\Lumalux (2100K)

Incandescent Tungsten-1.25 watts\candle (2400K)

Acetylene Lamp  (2415K)

40watt-general service  (2650K)

Fluorescent-Incandescent  (2700K)

75watt-general service  (2820K)

100watt-general service  (2900K)

Fluorescent-Deluxe Warm White  (2950K)

Tungsten-Gas Filled Lamps:200-500W  (2980K)

200watt-general service  (2980K)

Tungsten-Gas Filled Lamps:1000W  (2990K)

Fluorescent-Warm White (3050K)

Incandescent-Standard & Tungsten\Halogen (3200K)

CP Gas Filled (3350K)

Carbon Arc-225ABrute-Yellow Flame\YF 101 Filter (3350K)

Photoflood (3400K)

Fluorescent-White (3500K)
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Mercury Vapor-Warm Deluxe (3500K)

Sunlight-One Hour After Sunrise (3500K)

Fluorescent-Natural White (3700K)

Metal Halide-Metalarc C (3800K)

Clear Aluminum Wire-Filled Flash (3800K)

Mercury Vapor-White Deluxe (4000K)

Crater of Carbon Arc (4000K)

Fluorescent-Deluxe Cool White (4100K)

Metal Halide Additive AC Arc-CSI (4200K)

Clear Zirconium Wire-Filled Flash (4200K)

Fluorescent-Cool White (4300K)

Sunlight-Early Morning\Late Afternoon (4300K)

Daylight Blue Photoflood (4800K)

Flashcube-Magicube or Flipflash (4950K)

White Flame Carbon Arc (5000K)

Carbon Arc-225ABrute-White Flame\Y-1 Filter (5100K)

Fluorescent-Design White (5200K)

Sunlight-mean noon (5400K)

Photographic Daylight (5500K)

High Intensity Carbon Arc-sun arc (5500K)

Metal Halide Additive AC Arc-HMI (5600K)

Metal Halide Additive AC Arc-CID  (5600K)

Carbon Arc-225ABrute-White Flame\No Filter (5800K)

Sunlight-Midsummer (5800K)

Mercury Vapor-Clear Mercury (5900K)
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Metal Halide-Multi Arc\Metal Vapor (5900K)

Xenon High Pressure DC Short Arc (6000K)

Overcast Sky (6000K)

Fluorescent-Daylight (6500K)

Average Summer Daylight (6500K)

Light Summer Shade (7100K)

Average Summer Shade (8000K)

Partly Cloudy Sky (8000K)

Summer Skylight (9500K)

Skylight (12000K)
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 APPENDIX F - PHOTOGRAPHIC FILTERS 
PRESETS

1A Pale Pink

2A Pale Yellow

2B Pale Yellow

2E Pale Yellow

3 Light Yellow

8 Yellow

9 Deep Yellow

11 Yellowish-Green

12 Deep Yellow

15 Deep Yellow

16 Yellow-Orange

21 Orange

22 Deep Orange

23A Light Red

24 Red

25 Red Tricolor

26 Red

29 Deep Red Tricolor

32 Magenta

33 Magenta

34A Violet

38A Blue

39 Blue
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44 Light Blue-Green

44A Light-Blue-Green

47 Blue Tricolor

47A Light Blue

47B Deep Blue Tricolor

58 Green Tricolor

61 Deep Green Tricolor

70 Dark Red

74 Dark Green Monochromat

80A Blue

80B Blue

80C Blue

80D Blue

81 Yellowish

81A Yellowish

81B Yellowish

81C Yellowish

81D Yellowish

81EF Yellowish

82 Bluish

82A Bluish

82B Bluish

82C Bluish

85 Amber

85B Amber
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85C Amber

85N3 Amber

85N6 Amber

85N9 Amber

90 Dark Grayish Amber

92 Red

96 Neutral

98 Blue

99 Green

102  Yellow-Green

106 Amber

CC05R

CC10R

CC20R

CC30R

CC40R

CC50R

CC05B

CC10B

CC20B

CC30B

CC40B

CC50B

CC05G

CC10G
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CC20G

CC30G

CC40G

CC50G

CC05Y

CC10Y

CC20Y

CC30Y

CC40Y

CC50Y

CC05C

CC10C

CC20C

CC30C

CC40C

CC50C

CC05M

CC10M

CC20M

CC30M

CC40M

CC50M
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 APPENDIX G - GEL PRESETS

Gam Color
101 Lavender Blue

103 Blue Rose

104 Broadway Rose

105 Antique Rose

105X 3/4 Antique Rose

106 1/2 Antique Rose

107 1/4 Antique Rose

108 1/8 Antique Rose

109 Naked Pink

110 Dark Rose

120 Bright Pink

130 Rose

135 Soft Pink

140 Dark Magenta

150 Pink Punch

152 Party Pink

154 Baby Pink

155 Light Pink

160 Chorus Pink

170 Dark Flesh Pink

180 Cherry

190 Cold Pink
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195 Nymph Pink

220 Pink Magenta

235 Pink Red

245 Light Red

250 Medium Red XT

260 Rosey Amber

270 Red Orange

280 Fire Red

290 Fire Orange

305 French Rose

310 English Rose

315 Autumn Glory

320 Peach

323 Indian Summer

324 Dark Bastard Amber

325 Bastard Amber

327 Pale Sepia

328 Tan Tone

330 Sepia

335 Coral

338 Forever Amber

340 Light Bastard Amber

341 Cold Bastard Amber

342 Cantaloupe

343 Honey
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345 Deep Amber

350 Dark Amber

355 Amber Flame

360 Amber Blush

363 Sand

364 Pale Honey

365 Warm Straw

370 Spice

375 Flame

380 Golden Tan

382 Brass

385 Light Amber

386 Apricot

388 Gold Rush

390 Walnut

395 Golden Sunset

410 Yellow Gold

420 Medium Amber

430 Warm Ivory

433 Double Ivory

435 Ivory

440 Very Light Straw

450 Saffron

455 Yellow Sun

460 Mellow Yellow
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470 Pale Gold

475 Pale Yellow

480 Medium Yellow

510 No Color Straw

515 Lime Yellow

520 New Straw

525 Lime Sun

535 Lime

540 Pale Green

570 Light Green Yellow

650 Grass Green

655 Rich Green

660 Medium Green

670 Emerald Green

680 Kelly Green

685 Pistachio

690 Bluegrass

710 Blue Green

720 Light Steel Blue

725 Princess Blue

730 Azure Blue

740 Off Blue

750 Nile Blue

760 Aqua Blue

770 Christel Blue
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780 Shark Blue

785 Beverly Blue

790 Electric Blue

810 Moon Blue

815 Moody Blue

820 Full Light Blue

830 North Sky Blue

835 Aztec Blue

840 Steel Blue

841 Diamond Blue

842 Whisper Blue

845 Cobalt

847 City Blue

848 Bonus Blue

850 Primary Blue

855 Blue Jazz

860 Sky Blue

870 Winter White

872 Opera White

880 Daylight Blue

882 Southern Sky

885 Blue Ice

888 Blue Bell

890 Dark Sky Blue

905 Dark Blue
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910 Alice Blue

920 Twilight

925 Cosmic Blue

930 Real Congo Blue

940 Light Purple

945 Royal Purple

948 African Violet

950 Purple

960 Medium Lavender

970 Special Lavender

980 Surprise Pink

985 Ripe Plum

987 Wild Plum

990 Dark Lavender

995 Orchid

Gels
L003 Lavender Tint

L169 Lilac Tint

L136 Pale Lavender

L704 Lily

L052 Light Lavender

L170 Deep Lavender

L345 Fuchsia Pink

L048 Rose Purple

L126 Mauve
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L797 Deep Purple

L707 Ultimate Violet

L343 Special Medium Lavender

L180 Dark Lavender

L058 Lavender

L194 Surprise Pink

L344 Violet

L142 Pale Violet

L137 Special Lavender

L702 Special Pale Lavender

L053 Paler Lavender

L218 Eighth C.T.Blue

L203 Qtr C.T.B.

L061 Mist Blue

L202 Half C.T.Blue

L063 Pale Blue

L117 Steel Blue

L725 Old Steel Blue

L353 Lighter Blue

L140 Summer Blue

L172 Lagoon Blue

L724 Ocean Blue

L144 No Colour Blue

L118 Light Blue

L183 Moonlight Blue
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L352 Glacier Blue

L174 Dark Steel Blue

L196 True Blue

L281 Three quarters C.T.B.

L201 Full C.T.B.

L161 Slate Blue

L165 Daylight Blue

L141 Bright Blue

L143 Pale Navy Blue

L366 Cornflower

L719 Colour Wash Blue

L200 Double C.T.Blue

L132 Medium Blue

L068 Sky Blue

L075 Evening Blue

L197 Alice Blue

L079 Just Blue

L721 Berry Blue

L715 Cabana Blue

L716 Mikkel Blue

L711 Cold Blue

L119 Dark Blue

L363 Special Medium Blue

L195 Zenith Blue

L120 Deep Blue
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L085 Deeper Blue

L198 Palace Blue

L713 J.Winter Blue

L071 Tokyo Blue

L181 Congo Blue

L729 Scuba Blue

L116 Medium Blue-Green

L354 Special Steel Blue

L115 Peacock Blue

L131 Marine Blue

L241 Fluorescent 5700K

L728 Steel Green

L730 Liberty Green

L242 Fluorescent 4300K

L219 Fluorescent Green

L323 Jade

L322 Soft Green

L325 Mallard Green

L327 Forest Green

L735 Velvet Green

L090 Dark Yellow Green

L139 Primary Green

L089 Moss Green

L124 Dark Green

L243 Fluorescent 3600K
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L122 Fern Green

L738 JAS Green

L121 Green

L088 Lime Green

L138 Pale Green

L244 Plus Green

L213 White Flame Green

L245 Half Plus Green

L246 Quarter Plus Green

L278 Eighth Plus Green

L230 Super Corr.L.C.T.Yellow

L156 Chocolate

L017 Surprise Peach

L746 Brown

L208 Full C.T.O. + .6ND

L207 Full C.T.O. + .3ND

L232 Super Correction W.F.Green to Tungsten

L285 3/4 CT Orange

L009 Pale Amber Gold

L205 Half C.T.Orange

L442 Half C.T. Straw

L013 Straw Tint

L103 Straw

L443 Qtr C.T. Straw

L206 Qtr C.T.O.
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L223 Eighth C.T.O.

L444 Eighth C.T. Straw

L159 No Colour Straw

L226 U.V.

L763 Wheat

L212 L.C.T.Yellow

L007 Pale Yellow

L100 Spring Yellow

L010 Medium Yellow

L101 Yellow

L765 Yellow

L764 Sun Colour Straw

L102 Light Amber

L104 Deep Amber

L015 Deep Straw

L441 Full C.T. Straw

L204 Full C.T.Orange

L236 H.M.I. (to Tungsten)

L179 Chrome Orange

L020 Medium Amber

L776 Nectarine

L147 Apricot

L105 Orange

L779 Bastard Pink

L237 C.I.D. (to Tungsten)
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L134 Golden Amber

L158 Deep Orange

L021 Gold Amber

L777 Rust

L778 Millennium Gold

L135 Deep Golden Amber

L022 Dark Amber

L025 Sunset Red

L166 Pale Red

L781 Terry Red

L019 Fire

L164 Flame Red

L024 Scarlet

L182 Light Red

L106 Primary Red

L026 Bright Red

L029 PLASA Red

L027 Medium Red

L789 Blood Red

L341 Plum

L127 Smokey Pink

L046 Dark Magenta

L113 Magenta

L148 Bright Rose

L332 Special Rose Pink
mm v7 User Guide



• 

Appendix G - Gel Presets  305 
• 
• 
• 
•
•
•

L793 Vanity Fair

L128 Bright Pink

L328 Follies Pink

L002 Rose Pink

L111 Dark Pink

L192 Flesh Pink

L036 Medium Pink

L110 Middle Rose

L039 Pink Carnation

L247 Minus Green

L035 Light Pink

L153 Pale Salmon

L248 Half Minus Green

L249 Quarter Minus Green

L279 Eighth Minus Green

L162 Bastard Amber

L152 Pale Gold

L154 Pale Rose

L151 Gold Tint

L004 Medium Bastard Amber

L108 English Rose

L790 Moroccan Pink

L176 Loving Amber

L109 Light Salmon

L107 Light Rose
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L157 Pink

L193 Rosy Amber

L008 Dark Salmon

L238 C.S.I. (to Tungsten)

L298 0.15ND

L209 0.3ND

L210 0.6ND

L211 0.9ND

L299 1.2ND

Rosco
Rosco Cinegel

Rosco 3202 Full Blue CTB

Rosco 3203 3/4 Blue CTB

Rosco 3204 1/2 Blue CTB

Rosco 3206 1/3 Blue CTB

Rosco 3208 1/4 Blue CTB

Rosco 3216 1/8 Blue CTB

Rosco 3220 Double Blue CTB

Rosco 3407 Sun CTO

Rosco 3411 Sun 3/4 CTO

Rosco 3408 Sun 1/2 CTO

Rosco 3409 Sun 1/4 CTO

Rosco 3410 Sun 1/8 CTO

Rosco 3420 Double CTO

Rosco 3441 Full Straw CTS
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Rosco 3442 1/2 Straw CTS

Rosco 3443 1/4 Straw CTS

Rosco 3444 1/8 Straw 1/8 CTS

Rosco 3415 N.15 (1/2 Stop)

Rosco 3402 N.3 (1 Stop)

Rosco 3403 N.6 (2 Stops)

Rosco 3404 N.9 (3 Stops)

Rosco 3401 Sun 85

Rosco 3405 Sun 85N.3

Rosco 3406 Sun 85N.6

Rosco 3304 Tough Plusgreen

Rosco 3315 Tough 1/2 Plusgreen

Rosco 3316 Tough 1/4 Plusgreen

Rosco 3317 Tough 1/8 Plusgreen

Rosco 3308 Tough Minusgreen

Rosco 3313 Tough 1/2 Minusgreen

Rosco 3314 Tough 1/4 Minusgreen

Rosco 3318 Tough 1/8 Minusgreen

Rosco 3310 Fluorofilter

Rosco 3114 Tough UV Filter

Rosco 3107 Tough Y-1

Rosco 3134 Tough MT 54

Rosco 3106 Tough MTY

Rosco 3102 Tough MT2
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Rosco Cinelux
Rosco 01 Light Bastard Amber 

Rosco 02 Bastard Amber

Rosco 03 Dark Bastard Amber

Rosco 04 Medium Bastard Amber

Rosco 304 Pale Apricot 

Rosco 05 Rose Tint 

Rosco 305 Rose Gold

Rosco 06 No Color Straw

Rosco 07 Pale Yellow 

Rosco 08 Pale Gold

Rosco 09 Pale Amber Gold 

Rosco 10 Medium Yellow

Rosco 11 Light Straw

Rosco 12 Straw

Rosco 312 Canary

Rosco 13 Straw Tint 

Rosco 14 Medium Straw

Rosco 15 Deep Straw 

Rosco 16 Light Amber

Rosco 17 Light Flame

Rosco 317 Apricot

Rosco 18 Flame

Rosco 318 Mayan Sun

Rosco 19 Fire
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Rosco 20 Medium Amber 

Rosco 21 Golden Amber

Rosco 321 Soft Golden Amber

Rosco 22 Deep Amber 

Rosco 23 Orange

Rosco 24 Scarlet 

Rosco 25 Orange Red 

Rosco 26 Light Red

Rosco 27 Medium Red 

Rosco 30 Light Salmon Pink 

Rosco 31 Salmon Pink

Rosco 32 Medium Salmon Pink 

Rosco 33 No Color Pink

Rosco 333 Blush Pink

Rosco 34 Flesh Pink

Rosco 35 Light Pink

Rosco 36 Medium Pink 

Rosco 336 Billington Pink

Rosco 37 Pale Rose Pink

Rosco 337 True Pink

Rosco 38 Light Rose 

Rosco 39 Exotic Sangria

Rosco 339 Broadway Pink

Rosco 40 Light Salmon 

Rosco 41 Salmon
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Rosco 42 Deep Salmon

Rosco 342 Rose Pink 

Rosco 43 Deep Pink 

Rosco 343 Neon Pink 

Rosco 44 Middle Rose

Rosco 344 Follies Pink 

Rosco 45 Rose

Rosco 46 Magenta

Rosco 346 Tropical Magenta

Rosco 47 Light Rose Purple

Rosco 48 Rose Purple 

Rosco 49 Medium Purple 

Rosco 50 Mauve

Rosco 51 Surprise Pink

Rosco 351 Lavender Mist 

Rosco 52 Light Lavender

Rosco 53 Pale Lavender

Rosco 54 Special Lavender 

Rosco 55 Lilac

Rosco 355 Pale Violet

Rosco 56 Gypsy Lavender

Rosco 356 Middle Lavender

Rosco 57 Lavender

Rosco 357 Royal Lavender

Rosco 58 Deep Lavender
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Rosco 358 Rose Indigo 

Rosco 59 Indigo

Rosco 359 Medium Light

Rosco 60 No Color Blue

Rosco 360 Clearwater

Rosco 61 Mist Blue

Rosco 62 Booster Blue

Rosco 63 Pale Blue 

Rosco 363 Aquamarine

Rosco 64 Light Steel Blue 

Rosco 65 Daylight Blue 

Rosco 365 Tharon Delft Blue

Rosco 66 Cool Blue

Rosco 67 Light Sky Blue

Rosco 367 Slate Blue

Rosco 68 Sky Blue

Rosco 69 Brilliant Blue

Rosco 70 Nile Blue

Rosco 370 Italian Blue

Rosco 71 Sea Blue

Rosco 371 Theatre Booster 1

Rosco 72 Azure Blue

Rosco 372 Theatre Booster 2

Rosco 73 Peacock Blue

Rosco 373 Theatre Booster 3
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Rosco 74 Night Blue

Rosco 76 Light Green Blue

Rosco 77 Green Blue

Rosco 78 Trudy Blue

Rosco 79 Bright Blue

Rosco 80 Primary Blue

Rosco 81 Urban Blue 

Rosco 82 Surprise Blue 

Rosco 382 Congo Blue

Rosco 83 Medium Blue

Rosco 383 Sapphire Blue 

Rosco 84 Zephyr Blue 

Rosco 85 Deep Blue 

Rosco 385 Royal Blue

Rosco 86 Pea Green 

Rosco 87 Pale Yellow Green

Rosco 88 Light Green

Rosco 388 Gaslight Green 

Rosco 89 Moss Green

Rosco 389 Chroma Green 

Rosco 90 Dark Yellow Green

Rosco 91 Primary Green

Rosco 92 Turquoise

Rosco 93 Blue Green

Rosco 94 Kelly Green 
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Rosco 95 Medium Blue Green

Rosco 395 Teal Green

Rosco 96 Lime

Rosco 97 Light Grey

Rosco 98 Medium Grey

Rosco 398 Neutral Grey

Rosco 99 Chocolate

Rosco Storaro Selection
Rosco 2001 VS Red

Rosco 2002 VS Orange

Rosco 2003VS Yellow

Rosco 2004 VS Green

Rosco 2005 VS Cyan

Rosco 2006 VS Azure

Rosco 2007 VS Blue

Rosco 2008 VS Indigo

Rosco 2009 VS Violet

Rosco 2010 VS Magenta

Rosco Calcolor
Rosco 4215 15 Blue

Rosco 4230 30 Blue

Rosco 4260 60 Blue

Rosco 4290 90 Blue

Rosco 4315 15 Cyan

Rosco 4330 30 Cyan

Rosco 4360 60 Cyan
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Rosco 4390 90 Cyan

Rosco 4415 15 Green

Rosco 4430 30 Green

Rosco 4460 60 Green

Rosco 4490 90 Green

Rosco 4515 15 Yellow

Rosco 4530 30 Yellow

Rosco 4560 60 Yellow

Rosco 4590 90 Yellow

Rosco 4615 15 Red

Rosco 4630 30 Red

Rosco 4660 60 Red

Rosco 4690 90 Red

Rosco 4715 15 Magenta

Rosco 4730 30 Magenta

Rosco 4760 60 Magenta

Rosco 4790 90 Magenta

Rosco 4815 15 Pink

Rosco 4830 30 Pink

Rosco 4860 60 Pink

Rosco 4890 90 Pink

Rosco 4915 15 Lavender

Rosco 4930 30 Lavender

Rosco 4960 60 Lavender

Rosco 4990 90 Lavender
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